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CHAPTER 1

Preámbulo

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

Los detalles, datos y resultados en este documento han sido escritos y verificados con el mejor de los conocimien-
tos y responsabilidad de los autores y editores. Sin embargo, son posibles errores en el contenido.

Por lo tanto, los datos no están sujetos a ningún derecho o garantía. Los autores y editores no aceptan ninguna
responsabilidad u obligación por fallos y sus consecuencias. Siempre será bienvenido a informar posibles errores.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://www.qgis.org/wiki/.

Enlaces en este documento

Este documento contiene enlaces internos y externos. Pulsando un enlace interno navega dentro del documento,
mientras que pulsando un enlace externo abre una dirección de Internet. En formato PDF, los enlaces internos y
externos son mostrados en azul y son manejados por el navegador del sistema. En formato HTML, el navegador
muestra y maneja ambos de manera idéntica.

Autores y Editores de las Guías de Usuario, Instalación y Programación:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet: http://www.qgis.org

Licencia de este documento

Se permite la copia, distribución y/o modificación de este documento bajo los términos de la Licencia de Docu-
mentación Libre GNU, Versión 1.3 o cualquier versión posterior publicada por la Fundación de Software Libre;
sin Secciones Invariante, ni Texto de Portada ni de Contracubierta. Se incluye una copia de la licencia en el
Apéndice GNU Free Documentation License.

.
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CHAPTER 2

Convenciones

Esta sección describe los estilos homogéneos que se utilizarán a lo largo de este manual.

2.1 Convenciones de la Interfaz Gráfica o GUI

Las convenciones de estilo del GUI están destinadas a imitar la apariencia de la interfaz gráfica de usuario. En
general, un estilo reflejará la apariencia simplificada, por lo que un usuario puede escanear visualmente el GUI
para encontrar algo que se parece a lo mostrado en el manual.

• Menú Opciones: Capa → Añadir capa ráster o Preferencias → Barra de Herramientas → Digitalizacion

• Tool: Add a Raster Layer

• Boton : [Guardar como]

• Título del Cuadro de Diálogo: Propiedades de capa

• Pestaña: General

• Selección: Renderizar

• Radio Button: Postgis SRID EPSG ID

• Select a number:

• Select a string:

• Browse for a file:

• Select a color:

• Barra de desplazamiento:

• Input Text:

El sombreado muestra un componente de la interfaz que el usuario puede pulsar.

2.2 Convenciones de Texto o Teclado

This manual also includes styles related to text, keyboard commands and coding to indicate different entities, such
as classes or methods. These styles do not correspond to the actual appearance of any text or coding within QGIS.

• Hiperenlaces: http://qgis.org

• Combinaciones de Teclas: Pulsar Ctrl+B, significa mantener pulsada la tecla Ctrl y pulsar la letra B.

• Nombre de un Archivo: lakes.shp

5
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• Nombre de una Clase: NewLayer

• Método: classFactory

• Servidor: myhost.de

• Texto para el Usuario: qgis --help

Las líneas de código se muestran con una fuente de ancho fijo:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instrucciones específicas de cada plataforma

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on Macintosh OS X platforms, you should click the QGIS menu first, then Quit.

Las cantidades mayores de texto se pueden formatear como listas:

• Hacer esto

• Hacer aquello

• Hacer otra cosa

o como párrafos:

Hacer esto y esto y esto. Entonces hacer esto y esto y esto, y esto y esto y esto, y esto y esto y esto.

Hacer eso. Entonces hacer eso y eso y eso, y eso y eso y eso y eso, y eso y eso y eso, y eso y eso y eso, y eso y
eso y eso.

Las capturas de pantalls que aparecen a lo largo de la guía de usuario han sido creadas en diferentes plataformas;
éstas se indicarán por el icono específico para cada una al final del pie de imagen.

.
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CHAPTER 3

Prólogo

¡Bienvenido al maravilloso mundo de los Sistemas de Información Geográfica (SIG)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(http://qt.digia.com) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS aims to be a user-friendly GIS, providing common functions and features. The initial goal of the project
was to provide a GIS data viewer. QGIS has reached the point in its evolution where it is being used by many for
their daily GIS data-viewing needs. QGIS supports a number of raster and vector data formats, with new format
support easily added using the plugin architecture.

QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license means that
you can inspect and modify the source code, and guarantees that you, our happy user, will always have access to
a GIS program that is free of cost and can be freely modified. You should have received a full copy of the license
with your copy of QGIS, and you also can find it in Appendix GNU General Public License.

Truco: Documentación al día
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.

.
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CHAPTER 4

Características

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Ver datos

Se puede ver y sobreponer datos vectoriales y ráster en diferentes formatos y proyecciones sin convertir a un
formato interno o común. Los formatos admitidos incluyen:

• Tablas y vistas habilitadas para operaciones espaciales utilizando PostGIS, SpatiaLite y MS SQL Spatial,
Oracle Spatial, formatos vectoriales admitidos por la biblioteca OGR instalada, incluyendo archivos shape
de ESRI, MapInfo, SDTS, GML y muchos más. Vea la sección Trabajar con catos vectoriales.

• Ráster y formatos de imagenes admitidos por la biblioteda GDAL (Geospatial Data Abstraction Library)
instalada, por ejemplo GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG y muchos más. Vea la
sección Trabajar con catos raster.

• Ráster GRASS y datos vectoriales de base de datos GRASS (location/mapset). Vea sección Integracion
GRASS SIG.

• Datos espaciales en línea servidos como servicios web OGC incluyendo WMS, WMTS, WCS, WFS, y
WFS-T. Vea la sección Trabajar con datos OGC.

4.2 Explorar datos y componer mapas

Se puede componer mapas y explorar datos espaciales interactivamente con una GUI amigable. Las muy útiles
herramientas disponibles en la GUI incluyen:

• QGIS browser

• Reproyección al vuelo

• Gestor de Base de Datos

• Diseñador de mapas

• Panel de vista general

• Marcadores espaciales

• Herramientas de anotaciones

• Identificar/seleccionar objetos espaciales

• Editar/ver/buscar atributos

• Data-defined feature labeling

9
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• Vectores definidos por datos y herramientas para simbologia raster.

• Composición del atlas y mapa con capas de cuadricula.

• flecha barra de escala y etiqueta de derechos de autor para mapas

• Apoyo para guardar y restaurar proyectos

4.3 Crear, editar, gestionar y exportar datos

You can create, edit, manage and export vector and raster layers in several formats. QGIS offers the following:

• Herramientas de digitalización para formatos reconocidos OGR y capas vectoriales GRASS

• Capacidad para crear y editar archivos shape y capas vectoriales GRASS

• Complemento de georeferenciador para geocodificar imágenes

• Herramienta GPS para importar y exportar formato GPX y convertir otros formatos GPS a GPX o descargar
o subir directo a la unidad GPS (en Linux, usb se agredo a la lista de objetos GPS.)

• Apoyo para visualizar y editar datos de OpenStreetMap

• Capacidad para crear tablas de base de datos espaciales desde archivos shape con el complemento de Ad-
ministrados de BBDD

• Mejor manejo de tablas de bases de datos espaciales

• Herramientas para la gestión de tablas de atributos vectoriales

• Opción para guardar capturas de pantalla como imágenes georeferenciadas

• Herramienta para exportar DXF con capacidades aumentadas de explorar estilos y plugins que realizan
funciones parecidas a CAD.

4.4 Analyse data

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use the
integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See sec-
tion Integracion GRASS SIG.) Or, you can work with the Processing Plugin, which provides a powerful geospatial
analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA, GRASS, fTools
and more. (See section Introducción.)

4.5 Publicar mapas en Internet

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server.
(See section Trabajar con datos OGC.) Additionally, you can publish your data on the Internet using a webserver
with UMN MapServer or GeoServer installed.

4.6 Extend QGIS functionality through plugins

QGIS can be adapted to your special needs with the extensible plugin architecture and libraries that can be used
to create plugins. You can even create new applications with C++ or Python!
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4.6.1 Complementos del Núcleo

Los complementos del núcleo incluyen:

1. Captura de coordenadas (captura las coordenadas del ratón en diferentes SRCs)

2. DB Manager (Exchange, edit and view layers and tables; execute SQL queries)

3. Dxf2Shp Converter (convierte DXF a archivos shape)

4. eVIS (Visualizar eventos)

5. fTools (Análiza y gestiona datos vectoriales)

6. GDALTools (Integrate GDAL Tools into QGIS)

7. Georeferenciador GDAL (Añade información de la proyección para utilizar ráster GDAL)

8. Herramientas GPS (cargar e importar datos de GPS)

9. GRASS (integrar el SIG GRASS)

10. Mapa de calor (Genera ráster de mapa de calor de datos de punto)

11. Complemento de interpolación (Interpolar basada en vértices de una capa vectorial)

12. Cliente de Catálogo de metasearch

13. Edición fuera de línea (permite editar fuera de línea y sincronizar con bases de datos)

14. GeoRaster Espacial de Oracle

15. Procesamiento (antiguamente SEXTANTE)

16. Análisis del Terreno Ráster (Analiza terreno a base de ráster)

17. Complemento Grafo de rutas (Analiza una red de ruta más corta)

18. Complemento de consulta espacial

19. SPIT (Import shapefiles to PostgreSQL/PostGIS)

20. Verificador de Topología (encuentra errores topológicos en una capa vectorial)

21. Complemento estadístico zonal (calcula recuento, suma y media de un ráster por cada polígono de una capa
vectorial)

4.6.2 Complementos externos de Python

QGIS offers a growing number of external Python plugins that are provided by the community. These plugins
reside in the official Plugins Repository and can be easily installed using the Python Plugin Installer. See Section
El diálogo de complementos.

4.7 Consola de Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.
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4.8 Problemas Conocidos

4.8.1 Limitación en el número de archivos abiertos

Si va a abrir un proyecto grande de QGIS y está seguro de que todas las capas son válidas, pero algunas capas
se marcan como malas, es probable que se enfrentará a este problema. Linux (y otros sistemas operativos, así
mismo) tiene un límite de archivos abiertos por proceso. Los límites de recursos son por proceso y heredados. El
ulimit, que es una cáscara integrada, cambia los límites solamente para el proceso actual; el nuevo límite será
heredado por los procesos hijos.

Puede ver toda la información ulimit actual al escribir

user@host:~$ ulimit -aS

You can see the current allowed number of opened files per proccess with the following command on a console

user@host:~$ ulimit -Sn

Para cambiar los límites de una sesión existente, es posible que pueda usar algo como

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Para solucionarlo para siempre

En la mayoría de los sistemas Linux, los límites de recursos se establecen al iniciar sesión
por el módulo pam_limits de acuerdo con los ajustes contenidos en:file:/etc/security/limits.conf o
/etc/security/limits.d/*.conf. Debe ser capaz de editar esos archivos si tiene privilegios de root
(también a través de sudo), pero tendrá que volver a iniciar sesión para que los cambios surtan efecto.

Más información:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

.

12 Chapter 4. Características

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/
http://linuxaria.com/article/open-files-in-linux?lang=en
http://linuxaria.com/article/open-files-in-linux?lang=en


CHAPTER 5

What’s new in QGIS 2.8

Esta versión contiene nuevas características y se extiende la interfaz de programación con respecto a versiones
anteriores. Le recomendamos que utilice esta versión sobre las versiones anteriores.

This release includes hundreds of bug fixes and many new features and enhancements
that will be described in this manual. You may also review the visual changelog at
http://qgis.org/en/site/forusers/visualchangelog28/index.html.

5.1 Application

• Map rotation: A map rotation can be set in degrees from the status bar

• Bookmarks: You can share and transfer your bookmarks

• Expressions:

– when editing attributes in the attribute table or forms, you can now enter expressions directly into spin
boxes

– the expression widget is extended to include a function editor where you are able to create your own
Python custom functions in a comfortable way

– in any spinbox of the style menu you can enter expressions and evaluate them immediately

– a get and transform geometry function was added for using expressions

– a comment functionality was inserted if for example you want to work with data defined labeling

• Joins: You can specify a custom prefix for joins

• Layer Legend: Show rule-based renderer’s legend as a tree

• DB Manager: Run only the selected part of a SQL query

• Attribute Table: support for calculations on selected rows through a ‘Update Selected’ button

• Measure Tools: change measurement units possible

5.2 Data Providers

• DXF Export tool improvements: Improved marker symbol export

• WMS Layers: Support for contextual WMS legend graphics

• Temporary Scratch Layers: It is possible to create empty editable memory layers

13
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5.3 Digitizing

• Advanced Digitizing:

– digitise lines exactly parallel or at right angles, lock lines to specific angles and so on with the advanced
digitizing panel (CAD-like features)

– simplify tool: specify with exact tolerance, simplify multiple features at once ...

• Snapping Options: new snapping mode ‘Snap to all layers’

5.4 Map Composer

• Composer GUI improvements: hide bounding boxes, full screen mode for composer toggle display of
panels

• Grid improvements: You now have finer control of frame and annotation display

• Label item margins: You can now control both horizontal and vertical margins for label items. You can
now specify negative margins for label items.

• optionally store layer styles

• Attribute Table Item: options ‘Current atlas feature’ and ‘Relation children’ in Main properties

5.5 Plugins

• Python Console: You can now drag and drop python scripts into the QGIS window

5.6 QGIS Server

• Python plugin support

5.7 Symbology

• live heatmap renderer creates dynamic heatmaps from point layers

• raster image symbol fill type

• more data-defined symbology settings: the data-defined option was moved next to each data definable
property

• support for multiple styles per map layer, optionally store layer styles

5.8 User Interface

• Projection: Improved/consistent projection selection. All dialogs now use a consistent projection selection
widget, which allows for quickly selecting from recently used and standard project/QGIS projections

.
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CHAPTER 6

Comenzar

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Instalación

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and Mac OS X. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Instalación a partir de las fuentes

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Instalación en medios extraíbles

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section Menú Sistema for additional
information.

6.2 Datos de ejemplo

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• Usar datos SIG que ya tenga

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Uninstall QGIS and reinstall with the data download option checked (only recommended if the above solu-
tions are unsuccessful)

For GNU/Linux and Mac OS X, there are not yet dataset installation packages available as rpm,
deb or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data and unzip the archive on your system.
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The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.3 Sample Session

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short
and simple QGIS sample session. We will visualize a raster and a vector layer. We will use the
landcover raster layer, qgis_sample_data/raster/landcover.img, and the lakes vector layer,
qgis_sample_data/gml/lakes.gml.

6.3.1 Start QGIS

• Start QGIS by typing “QGIS” at a command prompt, or if using a precompiled binary, by using the
Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder.

6.3.2 Load raster and vector layers from the sample dataset

1. Click on the Add Raster Layer icon.

2. Navegue a la carpeta qgis_sample_data/raster/, seleccione el archivo ERDAS IMG
landcover.img y haga clic en [Abrir].

3. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case “Erdas Imagine Images (*.img, *.IMG)”.

4. Now click on the Add Vector Layer icon.

5. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.
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6. Browse to the folder qgis_sample_data/gml/, select ‘Geography Markup Language [GML] [OGR]

(.gml,.GML)’ from the Filter combo box, then select the GML file lakes.gml and click [Open].
In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog opens with
NAD27 / Alaska Alberts selected, click [OK].

7. Zoom in a bit to your favorite area with some lakes.

8. Haga doble clic en la capa lakes en el panel Capas para abrir el diálogo Propiedades.

9. Clic en la pestaña Estilo y seleccionar un azul como color de relleno.

10. Click on the Labels tab and check the Label this layer with checkbox to enable labeling. Choose the
“NAMES” field as the field containing labels.

11. To improve readability of labels, you can add a white buffer around them by clicking “Buffer” in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

12. Haga clik en [Aplicar]. Compruebe si el resultado le gusta y finalmente pulse [Aceptar].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Starting and Stopping QGIS

In section Sample Session you already learned how to start QGIS. We will repeat this here, and you will see that
QGIS also provides further command line options.

• Assuming that QGIS is installed in the PATH, you can start QGIS by typing qgis at a command prompt
or by double clicking on the QGIS application link (or shortcut) on the desktop or in the Applications menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder. If you need to start QGIS in a shell, run
/path-to-installation-executable/Contents/MacOS/Qgis.

To stop QGIS, click the menu option File QGIS → Quit, or use the shortcut Ctrl+Q.

6.5 Opciones de la línea de órdenes

QGIS supports a number of options when started from the command line. To get a list of the options, enter
qgis --help on the command line. The usage statement for QGIS is:

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--code path] run the given python file on load
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[--defaultui] start by resetting user ui settings to default
[--help] this text

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Truco: Ejemplo usando argumentos de la línea de órdenes
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Opción de la línea de órdenes --snapshot

Esta opción permite crear una captura de pantalla en formato PNG de la vista actual. Esto es práctico cuando tiene
muchos proyectos y quiere generar capturas de pantalla de sus datos.

Actualmente genera un archivo PNG con 800x600 píxeles. Esto se puede ajustar usando los argumentos‘‘–width‘‘
y --height en la línea de órdenes. Se puede añadir un nombre de archivo después de --snapshot.

Opción de la línea de órdenes --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, --lang=it starts QGIS in italian localization.

Opción de la línea de órdenes --project

Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Opción de la línea de órdenes --extent

Use esta opción para iniciar con una extensión de mapa específica. Necesita añadir el cuadro delimitador de su
extensión en el siguiente orden, separado por una coma:

--extent xmin,ymin,xmax,ymax

Opción de la línea de órdenes --nologo

This command line argument hides the splash screen when you start QGIS.

Opción de la línea de órdenes --noplugins

Si tiene problemas con los complementos al iniciar, puede evitar cargarlos con ésta opción. Estarán aún disponibles
después en el administrador de complementos.

Opciónde la línea de órdenes --customizationfile

Utilizando este argumento de línea de órdenes puede definir un archivo de personalizacion de la GUI, que se
utilizará al iniciar.

Opción de la línea de órdenes --nocustomization

Utilizando este argumento de línea de órdenes no se aplicará la personalización existente de la GUI.

Opción de la línea de órdenes --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Opciones to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use option:

18 Chapter 6. Comenzar



QGIS User Guide, Publicación 2.8

--optionspath /path/to/config/

Opción de la línea de órdenes --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Opción de línea de comandos --código

This option can be used to run a given python file directly after QGIS has started.

Por ejemplo, cuando se tiene un archivo python llamado load_alaska.py con el siguiente contenido:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

6.6 Proyectos

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opciones). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
As....

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

El tipo de información guardada en el archivo de proyecto incluye:

• Las capas añadidas

• Que capas pueden ser consultadas

• Propiedades de la capa, incluyendo simbolización y estilos

• Proyección de la vista del mapa

• Última extensión vista

• Diseñador de impresión

• Elementos de diseñador de impresión con ajustes

• Diseñador de impresión configuración de atlas

• Configuración de digitalización

• Tabla de relaciones

• Proyectos Macros

• Proyecto de estilos predeterminados

• Configuración de complementos

• Configuración de servidor QGIS desde la pestaña de ajustes de OWS en propiedades del proyecto

• Consultas almacenadas en el Administrador de BBDD
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The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly anymore. To be made aware of this, in the General tab under Settings
→ Options you can select:

• Prompt to save project and data source changes when required

• Warn when opening a project file saved with an older version of QGIS

Whenever you save a project in QGIS a backup of the project file is made with the extension ~.

6.7 Salida

There are several ways to generate output from your QGIS session. We have discussed one already in section
Proyectos, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image opens a file dialog where you select the name, path and type of
image (PNG,JPG and many other formats). A world file with extension PNGW or JPGW saved in the same
folder georeferences the image.

• Menu option Project → DXF Export ... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.

• Menu option Project → New Print Composer opens a dialog where you can layout and print the current
map canvas (see section Diseñadores de impresión).

.
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Nota: Las decoraciones de las ventanas (barra de título, etc.) pueden ser distintas dependiendo de su sistema
operativo y su gestor de ventanas.

The QGIS GUI is divided into five areas:

1. Barra de Menú

2. Tool Bar

3. Map Legend

4. Vista del mapa

5. Barra de Estado

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Barra de Menú

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Aunque la mayoría de las opciones tiene una herramienta correspondiente y viceversa, los menús no están orga-
nizados exactamente como las barras de herramientas. La barra de herramientas que contiene la herramienta esta
listada después de cada opción de menú como una entrada de casilla de verificación. Algunas opciones de menú
sólo aparecen si se carga el complemento correspondiente. Para obtener más información acerca de herramientas
y barra de herramientas, ver la sección Barra de herramietas.

7.1.1 Proyecto

Menú Opción Atajos Referencia Barra de herramietas

New Ctrl+N ver Proyectos Proyecto

Open Ctrl+O ver Proyectos Proyecto
Nuevo a partir de plantilla → ver Proyectos Proyecto
Open Recent → ver Proyectos

Save Ctrl+S ver Proyectos Proyecto

Save As... Ctrl+Shift+S ver Proyectos Proyecto

Save as Image... ver Salida
DXF Export ... ver Salida

New Print Composer Ctrl+P ver Diseñadores de impresión Proyecto

Composer manager ... ver Diseñadores de impresión Proyecto
Diseñadores de impresión → ver Diseñadores de impresión

Exit QGIS Ctrl+Q
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7.1.2 Editar

Menú Opción Atajos Referencia Barra de
herramietas

Undo Ctrl+Z ver Digitalización avanzada Digitalización
Avanzada

Redo Ctrl+Shift+Z ver Digitalización avanzada Digitalización
Avanzada

Cut Features Ctrl+X ver Digitalizando una capa
existente

Digitalización

Copy Features Ctrl+C ver Digitalizando una capa
existente

Digitalización

Paste Features Ctrl+V ver Digitalizando una capa
existente

Digitalización

Pegar objetos espaciales como
→

ver Working with the Attribute
Table

Add Feature Ctrl+. ver Digitalizando una capa
existente

Digitalización

Move Feature(s) ver Digitalizando una capa
existente

Digitalización

Delete Selected ver Digitalizando una capa
existente

Digitalización

Rotate Feature(s) ver Digitalización avanzada Digitalización
Avanzada

Simplify Feature ver Digitalización avanzada Digitalización
Avanzada

Add Ring ver Digitalización avanzada Digitalización
Avanzada

Add Part ver Digitalización avanzada Digitalización
Avanzada

Fill Ring ver Digitalización avanzada Digitalización
Avanzada

Delete Ring ver Digitalización avanzada Digitalización
Avanzada

Delete Part ver Digitalización avanzada Digitalización
Avanzada

Reshape Features ver Digitalización avanzada Digitalización
Avanzada

Offset Curve ver Digitalización avanzada Digitalización
Avanzada

Split Features ver Digitalización avanzada Digitalización
Avanzada

Split Parts ver Digitalización avanzada Digitalización
Avanzada

Merge Selected Features ver Digitalización avanzada Digitalización
Avanzada

Merge Attr. of Selected
Features

ver Digitalización avanzada Digitalización
Avanzada

Node Tool ver Digitalizando una capa
existente

Digitalización

Rotate Point Symbols ver Digitalización avanzada Digitalización
Avanzada
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After activating Toggle editing mode for a layer, you will find the Add Feature icon in the Edit menu depend-
ing on the layer type (point, line or polygon).

7.1.3 Edición (extra)

Menú Opción Atajos Referencia Barra de herramietas

Add Feature ver Digitalizando una capa existente Digitalización

Add Feature ver Digitalizando una capa existente Digitalización

Add Feature ver Digitalizando una capa existente Digitalización

7.1.4 Ver

Menú Opción Atajos Referencia Barra de
herramietas

Pan Map Navegación de
mapas

Pan Map to
Selection

Navegación de
mapas

Zoom In Ctrl++ Navegación de
mapas

Zoom Out Ctrl+- Navegación de
mapas

Seleccionar → ver Seleccionar y deseleccionar objetos
espaciales

Atributos

Identify Features Ctrl+Shift+I Atributos
Medir → ver Mediciones Atributos

Zoom Full Ctrl+Shift+F Navegación de
mapas

Zoom To Layer Navegación de
mapas

Zoom To
Selection

Ctrl+J Navegación de
mapas

Zoom Last Navegación de
mapas

Zoom Next Navegación de
mapas

Zoom Actual Size Navegación de
mapas

Ilustraciones → ver Elementos decorativos
Modo Vista previa →

Map Tips Atributos

New Bookmark Ctrl+B ver Marcadores espaciales Atributos

Show Bookmarks Ctrl+Shift+B ver Marcadores espaciales Atributos

Refresh F5 Navegación de
mapas
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7.1.5 Capa

Menú Opción Atajos Referencia Barra de
herramietas

Crear capa → ver Crear nueva capa
vectorial

Administrar Capas

Añadir capa → Administrar Capas
Embed Layers and Groups ... ver Anidar proyectos
Add from Layer Definition File ...

Copy style see Estilo de Menu

Paste style see Estilo de Menu

Open Attribute Table ver Working with the
Attribute Table

Atributos

Toggle Editing ver Digitalizando una capa
existente

Digitalización

Save Layer Edits ver Digitalizando una capa
existente

Digitalización

Current Edits → ver Digitalizando una capa
existente

Digitalización

Save as...
Save as layer definition file...

Remove Layer/Group Ctrl+D

Duplicate Layers (s)
Establecer escala de visibilidad de
las capas
Set CRS of Layer(s) Ctrl+Shift+C
Set project CRS from Layer
Properties ...
Query...

Labeling

Add to Overview Ctrl+Shift+O Administrar Capas

Add All To Overview

Remove All From Overview

Show All Layers Ctrl+Shift+U Administrar Capas

Hide All Layers Ctrl+Shift+H Administrar Capas

Show selected Layers

Hide selected Layers

26 Chapter 7. QGIS GUI



QGIS User Guide, Publicación 2.8

7.1.6 Configuración

Menú Opción Atajos Referencia Barra de
herramietas

Paneles → ver Panels and Toolbars
Barras de
herramientas→

ver Panels and Toolbars

Toggle Full Screen
Mode

F 11

Project
Properties ...

Ctrl+Shift+Pver Proyectos

Custom CRS ... ver Sistema de referencia de coordenadas
personalizada

Administrador de
estilos...

ver Presentation

Configure
shortcuts ...

Customization ... ver Personalización
Options ... ver Opciones

Snapping Options ...

7.1.7 Complementos

Menú Opción Atajos Referencia Barra de herramietas

Manage and Install Plugins ... ver El diálogo de complementos
Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vectorial

Menú Opción Atajos Referencia Barra de herramietas
menuselection:Open Street Map –> ver Cargar vectoriales OpenStreetMap

Herramientas de análisis → ver Complemento fTools

Herramientas de investigación → ver Complemento fTools

Herramientas de Geoproceso → ver Complemento fTools

Herramientas de geometría → ver Complemento fTools

Herramientas de gestión de datos → ver Complemento fTools

When starting QGIS for the first time not all core plugins are loaded.

7.1.9 Ráster

Menú Opción Atajos Referencia Barra de herramietas
Raster calculator ... see Calculadora Ráster

When starting QGIS for the first time not all core plugins are loaded.
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7.1.10 Base de datos

Menú Opción Atajos Referencia Barra de herramietas
Base de datos→ ver Complemento administrador de BBDD Base de datos

When starting QGIS for the first time not all core plugins are loaded.

7.1.11 Web

Menú Opción Atajos Referencia Barra de herramietas
Metasearch ver metabuscador Web

When starting QGIS for the first time not all core plugins are loaded.

7.1.12 Procesado

Menú Opción Atajos Referencia Barra de
herramietas

Toolbox ver La caja de herramientas

Graphical
Modeler ...

ver Modelador gráfico

History and log
...

ver El administrador del historial

Options ... ver Configurar el entorno de trabajo de
procesamiento

Results viewer ... ver Configurar aplicaciones externas

Commander Ctrl+Alt+M ver Los Comandos QGIS

When starting QGIS for the first time not all core plugins are loaded.

7.1.13 Ayuda

Menú Opción Atajos Referencia Barra de herramietas

Help Contents F1 Ayuda

What’s This? Shift+F1 Ayuda
API Documentation
Need commercial support?

QGIS Home Page Ctrl+H

Check QGIS Version

About

QGIS Sponsors

Please note that for Linux , the menu bar items listed above are the default ones in the KDE window manager.
In GNOME, the Settings menu has different content and its items have to be found here:
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Custom CRS Edit
Style Manager Edit

Configure Shortcuts Edit
Customization Edit
Options Edit

Snapping Options ... Edit

7.2 Barra de herramietas

La barra de herramientas proporciona acceso a la mayoría de las mismas funciones como las de los menús, y
herramientas adicionales para interactuar con el mapa. Cada elemento de la barra de herramientas tiene ayuda
emergente disponible. Mantenga el puntero del ratón sobre el elemento y una breve descripción del propósito de
la herramienta se mostrará.

Every menu bar can be moved around according to your needs. Additionally, every menu bar can be switched off
using your right mouse button context menu, holding the mouse over the toolbars (read also Panels and Toolbars).

Truco: Restauración de barras de herramientas
If you have accidentally hidden all your toolbars, you can get them back by choosing menu option Settings →
Toolbars →. If a toolbar disappears under Windows, which seems to be a problem in QGIS from time to time, you
have to remove key \HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state in the registry. When
you restart QGIS, the key is written again with the default state, and all toolbars are visible again.

7.3 Map Legend

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer. The Legend toolbar in the map legend are list allow you to Add group, Manage Layer Visibility
of all layers or manage preset layers combination, Filter Legend by Map Content, Expand All or Collapse All

and Remove Layer or Group. The button allows you to add Presets views in the legend. It means that
you can choose to display some layer with specific categorization and add this view to the Presets list. To add a

preset view just click on , choose Add Preset... from the drop down menu and give a name to the preset.

After that you will see a list with all the presets that you can recall pressing on the button.

Todos los preestablecidos añadidos están presentes en el diseño de impresión con el fin de permitirle crear un
diseño de mapa en base a sus puntos de vista específicos (ver Propiedades principales).

Una capa se puede seleccionar y arrastrar hacia arriba o hacia abajo en la leyenda para cambiar el orden. El orden-
z significa que las capas enlistadas más cerca de la parte superior de la leyenda son dibujadas sobre las capas que
figuran más abajo en la leyenda.

Nota: This behaviour can be overridden by the ‘Layer order’ panel.

Layers in the legend window can be organised into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Seleccionar algunas capas, al hacer clic derecho en la ventana de la leyenda y elegir Grupo Seleccionado.
Las capas seleccionadas serán colocadas automáticamente en un nuevo grupo.

Para llevar una capa fuera de un grupo, puede arrastrar hacia afuera , o haga clic derecho sobre él y elija Subir
elemento al nivel superior.

La casilla de verificación para un grupo mostrará u ocultará todas las capas en el grupo al hacer clic.
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The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers, Toggle editing is not available. See section Digitalizar y editar una capa
vectorial GRASS for information on editing GRASS vector layers.

Right mouse button menu for raster layers

• Zoom to Layer

• Show in overview

• Zoom to Best Scale (100%)

• Remove

• Duplicate

• Establecer escala de visibilidad de la capa

• Set Layer CRS

• Establecer SRC del proyecto a partir de capa

• Estilos→

• Save as ...

• Save As Layer Definition File ...

• Propiedades

• Cambiar nombre

Additionally, according to layer position and selection

• Mover al nivel superior

• Grupo seleccionado

Right mouse button menu for vector layers

• Zoom to Layer

• Show in overview

• Remove

• Duplicate

• Establecer escala de visibilidad de la capa

• Set Layer CRS

• Establecer SRC del proyecto a partir de capa

• Estilos→

• Open Attribute Table

• Toggle Editing (not available for GRASS layers)

• Save As ...

• Save As Layer Definition Style

• Filtrar

• Show Feature Count

• Propiedades

• Cambiar nombre

Additionally, according to layer position and selection

• Mover al nivel superior
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• Grupo seleccionado

Right mouse button menu for layer groups

• Zoom to Group

• Remove

• Set Group CRS

• Cambiar nombre

• Add Group

Es posible seleccionar mas de una capa o grupo al mismo tiempo manteniendo presionada la tecla Ctrl mientras
selecciona las capas con el botón izquierdo del ratón. Después puede mover todas las capas a un nuevo grupo al
mismo tiempo.

You may also delete more than one layer or group at once by selecting several layers with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

7.3.1 Trabajar con el orden de la leyenda de la capa independiente

There is a panel that allows you to define an independent drawing order for the map legend. You can activate
it in the menu Settings → Panels → Layer order. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.

Figure 7.2: Define a legend independent layer order

7.4 Vista del mapa

This is the “business end” of QGIS — maps are displayed in this area! The map displayed in this window will
depend on the vector and raster layers you have chosen to load (see sections that follow for more information on
how to load layers). The map view can be panned, shifting the focus of the map display to another region, and
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it can be zoomed in and out. Various other operations can be performed on the map as described in the toolbar
description above. The map view and the legend are tightly bound to each other — the maps in view reflect
changes you make in the legend area.

Truco: Zum al mapa con la rueda del ratón
Puede utilizar la rueda del ratón para acercar y alejar zum en el mapa. Coloque el cursor del ratón dentro del mapa
y gire la rueda hacia adelante (hacia la derecha) para acercar y hacia atrás (hacia usted) para alejarlo. El zum se
centra en la posición del cursor del ratón. Puede personalizar el comportamiento del zum de la rueda del ratón
usando la pestaña Herramientas del mapa bajo el menú Configuración→ Opciones

Truco: Desplazar el mapa con las teclas de dirección y barra de espaciadora
Puede utilizar las teclas de flechas para desplazar el mapa. Coloque el cursor dentro del mapa y haga clic en la
tecla de flecha a la derecha para desplazarse al este, tecla de flecha izquierda para el oeste, flecha arriba para el
norte y flecha abajo al sur. Puede también desplazar el mapa utilizando la barra espaciadora o al hacer clic en la
rueda del ratón: basta con mover el ratón mientras mantiene pulsada la barra espaciadora o haga clic en la rueda
del ratón.

7.5 Barra de Estado

The status bar shows you your current position in map coordinates (e.g., meters or decimal degrees) as the mouse
pointer is moved across the map view. To the left of the coordinate display in the status bar is a small button that
will toggle between showing coordinate position or the view extents of the map view as you pan and zoom in and
out.

Next to the coordinate display you will find the scale display. It shows the scale of the map view. If you zoom in or
out, QGIS shows you the current scale. There is a scale selector, which allows you to choose between predefined
scales from 1:500 to 1:1000000.

A la derecha de la escala desplegada se puede definir una rotación horaria actual de su vista de mapa en grados.

A progress bar in the status bar shows the progress of rendering as each layer is drawn to the map view. In some
cases, such as the gathering of statistics in raster layers, the progress bar will be used to show the status of lengthy
operations.

If a new plugin or a plugin update is available, you will see a message at the far left of the status bar. On the right
side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being rendered

to the map view (see section Renderizado below). The icon immediately stops the current map rendering
process.

To the right of the render functions, you find the EPSG code of the current project CRS and a projector icon.
Clicking on this opens the projection properties for the current project.

Truco: Calcular la escala correcta de su lienzo de mapa
When you start QGIS, the default units are degrees, and this means that QGIS will interpret any coordinate in your
layer as specified in degrees. To get correct scale values, you can either change this setting to meters manually in

the General tab under Settings → Project Properties, or you can select a project CRS clicking on the Current CRS:

icon in the lower right-hand corner of the status bar. In the last case, the units are set to what the project projection
specifies (e.g., ‘+units=m’).

.
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CHAPTER 8

Herramientas generales

8.1 Teclas de acceso rápido

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra de Menú. Ad-
ditionally, the menu option Settings → Configure Shortcuts.. allows you to change the default keyboard shortcuts
and to add new keyboard shortcuts to QGIS features.

Figure 8.1: Define shortcut options (Gnome)

Configuration is very simple. Just select a feature from the list and click on [Change], [Set none] or [Set default].
Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Ayuda de contexto

Cuando necesite ayuda sobre un tema especifico, puede acceder a la ayuda de contexto mediante el botón [Ayuda]
disponible en la mayoría de diálogos – tenga en cuenta que los complementos de terceros pueden apuntar a paginas
web dedicadas.

8.3 Renderizado

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Añadir una capa
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• Desplazar o hacer zoom

• Resizing the QGIS window

• Cambiar la visibilidad de una o varias capas

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Renderizado dependiente de la escala

El renderizado dependiente de la escala le permite especificar las escalas mínima y máxima a las que una capa
será visible. Para establecer el renderizado dependiente de la escala, abra el diálogo Propiedades mediante doble

clic en una capa en el panel Capas. En la pestaña General, haga clic en la casilla Visibilidad dependiente de la
escala para activar la característica, luego establezca los valores mínimo y máximo de escala.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Controlar el renderizado del mapa

Map rendering can be controlled in the various ways, as described below.

Suspender el renderizado

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Renderizado. Examples of when you might want to suspend rendering include:

• Añadir muchas capas y simbolizarlas antes de dibujar

• Añadir una o más capas grandes y establecer la dependencia de escala antes de dibujar

• Añadir una o más capas grandes y hacer zoom a una vista específica antes de dibujar

• Cualquier combinación de la anteriores

Marcar la casilla Renderizar habilita el renderizado y origina un refresco inmediato del lienzo del mapa.

Configurar la opción de añadir una capa

Puede establecer una opción para cargar siempre las nuevas capas sin dibujarlas. Esto significa que las capas se
añadirán al mapa pero su casilla de visibilidad en el panel Capas no estará marcada de forma predeterminada.
Para establecer esta opción, seleccione la opción de menú Configuración → Opciones y haga clic en la pestaña

Representación. Desmarque la casilla Por omisión, las nuevas capas añadidas al mapa se deben visualizar.
Cualquier capa añadida posteriormente al mapa estará desactivada (invisible) por omisión.

Detener el renderizado

Para detener el dibujado del mapa, presione la tecla ESC. Esto detendrá el refresco del lienzo del mapa y dejará el
mapa parcialmente dibujado. Puede que tarde un poco desde que se presiona la tecla ESC hasta que se detenga el
dibujado del mapa.

Nota: Actualmente no es posible detener la representación — esto se desactivó en el paso a Qt4 debido a
problemas y cuelgues de la Interfaz de Usuario (IU).
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Updating the Map Display During Rendering

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from the
datastore, choose menu option Settings → Options and click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance, as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Influir en la calidad del renderizado

To influence the rendering quality of the map, you have two options. Choose menu option Settings → Options,
click on the Rendering tab and select or deselect following checkboxes:

• Make lines appear less jagged at the expense of some drawing performance

• Fix problems with incorrectly filled polygons

Acelerar renderizado

There are two settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Enable back buffer. This provides better graphics performance at the cost of losing the possibility to
cancel rendering and incrementally draw features. If it is unchecked, you can set the Number of features to
draw before updating the display, otherwise this option is inactive.

• Usar cacheado de representación cuando sea posible para acelerar redibujados

8.4 Mediciones

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. If the loaded map
is defined with a geographic coordinate system (latitude/longitude), the results from line or area measurements
will be incorrect. To fix this, you need to set an appropriate map coordinate system (see section Trabajar con
Proyecciones). All measuring modules also use the snapping settings from the digitizing module. This is useful,
if you want to measure along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

8.4.1 Measure length, areas and angles

Measure Line: QGIS is able to measure real distances between given points according to a defined ellipsoid.
To configure this, choose menu option Settings → Options, click on the Map tools tab and select the appropriate
ellipsoid. There, you can also define a rubberband color and your preferred measurement units (meters or feet) and
angle units (degrees, radians and gon). The tool then allows you to click points on the map. Each segment length,
as well as the total, shows up in the measure window. To stop measuring, click your right mouse button. Note
that you can interactively change the measurement units in the measurement dialog. It overrides the Preferred
measurement units in the options. There is an info section in the dialog that shows which CRS settings are being
used during measurement calculations.

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Configurar la tolerancia del autoensamblado y radio de búsqueda). So, if you want to measure
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Figure 8.2: Measure Distance (Gnome)

exactly along a line feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now,
when using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.

Figure 8.3: Measure Area (Gnome)

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.4: Measure Angle (Gnome)

8.4.2 Seleccionar y deseleccionar objetos espaciales

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Single Feature

• Select Features by Rectangle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

To deselect all selected features click on Deselect features from all layers.
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Select feature using an expression allow user to select feature using expression dialog. See Expressions chapter for
some example.

Users can save features selection into a New Memory Vector Layer or a New Vector Layer using Edit → Paste
Feature as ... and choose the mode you want.

8.5 Identificar objetos espaciales

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click on the Identify features

icon in the toolbar.

If you click on several features, the Identify results dialog will list information about all the selected features. The
first item is the number of the layer in the list of results, followed by the layer name. Then, its first child will be the
name of a field with its value. The first field is the one selected in Properties → Display. Finally, all information
about the feature is displayed.

Esta ventana puede ser personalizada para mostrar campos personalizados, pero por omisión mostrará tres tipos
de información:

• Actions: Actions can be added to the identify feature windows. When clicking on the action label, action
will be run. By default, only one action is added, to view feature form for editing.

• Derived: This information is calculated or derived from other information. You can find clicked coordinate,
X and Y coordinates, area in map units and perimeter in map units for polygons, length in map units for
lines and feature ids.

• Data attributes: This is the list of attribute fields from the data.

Figure 8.5: Identify feaures dialog (Gnome)

At the top of the window, you have five icons:

• Expand tree

• Collapse tree

• Default behaviour

• Copy attributes

• Print selected HTML response
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At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
the identify mode: ‘Current layer’, ‘Top down, stop at first’, ‘Top down’ and ‘Layer selection’. The View can be
set as ‘Tree’, ‘Table’ and ‘Graph’.

The identify tool allows you to auto open a form. In this mode you can change the feautures attributes.

Otras funciones se pueden encontrar en el menú contextual del elemento identificado. Por ejemplo, del menú
contextual se puede:

• Ver el formulario del objeto espacial

• Zum a objeto espacial

• Copiar objeto espacial: Copiar toda la geometría y atributos del objeto espacial

• Toggle feature selection: adds identified feature to selection

• Copiar el valor del atributo: copiar solo el valor del atributo sobre el cual se hizo clic

• Copy feature attributes: Copy only attributes

• Limpiar resultados: quitar resultados de la ventana

• Limpiar resaltados: Deseleccionar los objetos espaciales en el mapa

• Resaltar todo

• Resaltar capa

• Activar capa: Elegir una capa para ser activada

• Propiedades de la capa: Abrir la ventana de propiedades de la capa.

• Expandir todo

• Colapsar todo

8.6 Elementos decorativos

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.6.1 Cuadrícula

Cuadrícula permite agregar una rejilla de coordenadas y anotaciones a la vista del mapa.

1. Seleccione en el menú Ver → Ilustraciones→ Cuadrícula. Aparece el díálogo (ver figure_decorations_1).

2. Activar la casilla Activar cuadrícula y establecer la definición de la cuadrícula de acuerdo con las capas
cargadas en la vista del mapa.

3. Activar la casilla Dibujar anotaciones y establecer la definición de las anotaciones de acuerdo con las
capas cargadas en la vista del mapa.

4. Click [Apply] to verify that it looks as expected.

5. Click [OK] to close the dialog.

8.6.2 Etiqueta de derechos de autor

Copyright label adds a copyright label using the text you prefer to the map.

1. Seleccione en el menú Ver → Ilustraciones→ Etiqueta de Copyright. Aparece el díálogo (ver fig-
ure_decorations_2).
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Figure 8.6: The Grid Dialog

Figure 8.7: The Copyright Dialog
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2. Escribir el texto que se quiera colocar en el mapa. Se puede usar HTML como se muestra en el ejemplo.

3. Choose the placement of the label from the Placement combo box.

4. Comprobar que la casilla de verificación Activar etiqueta de copyright este marcada.

5. Click [OK].

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.6.3 Flecha del Norte

North Arrow places a simple north arrow on the map canvas. At present, there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas.

Figure 8.8: The North Arrow Dialog

8.6.4 Barra de escala

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labeling of the bar.

Figure 8.9: The Scale Bar Dialog

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.
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Para añadir una barra de escala:

1. Seleccionar del menú Ver → Ilustraciones → Barra de escala. Se iniciará el diálogo (ver fig-
ure_decorations_4).

2. Choose the placement from the Placement combo box.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the size of the bar and its label Size of bar .

6. Comprobar que la casilla de verificación Habilitar barra de escala esté marcada.

7. Optionally, check Automatically snap to round number on resize.

8. Click [OK].

Truco: Configuración de elementos decorativos
Al guardar un proyecto .qgs, cualquiera de los cambios que se hayan hecho a la cuadrícula, flecha de norte, barra
de escala y copyright se guardarán en el proyecto y se restaurán la próxima vez que cargue el proyecto.

8.7 Herramientas de anotaciones

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.10: Annotation text dialog

Haciendo doble clic sobre el elemento se abre un cuadro de diálogo con varias opciones. Hay un editor de texto
para escribir el texto con formato y otros ajustes de elementos. Por ejemplo, existe la opción de tener el elemento
colocado en una posición del mapa (mostrado por el símbolo del marcador) o tener el elemento en una posición
de la pantalla (no relacionado con el mapa). El elemento se puede mover por la posición del mapa (al arrastrar el
marcador del mapa) o moviendo solo el globo. Los iconos son parte del tema de los SIG, y se utilizan de forma
predeterminada en otros temas también.

The Move Annotation tool allows you to move the annotation on the map canvas.
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8.7.1 Anotaciones HTML

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.7.2 Anotaciones SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.7.3 Anotaciones de formulario

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://www.youtube.com/watch?v=0pDBuSbQ02o from Tim Sutton for more information.

Figure 8.11: Customized qt designer annotation form

Nota: Si presiona Ctrl+T mientras está activa una herramienta Anotación (mover anotación, anotación de texto,
anotación de formulario), se invierten los estados de visibilidad de los elementos.

8.8 Marcadores espaciales

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later.
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8.8.1 Crear un marcador

Para crear un marcador:

1. Hacer zoom o desplazarse al área de interés.

2. Select the menu option View → New Bookmark or press Ctrl-B.

3. Introduzca un nombre descriptivo para el marcador (hasta 255 caracteres).

4. Press Enter to add the bookmark or [Delete] to remove the bookmark.

Tenga en cuenta que puede tener múltiples marcadores con el mismo nombre.

8.8.2 Trabajar con marcadores

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You cannot edit the bookmark name or coordinates.

8.8.3 Zooming to a Bookmark

From the Geospatial Bookmarks dialog, select the desired bookmark by clicking on it, then click [Zoom To]. You
can also zoom to a bookmark by double-clicking on it.

8.8.4 Deleting a Bookmark

To delete a bookmark from the Geospatial Bookmarks dialog, click on it, then click [Delete]. Confirm your choice
by clicking [Yes], or cancel the delete by clicking [No].

8.8.5 Import or export a bookmark

To share or transfer your bookmarks between computers you can use the Share pull down menu in the Geospatial
Bookmarks dialog.

8.9 Anidar proyectos

Si se quiere incluir contenido de otros proyectos en un proyecto, se puede elegir Capa → Empotrar capas y
grupos.

8.9.1 Empotrar capas

El siguiente cuadro de diálogo le permite incluir capas de otros proyectos. Aquí un pequeño ejemplo:

1. Press to look for another project from the Alaska dataset.

2. Select the project file grassland. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers grassland and regions. Press [OK]. The selected layers are
embedded in the map legend and the map view now.

Si bien las capas incrustadas son editables, no se pueden cambiar sus propiedades como estilo y etiquetado.

8.9. Anidar proyectos 43



QGIS User Guide, Publicación 2.8

Figure 8.12: Select layers and groups to embed

8.9.2 Eliminar capas incrustadas

Right-click on the embedded layer and choose Remove.

.
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Panels, Toolbars, Project Properties,
Options and Customization.

Nota: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described above could be located in the View menu
(Panels and Toolbars) or in Project for Options.

9.1 Panels and Toolbars

In the Panels→ menu, you can switch on and off QGIS widgets. The Toolbars→ menu provides the possibility to
switch on and off icon groups in the QGIS toolbar (see figure_panels_toolbars).

Figure 9.1: The Panels and Toolbars menu

Truco: Activating the QGIS Overview
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In QGIS, you can use an overview panel that provides a full extent view of layers added to it. It can be selected
under the menu Settings → Panels or View → Panels. Within the view is a rectangle showing the current
map extent. This allows you to quickly determine which area of the map you are currently viewing. Note that
labels are not rendered to the map overview even if the layers in the map overview have been set up for labeling.
If you click and drag the red rectangle in the overview that shows your current extent, the main map view will
update accordingly.

Truco: Show Log Messages

It’s possible to track the QGIS messages. You can activate Log Messages in the menu Settings → Panels
or View → Panels and follow the messages that appear in the different tabs during loading and operation.

9.2 Propiedades del proyecto

In the properties window for the project under Settings → Project Properties (kde) or Project → Project
Properties (Gnome), you can set project-specific options. These include:

• In the General menu, the project title, selection and background color, layer units, precision, and the option
to save relative paths to layers can be defined. If the CRS transformation is on, you can choose an ellipsoid
for distance calculations. You can define the canvas units (only used when CRS transformation is disabled)
and the precision of decimal places to use. You can also define a project scale list, which overrides the
global predefined scales.

• El menú SRC habilitado para elegir el Sistema de Referencia de Coordenadas para este proyecto, y para
habilitar la reproyección al vuelo de capas ráster y vector cuando se muestran capas de un diferente SRC.

• With the third Identify layers menu, you set (or disable) which layers will respond to the identify tool (see
the “Map tools” paragraph from the Opciones section to enable identifying of multiple layers).

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colours assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• El menú Macros es utilizado para editar macros de Python para proyectos. Actualmente, solo tres macros
están disponibles: openProject(), saveProject() and closeProject().

• El menú Relaciones es utilizado para definir relaciones 1:n. Las relaciones están definidas en el diálogo de
propiedades del proyecto. Una vez que existen las relaciones de una capa, un nuevo elemento de la interfaz
de usuario en la vista del formulario (por ejemplo al identificar un elemento espacial y abrir el formulario)
mostrará una lista de las entidades relacionadas. Este proporciona un poderosa forma para expresar, por
ejemplo la inspección de la longitud de una tubería o el segmento de carretera. Se puede encontrar más
información acerca de relaciones 1:n y soporte en la sección Creating one to many relations.

9.3 Opciones

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.
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Figure 9.2: Macro settings in QGIS

9.3.1 Menú General

Aplicación

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Define the Icon theme . Currently only ‘default’ is possible.

• Define the Icon size .

• Define the Font. Choose between Qt default and a user-defined font.

• Change the Timeout for timed messages or dialogs .

• Ocultar la pantalla de bienvenida al iniciar la aplicación

• Mostrar consejos al iniciar

• Títulos de cajas de grupos en negrita

• Cajas de grupo al estilo QGIS

• Utilizar los diálogos de selección de colores nativos

• Usar diálogos de selección de color actualizadas en vivo

• Estilo de barra lateral personalizado

• Apoyo para rotación del lienzo experimental (requiere reiniciar)

Los archivos de proyecto

• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Crear nuevo proyecto desde el proyecto predeterminado. Tiene la posibilidad de presionar Establecer
el actual proyecto como predeterminado o sobre Restablecer el predeterminado. Puede navegar a través de
sus archivos y definir un directorio donde se encuentra las plantillas definidas por el usuario. Esto se añadirá
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a Proyecto → Nueva plantilla de formulario. Si activa primero Crear nuevo proyecto desde proyecto
predeterminado y entonces guarde un proyecto en l la carpeta de las plantillas de proyecto.

• Solicitar guardar proyectos y fuentes de datos modificadas cuando sea necesario

• Pedir confirmación cuando se va a eliminar una capa

• Avisar cuando se abra un proyecto guardado con una versión anterior de QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.3.2 Menú Sistema

Entorno

Variables de entorno del sistema ahora se puede ver, y muchos lo configuran en el grupo Entorno (ver fig-
ure_environment_variables). Esto es útil para las plataformas, como Mac, donde una aplicación GUI no heredan
necesariamente entorno del casco del usuario. También es útil para configurar y visualizar las variables de en-
torno para los conjuntos de herramientas externas controladas por la caja de herramientas de procesamiento (por
ejemplo, SAGA, GRASS), y para activar la salida de depuración para secciones específicas del código fuente.

• Utilizar variables personalizadas (requiere reiniciar - incluir separadores). Puede [Añadir] y [Borrar]
variables. Las variables de entorno ya definidas se muestran en Variables de entorno actuales, y es posible

filtrarlos activando Mostrar sólo variables de QGIS específicas.

Figure 9.3: System environment variables in QGIS

Rutas de complemento

[Añadir] o [Borrar] Ruta(s) para buscar librerías de componentes en C++ adicionales
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9.3.3 Menú Fuente de datos

Atributos de entidades espaciales y tabla

• Abrir tabla de atributos en la ventana adosada (requiere reiniciar QGIS)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behaviour . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representación de valores NULOS. Aquí, puede definir un valor para los datos de campos que tienen un
valor NULO.

Manejo de fuente de datos

• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Solicitar subcapas raster al abrir. Algunas subcapas raster soportadas — se les llama subdataset en GDAL.
Un ejemplo son los archivos netCDF — si hay muchos variables netCDF, GDAL ve cada variable como un
subconjunto de datos. La opción le permite controlar cómo lidiar con subcapas cuando se abre un archivo
con subcapas. Dispone de las siguientes opciones:

– ‘Siempre’: Siempre preguntar (Si hay subcapas existentes)

– ‘Si es necesario’: Preguntar si la capa no tiene bandas, pero tiene subcapas

– ‘Nunca’: Nunca preguntar, no se cargará nada

– ‘Cargar todo’: Nunca preguntar, pero cargar todas las subcapas

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Añadir capas PostGIS con doble clic y seleccionar en modo extendido

• Añadir capas de Oracle con doble clic y seleccionar en modo extendido

9.3.4 Menú representación

Rendering behaviour

• Por defecto las nuevas capas añadidas al mapa se deben mostrar

• Utilizar el cacheo de presentación en lo posible a la velocidad de regeneración

• Representación de capas en paralelo utilizando muchos núcleos CPU

• Máximo de núcleos a utilizar

• Intervalo de actualización del mapa (por defecto 250 ms)

• Enable feature simplication by default for newly added layers
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• Simplificación del umbral

• Simplifique el lado del proveedor si es posible

• Escala máxima a la que la capa se debe simplificar

Calidad de representación

• Hacer que las líneas se muestren menos quebradas a expensas del rendimiento de la representación

Rásters

• Con Selección de la banda RGB, puede definir el numero para la banda Roja, Verde y Azul.

Mejora de contraste

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Límite para corte del conteo acumulativo de píxeles

• Multiplicador de la desviación estándar

Depuración

• Refrescar lienzo de mapa

9.3.5 Menú de Colores

Este menú le permite añadir algunos colores personalizados que puede encontrar en cada ventana de diálogo de
color de la representación. Verá un conjunto de colores predefinidos en la pestaña: se puede eliminar o editar
todos ellos. Por otra parte se puede añadir el color que se desea y realizar algunas operaciones de copiar y pegar.
Finalmente se puede exportar el conjunto de colores como un archivo gpl o importarlos.

9.3.6 Menú Vista del mapa y leyenda

Apariencia del mapa predeterminado (anulado por las propiedades del proyecto)

• Definir un Color de selección y un Color de fondo.

Leyenda de capa

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Lo siguiente es posible Estilos de elementos de la leyenda:

– Comenzar el nombre de las capas con mayúsculas

– Poner en negrita los nombres de la capa

– Poner en negrita los nombres de grupo

– Mostrar nombres de atributos de clasificación
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– Crear iconos de ráster (puede ser lento)

9.3.7 Menú Herramientas de mapa

This menu offers some options regarding the behaviour of the Identify tool.

• Radio de búsqueda para identificar y visualizar avisos en el mapa es un factor de tolerancia expresada
como un porcentaje del ancho de mapa. Esto significa que la herramienta de identificación representara los
resultados siempre y cuando haga clic dentro de esta tolerancia.

• Color de realce le permite elegir con que color deben ser identificados los objetos espaciales que están
resaltados.

• Buffer expressed as a percentage of the map width, determines a buffer distance to be rendered from the
outline of the identify highlight.

• Minimum width expressed as a percentage of the map width, determines how thick should the outline of a
highlighted object be.

Herramienta de medición

• Definir Color de la banda de medida para herramienta de medida

• Definir Lugares decimales

• Keep base unit

• Preferred measurements units (‘Meters’, ‘Feet’, ‘Nautical Miles’ or ‘Degrees’)‘

• Preferred angle units (‘Degrees’, ‘Radians’ or ‘Gon’)

Mover y zum

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Definir Factor de zum para la rueda del ratón

Escalas predefinidas

Here, you find a list of predefined scales. With the [+] and [-] buttons you can add or remove your individual
scales.

9.3.8 Menú Diseñador

Predeterminados de la composición

Se puede definir el Tipo de letra predeterminado aquí.

Apariencia de la cuadrícula

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Definir el Color de la cuadrícula

Valores predeterminados de la cuadrícula y guía

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance
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9.3.9 Menú Digitalización

Creación de entidades espaciales

• Suprimir formulario emergente de atributos después de crear objetos espaciales

• Reutilizar últimos valores de atributos introducidos

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Banda de medición

• Definir banda elástica Ancho de línea y Color de línea

Autoensamblado

• Abrir opciones de autoensamblado en una ventana adosada(requiere reiniciar QGIS)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Definir Tolerancia de autoensamblado predeterminado en unidades de mapa o píxeles

• Definir el Radio de búsqueda para edición de vértices en unidades de mapa o píxeles

Marcar vértices

• Mostrar marcadores sólo para los objetos espaciales seleccionados

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Definir vértice Tamaño de marcador

Herramienta de desplazamiento de curva

The next 3 options refer to the Offset Curve tool in Digitalización avanzada. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Estilo de la unión

• Segmentos del cuadrante

• Límite Miter

9.3.10 Menú GDAL

GDAL es una biblioteca de intercambio de datos para archivos ráster. Es esta pestaña, puede Editar opciones de
creación y Editar opciones de pirámides de los formatos ráster. Definir que controlador GDAL se va a utilizar
para un formato ráster, como en algunos casos más de un controlador está disponible.

9.3.11 Menú SRC

SRC predeterminado para nuevos proyectos

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Seleccionar un SRC y Empezar siempre nuevos proyectos con este SRC
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SRC para nuevas capas

Esta área permite definir la acción a realizar cuando una nueva capa es creada, o cuando una capa sin SRC es
cargada.

• Prompt for CRS

• Use project CRS

• Use default CRS

Por defecto transformación de datum

• Preguntar por la trasformación del datum cuando el predeterminado no este definido

• Si ha trabajado con la trasformación de SRC ‘al vuelo’ puede ver el resultado de la transformación en la
ventana de abajo. Puede encontrar información acerca de ‘Origen SRC’ y ‘Destino SRC’ así como también
‘Transformación de datum de origen’ y ‘Trasformación de datum destino’.

9.3.12 Menú Idioma

• Ignorar el idioma del sistema y Idioma a usar en su lugar

• Información acerca del idioma del sistema

9.3.13 Menú Red

General

• Definir Dirección de búsqueda de WMS, por omisión es http://geopole.org/wms/search?search=\%1\&type=rss

• Definir Expiró el tiempo para solicitudes de red - por omisión 60000

• Definir Periodo de expiración predeterminada para teselas WMS-C/WMTS (en horas) - por omisión 24

• Definir Reintentar al máximo en caso de errores en la solicitud de tile

• Definir Agente- Usuario

Configuración de caché

Definir la configuración del caché Directorio y un Tamaño.

• Usar proxy para acceso web y definir ‘Servidor’, ‘Puerto’, ‘Usuario’, y ‘Contraseña’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy se determina con base en el proxy de aplicación que establece el uso

– Socks5Proxy: Proxy genérico para cualquier tipo de conexión. Soporta TCP, UDP, unión a un puerto
(conexiones entrantes) y autenticación.

– HttpProxy: Implementado con el comando “CONNECT”, sólo admite conexiones TCP salientes; ad-
mite la autenticación.

– HttpCachingProxy: Implementando el uso de comandos HTTP normales, es útil sólo en el contexto
de peticiones HTTP.

– FtpCachingProxy: Implementar el uso de un proxy FTP, es útil sólo en el contexto de las peticiones
FTP.

Excluir algunas URLs se puede agregar a la caja de texto debajo los valores del proxy (ver Figure_Network_Tab).

Si necesita más información detallada acerca de las diferentes configuraciones de proxy, consulte el manual de
documentación de la biblioteca QT en http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Truco: Utilizar proxies
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Figure 9.4: Proxy-settings in QGIS
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El uso de proxies a veces puede ser complicado. Es útil para proceder por ‘prueba y error’ con los tipos de proxies
anteriores, comprobar para ver si en su caso tiene éxito.

You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• La configuración se guarda en un archivo de texto: $HOME/.config/QGIS/QGIS2.conf

• Puede encontrar sus ajustes en: $HOME/Library/Preferences/org.qgis.qgis.plist

• Los ajustes se almacenan bajo el registro: HKEY\CURRENT_USER\Software\QGIS\qgis

9.4 Personalización

The customization tool lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you have a lot of plugins installed that you never use and that are filling your screen.

Figure 9.5: The Customization dialog

QGIS Customization is divided into five groups. In Menus, you can hide entries in the Menu bar. In Panels,
you find the panel windows. Panel windows are applications that can be started and used as a floating, top-level

window or embedded to the QGIS main window as a docked widget (see also Panels and Toolbars). In the

Status Bar, features like the coordinate information can be deactivated. In Toolbars, you can (de)activate the

toolbar icons of QGIS, and in Widgets, you can (de)activate dialogs as well as their buttons.

With Switch to catching widgets in main application, you can click on elements in QGIS that you want to be hidden and
find the corresponding entry in Customization (see figure_customization). You can also save your various setups
for different use cases as well. Before your changes are applied, you need to restart QGIS.

.
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CHAPTER 10

Trabajar con Proyecciones

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Vista general de la ayuda de proyección

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Sistema de referencia de
coordenadas personalizada for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Especificar proyección global

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

Las opciones mostradas en figure_projection_1 son:

• Prompt for CRS

• Use project CRS

57



QGIS User Guide, Publicación 2.8

Figure 10.1: CRS tab in the QGIS Options Dialog
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• Use default CRS displayed below

If you want to define the coordinate reference system for a certain layer without CRS information, you can also do
that in the General tab of the raster and vector properties dialog (see General Menu for rasters and General Menu
for vectors). If your layer already has a CRS defined, it will be displayed as shown in Vector Layer Properties
Dialog .

Truco: SRC en la leyenda de mapa
Haga clic derecho sobre una capa en la leyenda del mapa (sección Map Legend) proporciona dos atajos. Establecer
SRC de la capa te lleva directamente al diálogo del selección de Sistema de Referencia de Coordenadas (vea
figure_projection_2). Establecer SRC del proyecto a partir de la capa redefine el SRC del proyecto mediante el
SRC de la capa.

10.3 Definir reproyección al vuelo (OTF)

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Hay tres maneras de hacer esto:

1. Select Project Properties from the Project (Gnome, OSX) or Settings (KDE, Windows) menu.

2. Hacer clic en el icono SRC actual en la esquina inferior-derecha de la barra de estado.

3. Encender OTF por omisión en la pestaña :guilabel:’CRS’ del diálogo :guilabel:’Options’ seleccionando
Permitir la reproyección ‘on the fly’ por omisión o Permitir automáticamente ´on the fly´ si las capas tienen
diferente CRS.

Si ya se ha cargado una capa y desea habilitar la proyección OTF, lo mejor es abrir la pestaña CRS del diálogo

Propiedades del Proyecto, elegir un CRS, y activar el casillero Permitir la transformación ‘on the fly’ CRS.
El ícono |geográfico| estado CRS no debe ser puesto en gris, y todas las capas serán proyectadas en OTF al CRS
exhibido cerca del ícono.

La pestaña CRS en el diálogo Propiedades del Proyecto contiene cinco componentes importantes, como se muestra
en Figura_proyección_2_y descrita abajo:

1. Habilitar la transformación ‘on the fly’ CRS — Este casillero se usa para habilitar o deshabilitar la
proyección OTF. Al estar apagado, cada capa es dibujada usando las coordenadas como se leen de la fuente
de datos, y los componentes descritos abajo están inactivos. Al encender, las coordenadas en cada capa se
proyectan al sistema de referencia de coordenadas definido por el mapa.

2. Filtro — Si conoce el código EPSG, el identificador, del nombre para un sistema de referencia por coorde-
nadas, puede usar la facción de búsqueda para encontrarlo. Ingresar el código EPSG, el identificador o el
nombre.

3. Sistemas de referencia por coordenadas usadas recientemente — Si tiene ciertos CRSs que ha usado
frecuentemente en su trabajo GIS diario, estos se desplegarán en esta lista. Clic en una de estas opciones
para seleccionar el CRS asociado.

4. Coordinate reference systems of the world — This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

5. ** Texto PROJ.4** — Esta es la cadena CRS usada por la máquina de proyección PROJ.4. Este texto es
solo de lectura y provisto para propósitos de información.

Truco: Diálogo de Propiedades del proyecto
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Figure 10.2: Project Properties Dialog

Si se abre el diálogo propiedades del Proyecto del menú Proyecto, debe dar clic en la pestaña CRS para ver los
ajustes CRS.

Abriendo el diálogo del ícono |geográfico| estado CRS traerá automáticamente al frente la pestaña CRS.

10.4 Sistema de referencia de coordenadas personalizada

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

El diálogo Definición del Sistema de Referencia de Coordenadas personalizada sólo necesita dos parámetros para
definir un usuario de SRC:

1. Un nombre descriptivo

2. Los parámetros cartográficos en el formato PROJ.4

To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.

Note que :guilaber:‘Parámetros‘ debe empezar con un bloque “+proj=”, para repersentar el nuevo sistema de
referencia por coordenadas.

Usted puede evaluar sus parámetros CRS para ver si dan resultados sensatos. Para hacer esto, ingresar valores de
longitud y latitud conocidos WGS 84 en campos Norte :guilable:‘Este‘, respectivamente. Clic en [Calcular], y
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Figure 10.3: Custom CRS Dialog

comparar los resultados con valores conocidos en su sistema de referencia por coordenadas.

10.5 Transformaciones de datos perdeterminadas

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• editar una lista de predeterminaciones de usuarios para transformaciones.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.

.
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CHAPTER 11

QGIS Browser

The QGIS Browser is a panel in QGIS that lets you easily navigate in your filesystem and manage geodata. You
can have access to common vector files (e.g., ESRI shapefiles or MapInfo files), databases (e.g., PostGIS, Oracle,
SpatiaLite or MS SQL Spatial) and WMS/WFS connections. You can also view your GRASS data (to get the data
into QGIS, see Integracion GRASS SIG).

Figure 11.1: QGIS browser as a stand alone application

Use the QGIS Browser to preview your data. The drag-and-drop function makes it easy to get your data into the
map view and the map legend.

1. Activate the QGIS Browser: Right-click on the toolbar and check Browser or select it from Settings →
Panels.

2. Drag the panel into the legend window and release it.

3. Click on the Browser tab.

4. Browse in your filesystem and choose the shapefile folder from qgis_sample_data directory.

5. Press the Shift key and select the airports.shp and alaska.shp files.

6. Press the left mouse button, then drag and drop the files into the map canvas.
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7. Right-click on a layer and choose Set project CRS from layer. For more information see Trabajar con
Proyecciones.

8. Click on Zoom Full to make the layers visible.

There is a second browser available under Settings → Panels. This is handy when you need to move files or layers
between locations.

1. Activate a second QGIS Browser: Right-click on the toolbar and check Browser (2), or select it from
Settings → Panels.

2. Drag the panel into the legend window.

3. Navigate to the Browser (2) tab and browse for a shapefile in your file system.

4. Select a file with the left mouse button. Now you can use the Add Selected Layers icon to add it into the
current project.

QGIS automatically looks for the coordinate reference system (CRS) and zooms to the layer extent if you work
in a blank QGIS project. If there are already files in your project, the file will just be added, and in the case that
it has the same extent and CRS, it will be visualized. If the file has another CRS and layer extent, you must first
right-click on the layer and choose Set Project CRS from Layer. Then choose Zoom to Layer Extent.

The Filter files function works on a directory level. Browse to the folder where you want to filter files and enter
a search word or wildcard. The Browser will show only matching filenames – other data won’t be displayed.

It’s also possible to run the QGIS Browser as a stand-alone application.

Start the QGIS browser

• Type in “qbrowser” at a command prompt.

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the stand-alone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Metadata Menu). With the Preview tab, you can
have a look at your files without importing them into your QGIS project. It’s also possible to preview the attributes
of your files in the Attributes tab.

.
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CHAPTER 12

Trabajar con catos vectoriales

.

12.1 Formatos de datos compatibles

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69
vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Referencias bibliográficas y
web). The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

Trabajar con datos vectoriales GRASS se describe en la sección Integracion GRASS SIG.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labeling and
attributes functions.

12.1.1 Archivos shape de ESRI

The standard vector file format used in QGIS is the ESRI shapefile. Support is provided by the OGR Simple
Feature Library (http://www.gdal.org/ogr/).

Un archivo shape actualmente consiste de varios archivos. Los siguientes tres son necesarios:

1. archivo .shp contiene las geometrías de los objetos espaciales

2. archivo .dbf contiene los atributos en formato dBase

3. archivo del índice .shx

Los archivos shape también incluyen un archivo con un sufijo .prj, que contiene la información de la proyec-
ción. Si bien es muy útil tener un archivo de proyección. no es obligatorio. Un conjunto de datos de archivo
shape puede contener archivos adicionales. Para mayor detalle, consulte la especificación técnica de ESRI en
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Loading a Shapefile

To load a shapefile, start QGIS and click on the Add Vector Layer toolbar button, or simply press Ctrl+Shift+V.
This will bring up a new window (see figure_vector_1).

Figure 12.1: Add Vector Layer Dialog

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the shapefile if desired.

Figure 12.2: Open an OGR Supported Vector Layer Dialog

Selecting a shapefile from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after
loading the alaska.shp file.

Truco: Capa de colores
Cuando se añade una capa al mapa, se asigna un color al azar. Cuando se añade más de una capa a la vez, diferentes
colores se asignan a cada capa.

Once a shapefile is loaded, you can zoom around it using the map navigation tools. To change the style of a
layer, open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in
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Figure 12.3: QGIS with Shapefile of Alaska loaded

the legend and choosing Properties from the context menu. See section Estilo de Menu for more information on
setting symbology of vector layers.

Truco: capa de cargada y se proyecta desde unidades externas montadas en OS X
En sistemas operativos X, unidades portátiles que se montan al lado del disco duro principal no aparecen como
se esperaba en Archivo → Abrir Proyecto. Estamos trabajando en una diálogo de abrir/guardar más nativo al SO
X para solucionar este problema. Como solución alternativa, puede escribir /Volumes en la caja Nombre del
archivo y presionar Enter. A continuación, se puede desplazar a unidades externas y los montajes de la red.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Utilice estos pasos para crear un índice:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Abrir el diálogo Propiedades de la capa haciendo doble clic sobre el nombre del archivo shape en la leyenda
o haciendo clic derecho y elegir Propiedades del menú contextual.

• En la pestaña General, hacer clic sobre el botón [Crear Índice Espacial].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
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of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Loading a MapInfo Layer

To load a MapInfo layer, click on the Add Vector Layer toolbar button; or type Ctrl+Shift+V, change the

file type filter Files of type : to ‘Mapinfo File [OGR] (*.mif *.tab *.MIF *.TAB)’ and select the MapInfo
layer you want to load.

12.1.3 Loading an ArcInfo Binary Coverage

To load an ArcInfo Binary Coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V
to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type filter Files of type

to ‘Arc/Info Binary Coverage’. Navigate to the directory that contains the coverage file, and select it.

Similarly, you can load directory-based vector files in the UK National Transfer Format, as well as the raw TIGER
Format of the US Census Bureau.

12.1.4 Archivos de Texto delimitado

Los datos tabulares son muy comunes y un formato extensamente utilizado debido a su simplicidad y legibilidad
– los datos pueden ser vistos y editados incluso en un editor de texto plano. un archivo de texto delimitado es una
tabla de atributos con cada columna separada por un caracter definido y cada fila separada por un salto de línea.
La primer fila normalmente contiene los nombres de columnas. Un tipo de campo de archivo de texto delimitado
es un CSV (Valores separados por comas), con cada columna separada por una coma.

Tales archivos de datos también pueden contener información posicional en dos formas principales:

• Como punto de coordenadas en columnas separadas

• Como representación de geometría well-known text (WKT)

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. El archivo debe tener una fila de encabezado delimitado de nombre de campos. Esto debe ser la primer línea
en el archivo de texto.

2. La fila del encabezado debe contener campo(s) con definición geometría. Estos campo(s) pueden tener
cualquier nombre.

3. La coordenada X y Y (si la geometría se define por coordenadas) se debe especificarse como números. El
sistema de coordenadas no es importante.

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Datos de ejemplo):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Algunos elementos a tener en cuenta sobre el archivo de texto:
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1. El archivo de texto de ejemplo utiliza ; (punto y coma) como delimitador. Cualquier carácter se puede
utilizar para delimitar los campos.

2. La primer fila es el encabezado. Este contiene los campos X, Y y ELEV.

3. Sin comillas (") se utilizan para delimitar los campos de texto.

4. Las coordenadas X están contenidas en el campo X.

5. La coordenada Y esta contenida en el campo Y.

Cargar un archivo de texto delimitado

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

Figure 12.4: Delimited Text Dialog

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

También hay una opción de ayuda que le permite recortar espacios iniciales y finales de los campos — Recortar

campos. Además, es posible Descartar campos vacíos. Si es necesario,se puede forzar una coma para ser el

separador decimal activando El separador decimal es la coma.
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If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionaly, you can enable:

• Utilizar índice espacial para mejorar el rendimiento de la visualización y selección de objetos espacial-
mente.

• Utilizar índice de subconjunto.

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.5 Datos OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides suppport for
OSM data.

Cargar vectoriales OpenStreetMap

QGIS integrates OpenStreetMap import as a core functionality.

• Para conectar al servidor OSM y descargar datos, abra el menú Vectorial → Openstreetmap → Descargar
datos.... Se puede saltar este paso si se ha obtenido un archivo XML .osm mediante JOSM, Overpass API
o cualquier otra fuente.

• El menú Vectorial → Openstreetmap → Importar topología a partir de XML convertirá su archivo .osm
en una base de datos SpatiaLite y cree una conexión de base de datos correspondiente.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Capas SpatiaLite).

12.1.6 Capas PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Crear una conexión almacenada

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Nombre: Un nombre para esta conexión. Este puede ser el mismo como la Base de datos

• Servicio: Parámetro de servicio para ser utilizado como alternativa de nombre del host/puerto (y potencial-
mente la base de datos). Esto se puede definido en pg_service.conf.
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• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Puerto Número de puerto al servidor de base de datos PostgreSQL escucha en. El puerto por defecto es
5432.

• Base de datos: Nombre de la base de datos.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Deshabilitar: Sólo trata una conexión SSL cifrada.

– Permitir: Trata una conexión no SSL. Si eso falla, trata una SSL.

– Preferir (por defecto): Trata una conexión SSL. Si eso falla, intenta una no SSL.

– Requerir: Sólo intenta una conexión SSL.

• Nombre de usuario: Nombre de usuario para iniciar sesión en la base de datos.

• Contraseña: Contraseña utilizada con Nombre de usuario para conectarse a la base de datos.

Opcionalmente se pueden activar las siguientes casillas:

• Guardar nombre de usuario

• Guardar contraseña

• Sólo busque en la tabla geometry_columns

• No se resuelve el tipo de columnas sin restricción (GEOMETRY)

• buscar sólo en el esquema ‘público’

• Listar también tablas sin geometría

• Utilizar metadatos de tablas estimados

Una vez que todos los parámetros y opciones estén establecidos, se puede probar la conexión al hacer clic en el
botón [Probar conexión].

Cargar una capa PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importar datos a PostgreSQL for a discussion on
importing data into the database.

Para cargar una capa de PostGIS, realizar los siguientes pasos:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Elija la conexión de la lista desplegable y haga clic en [Conectar].

• Seleccione o deseleccione Listar también las tablas sin geometría.

• Opcionalmente, utilice algunas Opciones de búsqueda para definir que objetos espaciales se deben
cargar desde la capa, o utilice el botón [Construir consulta] al iniciar el diálogo Constructor de consultas.

• Encuentre las capa(s) que desee añadir en la lista de capas disponibles.
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• Selecciónelo haciendo clic sobre él. Se puede seleccionar múltiples capas manteniendo pulsado la tecla
Shift mientras hace clic. Consulte la sección Constructor de consultas para información sobre utilizar el
constructor de consultas de PostgreSQL para definir aún más la capa.

• Haga clic en el botón [Añadir] para agregar la capa al mapa.

Truco: Capas PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Algunos detalles acerca de las capas PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Truco: Respaldo de base de datos PostGIS con capas guardadas por QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands
the default layer styles as saved by QGIS are failing to restore afterwards. You need to set the XML option to
DOCUMENT and the restore will work.

12.1.7 Importar datos a PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the SPIT plugin and the command
line tools shp2pgsql and ogr2ogr.

Administrador BBDD

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Complemento administrador de BBDD for more information.

shp2pgsql

PostGIS incluye una utilidad llamada shp2pgsql que puede ser utilizada para importar archivos shape a la base
de datos PostGIS habilitada. Por ejemplo, importar un archivo shape llamado lakes.shp en la base de datos
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PostgreSQL llamado gis_data, utilice el siguiente comando:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Esto crea una nueva capa llamada lakes_new en la base de datos gis_data. La nueva capa tendrá un identi-
ficador de referencia espacial (SRID) de 2964. Vea la sección Trabajar con Proyecciones para más información
en sistema de referencia espacial y proyecciones.

Truco: Exportar conjunto de datos de PostGIS
Como la herramienta de importar shp2pgsql, también hay una herramienta para exportar conjuntos de datos
PostGIS como archivos shape: pgsql2shp. Esta es enviada dentro de su distribución PostGIS.

ogr2ogr

Además de shp2pgsql y Administrador de BBDD, hay otra herramienta para alimentar de datos geográficos a
PostGIS: ogr2ogr. Esto es parte de su instalación GDAL.

Para importar un archivo shape a PostGIS, realice lo siguiente:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Esto importará el archivo shape alaska.shp a la base de datos de PostGIS postgis utilizando el usuario postgres
con la contraseña topsecret del servidor local myhost.de.

Tenga en cuenta que OGR se debe contruir con PostgreSQL para reconocer PostGIS. Se debe verificar esto escri-
biendo (en )

ogrinfo --formats | grep -i post

Si prefiere utilizar el comando de PostgreSQL COPY en lugar del método predeterminado INSERT INTO, se

puede exportar la siguiente variable de entorno (al menos disponible en y ):

export PG_USE_COPY=YES

ogr2ogr no crea índices espaciales como lo hace shp2pgsl. Se deben crear manualmente, utilizando el comando
SQL normal CREATE INDEX después como un paso extra (como se describe en la siguiente sección Mejorar el
desempeño).

Mejorar el desempeño

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

La sintaxis para crear un índice GiST es:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Tenga en cuenta que para tablas grandes, crear el índice puede tomar un largo tiempo. Una vez que el índice
es creado, se debe realizar un VACUUM ANALYZE. Vea la documentación de PostGIS (POSTGIS-PROJECT
Referencias bibliográficas y web) para mayor información.

El siguiente es un ejemplo de cómo crear un índice GiST:
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gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Las capas vectoriales que crusan 180° de longitud

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

Figure 12.5: Map in lat/lon crossing the 180° longitude line

Una solución temporal es transformar los valores de longitud utilizando PostGIS y la función
ST_Shift_Longitude. Esta función lee todos los puntos/vértices en todos el componentes de todos los objetos
espaciales de una geometría, y si la coordenada longitud es < 0°, se agregan 360°. El resultado es un 0° - 360°
versión de los datos que se van a representar en 180° de un mapa centrico.

Figure 12.6: Cruzar 180° de longitud aplicando la función ST_Shift_Longitude
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Uso

• Importar datos a PostGIS (Importar datos a PostgreSQL) utilizando, por ejemplo, el complemento Admin-
istrador de BBDD.

• Utilizar la interfaz de línea de comandos de PostGIS para emitir el siguiente comando (en este ejem-
plo, “TABLE” es el nombre actual de su tabla de PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Si todo fue bien, debe recibir una confirmación acerca del número de objetos espaciales que se actualizaron.
Entonces podrá cargar el mapa y ver la diferencia (Figure_vector_5).

12.1.9 Capas SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

Si desea guardar una capa vectorial a un formato SpatiaLite, se puede hacer esto al hacer clic derecho sobre la
capa en la leyenda. A continuación, haga clic sobre Guardar como.., definir el nombre del archivo de salida, y
seleccionar ‘SpatiaLite’ como formato y el SRC. También se puede seleccionar ‘SQLite’ como formato y entonces
añadir SPATIALITE=YES en el campo de opcion de creación de fuente de datos. Esto le dice a OGR crear una
base de datos SpatiaLite. También vea http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Crear una nueva capa SpatiaLite

Si se desea crear una nueva capa SpatiaLite, por favor consulte la sección Crear una nueva capa SpatiaLite.

Truco: Complemento de Administración de datos SpatiaLite
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.10 Capas MSSQL Spatial

QGIS also provides native MS SQL 2008 support. The first time you load MSSQL Spatial data, begin by

clicking on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option
from the Layer menu, or by typing Ctrl+Shift+M.

12.1.11 Capas Oracle Spatial

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.
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Crear una conexión almacenada

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Orcale Spatial Layer toolbar button, selecting the Add Orcale
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Nombre: Un nombre para esta conexión. Puede ser el mismo como la Base de datos

• Base de datos: SID o SERVICE_NAME de la instancia de Oracle.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Puerto: Número de puerto al servidor de base de datos en donde escucha Oracle. El puerto predeterminado
es 1521.

• Nombre de usuario: Nombre de usuario para iniciar sesión en la base de datos.

• Contraseña: Contraseña utilizada con Nombre de usuario para conectarse a la base de datos.

Opcionalmente, se pueden activar las siguientes casillas:

• Guardar nombre de usuario Indicar si guarda el nombre de usuario de la base de datos en la configu-
ración de la conexión.

• Guardar contraseña Indicar si se guarda la contraseña de la base de datos en la configuración de la
conexión.

• Buscar sólo en la tabla de datos meta restinge las tablas mostradas a esos que están en la vista
all_sdo_geom_metadata. Esto puede acelerar la visualización inicial de tablas espaciales.

• Buscar solo tablas de usuarios Cuando busca tablas espaciales, restringe la búsqueda a tablas que son
propiedad del usuario.

• Listar también tablas sin geometría Indica que las tablas sin geometría también se listen de forma
predeterminada.

• Utilizar metadatos de tabla estimados Cuando la capa se configura, varios metadatos son requeridos
para la tabla Oracle. Esto incluye información como el total de filas de la tabla, tipo de geometria y ex-
tensión espacial de los datos en la columna geometría. Si la tabla contiene un gran número de filas, la
determinación de esto metadatos puede llevar mucho tiempo. Al activar esta opción, las siguientes opera-
ciones de metadatos de tabla rápida se hacen: Total de filas se determina de all_tables.num_rows.
Extensión de la tabla siempre se determina con la función SDO_TUNE.EXTENTS_OF, incluso si un filtro
de capa es aplicado. La tabla de geometría se determina de los primeros 100 filas de geometría no nula en
la tabla.

• Sólo tipos de geometría existente Sólo listar los tipos de geometría existente y no ofrecer añadir otros.

Una vez que todos los parámetros y opciones estén establecidos, se puede probar la conexión al hacer clic en el
botón [Probar conexión].

Truco: Configuración de usuario QGIS User y seguridad
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• Los ajustes son almacenados en su directorio de inicio en ~/.qgis2.

• Los ajustes son almacenados en el registro.
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Cargar una capa Oracle Spatial

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Para cargar una capa de Oracle Spatial, realice los siguientes pasos:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Elija la conexión de la lista desplegable y haga clic en [Conectar].

• Seleccione o deseleccione Listar también las tablas sin geometría.

• Opcionalmente, utilice algunos Opciones de búsqueda para definir que objetos espaciales cargar de la
capa o utilice el botón [Construir consulta] para iniciar el diálogo Constructor de consulta.

• Encuentre las capa(s) que desee añadir en la lista de capas disponibles.

• Seleccionelo haciendo clic sobre él. Se puede seleccionar múltiples capas manteniendo pulsado la tecla
Shift mientras hace clic. Vea la sección Constructor de consultas para más información sobre el uso del
Constructor de consultas de Oracle para definir aún más la capa.

• Haga clic en el botón [Añadir] para agregar la capa al mapa.

Truco: Capas Oracle Spatial
Normalmente, una capa espacial de Oracle se define por una entrada en la tabla USER_SDO_METADATA.

.

12.2 La librería Símbolo

12.2.1 Presentation

The Symbol Library is the place where users can create generic symbols to be used in several QGIS projects. It
allows users to export and import symbols, groups symbols and add, edit and remove symbols. You can open it
with the Settings → Style Library or from the Style tab in the vector layer’s Properties.

Share and import symbols

Users can export and import symbols in two main formats: qml (QGIS format) and SLD (OGC standard). Note
that SLD format is not fully supported by QGIS.

share item displays a drop down list to let the user import or export symbols.

Grupos y grupos inteligentes

Groups are categories of Symbols and smart groups are dynamic groups.

To create a group, right-click on an existing group or on the main Groups directory in the left of the library. You

can also select a group and click on the add item button.

To add a symbol into a group, you can either right click on a symbol then choose Apply group and then the group

name added before. There is a second way to add several symbols into group: just select a group and click
and choose Group Symbols. All symbols display a checkbox that allow you to add the symbol into the selected
groups. When finished, you can click on the same button, and choose Finish Grouping.
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Create Smart Symbols is similar to creating group, but instead select Smart Groups. The dialog box allow user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.)

Add, edit, remove symbol

With the Style manager from the [Symbol] menu you can manage your symbols. You can add item,
edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns and ‘colour ramps’

can be used to create the symbols. The symbols are then assigned to ‘All Symbols’, ‘Groups’ or ‘Smart groups’.

Para cada tipo de símbolo, siempre encontrará la misma estructura de diálogo:

• at the top left side a symbol representation

• under the symbol representation the symbol tree show the symbol layers

• at the right you can setup some parameter (unit,transparency, color, size and rotation)

• under these parameters you find some symbol from the symbols library

The symbol tree allow adding, removing or protect new simple symbol. You can move up or down the symbol
layer.

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can define
Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. Settings will be
shown later in this chapter.

Truco: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the
whole symbol can be changed with the Size menu in the first level again. The size of the lower levels changes
accordingly, while the size ratio is maintained.

12.2.2 Símbolos de marcador

Símbolos de marcador tienen varios tipos de capas de símbolos:

• Marcador de elipse

• Marcador de fuente

• Marcador sencillo (por defecto)

• Marcador SVG

• Marcador campo vectorial

The following settings are possible:

• Tipo de capa de símbolo: Se tiene la opción para utilizar marcadores de elipse, marcadores de fuente,
marcadores sencillos, marcadores SVG y marcadores de campo vectorial.

• Colores

• Tamaño

• Estilo de línea exterior

• Anchura de línea exterior

• Ángulo

• Desplazamiento X, Y: Se puede cambiar el símbolo en la dirección x- o y-.

• Punto de anclaje

• Propiedades definidas por datos ...
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12.2.3 Símbolos línea

Símbolos de línea de marcador tienen sólo dos tipos de símbolo:

• Línea de marcador

• Línea sencilla (por defecto)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location vertex, interval or central point. Marker line can have offset along the line or
offset line. Finally, rotation allows you to change the orientation of the symbol.

The following settings are possible:

• Color

• Anchura de plumilla

• Desplazamiento

• Estilo de plumilla

• Estilo de unión

• Estilo de mayusculas

• Usar patrón de guiones personalizado

• Unidad patrón de guiones

• Propiedades definidas por datos ...

12.2.4 Símbolos de polígono

Símbolos de marcador de polígonos también tienen varios tipos de capas de símbolo:

• Relleno de centroides

• Relleno de gradiente

• Patrón de relleno de línea

• Patrón de relleno de puntos

• Relleno de imagen ráster

• Relleno SVG

• Relleno shapeburst

• Relleno sencillo (por defecto)

• Línea exterior: línea de marcador (el mismo como marcador de línea)

• Línea exterior: línea sencilla (la misma como marcador de línea)

The following settings are possible:

• Colores para el contorno y el relleno.

• Estilo de relleno

• Estilo de borde

• Ancho de borde

• Desplazamiento X, Y

• Propiedades definidas por datos ...
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Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allow you to fill in the feature with transparency. You can also just click on the button to open the palettte dialog.
Note that you can import color from some external software like GIMP.

Con el relleno de imagen ráster’ se puede rellenar polígonos con una imagen de trama de azulejos. Las opciones
incluyen (datos definidos) nombre de archivo, opacidad, anchura de imagen (en píxeles, mm o unidades de mapa),
modo de coordenadas (objeto o área de visualización) y la rotación.

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer. Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a
gradient is drawn from the boundary of a polygon towards the polygon’s centre. Configurable parameters include
distance from the boundary to shade, use of color ramps or simple two color gradients, optional blurring of the fill
and offsets.

Esto es posible solamente para dibujar los bordes del polígonos dentro del polígono. El uso de ‘Línea exterior:

Línea sencilla’ seleccionar Dibujar línea sólo dentro del polígono.

12.2.5 Color ramp

You can create a custom color ramp choosing New color ramp... from the color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, colorBrewer, or cpt-city. The first three have options for number

of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the data with
a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a for the
cpt-city dialog.

Figure 12.7: Example of custom gradient color ramp with multiple stops

La opción cpt-city abre un nuevo diálogo con cientos de temas incluidos ‘fuera de la caja’.

.
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Figure 12.8: cpt-city dialog with hundreds of color ramps
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12.3 El Dialogo de las Propiedades del Vector

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
pop-up menu.

Figure 12.9: Vector Layer Properties Dialog

12.3.1 Estilo de Menu

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You can
use Layer rendering → tools that are common to all vector data, as well as special symbolizing tools that were
designed for the different kinds of vector data.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see Presentation). The Style Manager allows you to edit and remove existing symbols and add new ones.
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After having made any needed changes, the symbol can be added to the list of current style symbols (using

[Symbol] Save in symbol library), and then it can easily be used in the future. Furthermore, you can use

the [Save Style] button to save the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If you change the renderer type when setting the style of a vector layer the settings you made for the symbol will
be maintained. Be aware that this procedure only works for one change. If you repeat changing the renderer type
the settings for the symbol will get lost.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can save your layer style inside
a table of the database. Just click on Save Style comboxbox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file and if the style is a default style. When loading a layer
from the database, if a style already exists for this layer, QGIS will load the layer and its style. You can add several
style in the database. Only one will be the default style anyway.

Figure 12.10: Save Style in database Dialog

Truco: Elegir y cambiar símbolos múltiples
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Single Symbol Renderer

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, which can be adjusted in the Style menu, depend partially on the type of layer, but all types share the
following dialog structure. In the top-left part of the menu, there is a preview of the current symbol to be rendered.
On the right part of the menu, there is a list of symbols already defined for the current style, prepared to be used
by selecting them from the list. The current symbol can be modified using the menu on the right side. If you
click on the first level in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size,
Transparency, color and Rotation. Here, the layers are joined together.

In any spinbox in this dialog you can enter expressions. E.g. you can calculate simple math like multiplying the
existing size of a point by 3 without resorting to a calculator.

If you click on the second level in the Symbol layers dialog a ‘Data-defined override’ for nearly all settings is
possible. When using a data-defined color one may want to link the color to a field ‘budged’. Here a comment
functionality is inserted.

/* This expression will return a color code depending on the field value.

* Negative value: red

* 0 value: yellow

* Positive value: green
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Figure 12.11: Single symbol line properties

Figure 12.12: Expression in Size spinbox
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*/
CASE

WHEN value < 0 THEN ’#DC143C’ -- Negative value: red
WHEN value = 0 THEN ’#CCCC00’ -- Value 0: yellow
ELSE ’#228B22’ -- Positive value: green

END

static/user_manual/working_with_vector/symbol_data_defined_edit.png

Figure 12.13: Data-defined symbol with Edit... menu

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol whose
color reflects the value of a selected feature’s attribute. The Style menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions)

• The symbol (using the Symbol dialog)

• The colors (using the color Ramp listbox)

Then click on Classify button to create classes from the distinct value of the attribute column. Each classes can
be disabled unchecking the checkbox at the left of the class name.

You can change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The [Advanced] button in the lower-right corner of the dialog allows you to set the fields containing rotation and
size scale information. For convenience, the center of the menu lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure_symbology_6 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol whose
color reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, the Style tab allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions chapter)

• The symbol (using the Symbol Properties button)

• The colors (using the color Ramp list)

Additionally, you can specify the number of classes and also the mode for classifying features within the classes
(using the Mode list). The available modes are:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;

12.3. El Dialogo de las Propiedades del Vector 85



QGIS User Guide, Publicación 2.8

Figure 12.14: Categorized Symbolizing options

Figure 12.15: Graduated Symbolizing options
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• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: the same of natural breaks but the extremes number of each class are integers.

La caja de listas en el centro de la lista de menu Style crea lista de clase juntas con sus rangos, etiquetas y simbolos
que se van a reproduccion.

Click on Classify button to create classes using the choosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

You can change symbol, value and/or label of the clic, just double clicking on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_7 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Truco: Thematic maps using an expression
Categorized and graduated thematic maps can now be created using the result of an expression. In the properties
dialog for vector layers, the attribute chooser has been augmented with a Set column expression function. So
now you no longer need to write the classification attribute to a new column in your attribute table if you want the
classification attribute to be a composite of multiple fields, or a formula of some sort.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule based symbols whose color
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

The example in figure_symbology_8 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expressions). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
match. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-klick the rules in the
map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

Point displacement

The Point Displacement Renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Truco: Export vector symbology
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Inverted Polygon

Inverted polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As before you
can select subrenderers. These subrenderers are the same as for the main renderers.

Truco: Switch quickly between styles
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Figure 12.16: Rule-based Symbolizing options

Figure 12.17: Point displacement dialog
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Figure 12.18: Inverted Polygon dialog

Once you created one of the above mentioned styles you can right-klick on the layer and choose Styles → Add to
save your style. Now you can easily switch between styles you created using the Styles → menu again.

Heatmap

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify the
heatmap radius in pixels, mm or map units, choose a color ramp for the heatmap style and use a slider for selecting
a tradeoff between render speed and quality. When adding or removing a feature the heatmap renderer updates the
heatmap style automatically.

Color Picker

Regardless the type of style to be used, the select color dialog will show when you click to choose a color - either

border or fill color. This dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker.

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is
populated with one of three methods: Recent colors, Standard colors or Project colors

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
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Figure 12.19: Color picker ramp tab

Figure 12.20: Color picker swatcher tab
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any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Truco: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the
drop-down arrow that follows a current color box.

Figure 12.21: Quick color picker menu

Reproduccion de Capas

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it. The colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with the other. In case of values
above one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the corresponding
pixels for the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.
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– Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a
very intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer from the other. In case of negative
values, black is displayed.

12.3.2 Labels Menu

The Labels core application provides smart labeling for vector point, line and polygon layers, and it only
requires a few parameters. This new application also supports on-the-fly transformed layers. The core functions
of the application have been redesigned. In QGIS, there are a number of other features that improve the labeling.
The following menus have been created for labeling the vector layers:

• Text

• Formatting

• Buffer

• Antecedentes

• Shadow

• Placement

• Rendering

Let us see how the new menus can be used for various vector layers. Labeling point layers

Start QGIS and load a vector point layer. Activate the layer in the legend and click on the Layer Labeling Options

icon in the QGIS toolbar menu.

The first step is to activate the Label this layer with checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

The following steps describe a simple labeling without using the Data defined override functions, which are
situated next to the drop-down menus.

You can define the text style in the Text menu (see Figure_labels_1 ). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the blend modes to create effects known from graphics programs (see blend_modes).

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’

function. Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places
may be inserted. If you enable this option, three decimal places are initially set by default.

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.
Here, you can also use blend modes (see blend_modes).

If the color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see blend_modes).
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Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode (see blend_modes).

Choose the Placement menu for the label placement and the labeling priority. Using the Offset from point
setting, you now have the option to use Quadrants to place your label. Additionally, you can alter the angle of
the label placement with the Rotation setting. Thus, a placement in a certain quadrant with a certain rotation is
possible. In the priority section you can define with which priority the labels are rendered. It interacts with labels
of the other vector layers in the map canvas. If there are labels from different layers in the same location then the
label with the higher priority will be displayed and the other will be left out.

In the Rendering menu, you can define label and feature options. Under Label options, you find the scale-based

visibility setting now. You can prevent QGIS from rendering only selected labels with the Show all labels for
this layer (including colliding labels) checkbox. Under Feature options, you can define whether every part of a
multipart feature is to be labeled. It’s possible to define whether the number of features to be labeled is limited

and to Discourage labels from covering features.

Figure 12.22: Smart labeling of vector point layers

Labeling line layers

The first step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column
to use for labeling. Click if you want to define labels based on expressions - See labeling_with_expressions.
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After that, you can define the text style in the Text menu. Here, you can use the same settings as for point layers.

Also, in the Formatting menu, the same settings as for point layers are possible.

The Buffer menu has the same functions as described in section labeling_point_layers.

The Background menu has the same entries as described in section labeling_point_layers.

Also, the Shadow menu has the same entries as described in section labeling_point_layers.

In the Placement menu, you find special settings for line layers. The label can be placed Parallel, Curved

or Horizontal. With the Parallel and Curved option, you can define the position Above line,

On line and Below line. It’s possible to select several options at once. In that case, QGIS will look for the
optimal position of the label. Remember that here you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_2 ).

You can set up a minimum distance for repeating labels. Distance can be in mm or in map units.

Some Placement setup will display more options, for example, Curved and Parallel Placements will allow the user
to set up the position of the label (above, below or on the line), distance from the line and for Curved, the user can
also setup inside/outside max angle between curved label. As for point vector layers you have the possibility to
define a Priority for the labels.

The Rendering menu has nearly the same entries as for point layers. In the Feature options, you can now Suppress
labeling of features smaller than.

Figure 12.23: Smart labeling of vector line layers
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Labeling polygon layers

The first step is to activate the Label this layer checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

In the Text menu, define the text style. The entries are the same as for point and line layers.

The Formatting menu allows you to format multiple lines, also similar to the cases of point and line layers.

As with point and line layers, you can create a text buffer in the Buffer menu.

Use the Background menu to create a complex user-defined background for the polygon layer. You can use the
menu also as with the point and line layers.

The entries in the Shadow menu are the same as for point and line layers.

In the Placement menu, you find special settings for polygon layers (see Figure_labels_3). Offset from centroid,
Horizontal (slow), Around centroid, Free and Using perimeter are possible.

In the Offset from centroid settings, you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label with the quadrants here, and define offset and rotation. The Around centroid setting makes it possible to
place the label around the centroid with a certain distance. Again, you can define visible polygon or whole
polygon for the centroid. With the Using perimeter settings, you can define a position and a distance for the

label. For the position, Above line, On line, Below line and Line orientation dependent position
are possible.

Related to the choice of Label Placement, several options will appear. As for Point Placement you can choose the
distance for the polygon outline, repeat the label around the polygon perimeter.

As for point and line vector layers you have the possibility to define a Priority for the polygon vector layer.

The entries in the Rendering menu are the same as for line layers. You can also use Suppress labeling of features
smaller than in the Feature options. Define labels based on expressions

Figure 12.24: Smart labeling of vector polygon layers
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QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function ‘$area()’ in combination with ‘format_number()’
to make it look nicer.

Figure 12.25: Using expressions for labeling

Expression based labeling is easy to work with. All you have to take care of is, that you need to combine all
elements (strings, fields and functions) with a string concatenation sign ‘||’ and that fields a written in “double
quotes” and strings in ‘single quotes’. Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a comma as separater
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ separated by comma
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
I live in Paris

# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town
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As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Expressions chapter for more information and examples on
expressions.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoom into a lake.

5. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6 ). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

Figure 12.26: Labeling of vector polygon layers with data-defined override

12.3.3 Fields Menu

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.

Edit Widget
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Figure 12.27: Move labels

Figure 12.28: Dialog to select an edit widget for an attribute column
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Within the Fields menu, you also find an edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. If you click on the [edit widget]
button, a dialog opens, where you can define different widgets. These widgets are:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style menu of the properties dialog.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• File name: Simplifies the selection by adding a file chooser dialog.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Photo: Field contains a filename for a picture. The width and height of the field can be defined.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Relation Reference: This widged lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

• Text edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.

• Unique values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

• Value map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• Webview: Field contains a URL. The width and height of the field is variable.

Nota: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is usefull for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.
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QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: MyForms.open

MyForms.py must live on PYTHONPATH, in .qgis2/python, or inside the project folder.

Figure 12.29: Dialog to create categories with the Attribute editor layout

12.3.4 General Menu

Use this menu to make general settings for the vector layer. There are several options available:

Layer Info

• Change the display name of the layer in displayed as

• Define the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file

Coordinate Reference System

• Specify the coordinate reference system. Here, you can view or change the projection of the specific vector
layer.

• Create a Spatial Index (only for OGR-supported formats)

• Update Extents information for a layer
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Figure 12.30: Resulting built-in form with tabs and named groups

• View or change the projection of the specific vector layer, clicking on Specify ...

Scale dependent visibility

• You can set the Maximum (inclusive) and Minimum (exclusive) scale. The scale can also be set by the
[Current] buttons.

Feature subset

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Constructor de consultas).

12.3.5 Rendering Menu

QGIS 2.2 introduces support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a new global setting that enables generalisation by default for newly added
layers (see section Opciones). Note: Feature generalisation may introduce artefacts into your rendered output
in some cases. These may include slivers between polygons and inaccurate rendering when using offset-based
symbol layers.

12.3.6 Display Menu

This menu is specifically created for Map Tips. It includes a new feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is now possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → MapTips. Figure Display 1 shows an example of HTML code.
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Figure 12.31: General menu in vector layers properties dialog

Figure 12.32: HTML code for map tip
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Figure 12.33: Map tip made with HTML code

12.3.7 Actions Menu

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Generic, Mac, Windows and Unix actions start an external process.

• Python actions execute a Python expression.

• Generic and Python actions are visible everywhere.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Add default actions]. One
example is performing a search based on an attribute value. This concept is used in the following discussion.

Defining Actions

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions menu. Go to the Action properties. Select ‘Generic’ as type and provide
a descriptive name for the action. The action itself must contain the name of the application that will be executed
when the action is invoked. You can add one or more attribute field values as arguments to the application. When
the action is invoked, any set of characters that start with a % followed by the name of a field will be replaced by
the value of that field. The special characters %% will be replaced by the value of the field that was selected from
the identify results or attribute table (see using_actions below). Double quote marks can be used to group text into
a single argument to the program, script or command. Double quotes will be ignored if preceded by a backslash.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by preceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
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Figure 12.34: Overview action dialog with some sample actions

the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.
Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

If you are invoking an action that uses the %% notation, right-click on the field value in the Identify Results dialog
or the Attribute Table dialog that you wish to pass to the application or script.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
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these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

After selecting a few localities and running the action on each one, opening the output file will show something
like this:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Make sure the lakes layer is loaded.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Click on the Actions menu.

4. Enter a name for the action, for example Google Search.

5. For the action, we need to provide the name of the external program to run. In this case, we can use Firefox.
If the program is not in your path, you need to provide the full path.

6. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

7. The text in the Action field should now look like this: firefox http://google.com/search?q=

8. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert Field] button.

9. From the drop-down box, select ‘NAMES’ and click [Insert Field].

10. Your action text now looks like this:

firefox http://google.com/search?q=%NAMES

11. To finalize the action, click the [Add to action list] button.

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

We can now use the action. Close the Layer Properties dialog and zoom in to an area of interest. Make sure the
lakes layer is active and identify a lake. In the result box you’ll now see that our action is visible:

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.

We can also make more complex examples, for instance, using Python actions.
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Figure 12.35: Select feature and choose action

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

To add a raster (a TIF image in this example), it becomes:
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qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.3.8 Joins Menu

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Figure 12.36: Join an attribute table to an existing vector layer

Additionally, the add vector join dialog allows you to:

• Cache join layer in virtual memory

• Create attribute index on the join field

• Choose which fields are joined

• Create a Custom field name prefix
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12.3.9 Diagrams Menu

The Diagrams menu allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for pie charts, text diagrams and histograms.

The menu is divided into four tabs: Appearance, Size, Postion and Options.

In the cases of the text diagram and pie chart, text values of different data columns are displayed one below the
other with a circle or a box and dividers. In the Size tab, diagram size is based on a fixed size or on linear scaling
according to a classification attribute. The placement of the diagrams, which is done in the Position tab, interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition,
chart positions can be fixed manually.

Figure 12.37: Vector properties dialog with diagram menu

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Datos de
ejemplo).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Diagrams menu, activate Display diagrams, and from the Diagram type combo box,
select ‘Text diagram’.

4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.
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6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

First select T_F_JAN as Attributes and click the button, then T_F_JUL, and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Deactivate the Fixed size and set the size of the diagrams on
the basis of an attribute with the [Find maximum value] button and the Size menu. If the diagrams appear

too small on the screen, you can activate the Increase size of small diagrams checkbox and define the
minimum size of the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_2 gives an idea of the result.

10. Finally, click [Ok].

Figure 12.38: Diagram from temperature data overlayed on a map

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression. See Expressions
chapter for more information and example.

12.3.10 Metadata Menu

The Metadata menu consists of Description, Attribution, MetadataURL and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and
location, number of features, feature type, and editing capabilities. The Extents table provides you with layer
extent information and the Layer Spatial Reference System, which is information about the CRS of the layer. This
is a quick way to get information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field. Use Attribution to get attribute data from an
XML metadata catalogue. In MetadataUrl, you can define the general path to the XML metadata catalogue. This
information will be saved in the QGIS project file for subsequent sessions and will be used for QGIS server.

.
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Figure 12.39: Metadata menu in vector layers properties dialog

12.4 Expressions

La característica Expresión está disponible a través de la calculadora de campos o el agregar un nuevo botón
columna en la tabla de atributos o la pestaña Campo (Field) en las propiedades Capa (Layer); a través del eti-

quetado basado-en-expresión en la aplicación principal :sup:’Labeling’; a través de la selección de
característica y de la pestaña diagrama de las propiedades Capa (Layer) tanto como: guilable:’Main properties’
del ítem etiqueta y la pestaña: guilable:’Atlas generation’ en el Diseñador de Impresión.

They are a powerful way to manipulate attribute value in order to dynamically change the final value in order to
change the geometry style, the content of the label, the value for diagram, select some feature or create virtual
column.

12.4.1 Functions List

The Function List contains functions as well as fields and values. View the help function in the Selected Func-
tion Help. In Expression you see the calculation expressions you create with the Function List. For the most
commonly used operators, see Operators.

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally,
you can use the various fields, values and functions to construct the calculation expression, or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side, the Field Values list opens with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provide several functions. In Operators,
you find mathematical operators. Look in Math for mathematical functions. The Conversions group contains
functions that convert one data type to another. The String group provides functions for data strings. In the
Geometry group, you find functions for geometry objects. With Record group functions, you can add a numeration
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to your data set. To add a function to the Field calculator Expression box, click on the > and then double click the
function.

Operators

This group contains operators (e.g., +, -, *).

a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three

times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match
case-insensitive)

IS returns 1 if a is the same as b
OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name, take

care to not be confused with simple
quote, see below

’string’ a string value, take care to not be
confused with double quote, see above

NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed

Some examples:

• Joins a string and a value from a column name:

’My feature’s id is: ’ || "gid"

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
character):

"description" LIKE ’Hello%’

Conditionals

Este grupo contiene funciones para menejar comprobaciones condicionales en expresiones.

CASE evaluates multiple expressions and returns a
result

CASE ELSE evaluates multiple expressions and returns a
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result
coalesce returns the first non-NULL value from the

expression list
regexp_match returns true if any part of a string matches

the supplied regular expression

Some example:

• Send back a value if the first condition is true, else another value:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’

Mathematical Functions

This group contains math functions (e.g., square root, sin and cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two

arguments to determine the quadrant of the
result

exp exponential of a value
ln value of the natural logarithm of the passed

expression
log10 value of the base 10 logarithm of the passed

expression
log value of the logarithm of the passed value

and base
round round to number of decimal places
rand random integer within the range specified by

the minimum
and maximum argument (inclusive)

randf random float within the range specified by
the minimum
and maximum argument (inclusive)

max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified

range
scale_linear transforms a given value from an input

domain to an output
range using linear interpolation

scale_exp transforms a given value from an input
domain to an output
range using an exponential curve

floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Conversions

This group contains functions to convert one data type to another (e.g., string to integer, integer to string).

toint converts a string to integer number
toreal converts a string to real number
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tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be

used to take days, hours, months, etc. off a
date)

Date and Time Functions

Este grupo contiene funciones para manipular datos de fecha y hora.

$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from

an interval
month extract the month part from a date, or the number of months

from an interval
week extract the week number from a date, or the number of weeks

from an interval
day extract the day from a date, or the number of days from an

interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

Some example:

• Get the month and the year of today in the format “10/2014”

month($now) || ’/’ || year($now)

String Functions

This group contains functions that operate on strings (e.g., that replace, convert to upper case).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title

case (all words lower case with leading
capital letter)

trim removes all leading and trailing white
space (spaces, tabs, etc.) from a string

wordwrap returns a string wrapped to a maximum/
minimum number of characters

length length of string a
replace returns a string with the supplied string

replaced
regexp_replace(a,this,that) returns a string with the supplied regular

expression replaced
regexp_substr returns the portion of a string which matches

a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression

in a string
left returns a substring that contains the n

leftmost characters of the string
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right returns a substring that contains the n
rightmost characters of the string

rpad returns a string with supplied width padded
using the fill character

lpad returns a string with supplied width padded
using the fill character

format formats a string using supplied arguments
format_number returns a number formatted with the locale

separator for thousands (also truncates the
number to the number of supplied places)

format_date formats a date type or string into a custom
string format

Color Functions

This group contains functions for manipulating colors.

color_rgb returns a string representation of a color based on its
red, green, and blue components

color_rgba returns a string representation of a color based on its
red, green, blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its

hue, saturation, and lightness attributes
color_hsla returns a string representation of a color based on its

hue, saturation, lightness and alpha (transparency)
attributes

color_hsv returns a string representation of a color based on its
hue, saturation, and value attributes

color_hsva returns a string representation of a color based on its
hue, saturation, value and alpha (transparency) attributes

color_cmyk returns a string representation of a color based on its
cyan, magenta, yellow and black components

color_cmyka returns a string representation of a color based on its
cyan, magenta, yellow, black and alpha (transparency)
components

Geometry Functions

This group contains functions that operate on geometry objects (e.g., length, area).

$geometry returns the geometry of the current feature (can be used
for processing with other functions)

$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
$y returns the y coordinate of the current feature
xat retrieves the nth x coordinate of the current feature.

n given as a parameter of the function
yat retrieves the nth y coordinate of the current feature.

n given as a parameter of the function
xmin returns the minimum x coordinate of a geometry.

Calculations are in the Spatial Reference System of this
Geometry

xmax returns the maximum x coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymin returns the minimum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
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Geometry
ymax returns the maximum y coordinate of a geometry.

Calculations are in the Spatial Reference System of this
Geometry

geomFromWKT returns a geometry created from a well-known text (WKT)
representation

geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space

together
intersects returns 1 if the geometries spatially intersect

(share any portion of space) and 0 if they don’t
touches returns 1 if the geometries have at least one point in

common, but their interiors do not intersect
crosses returns 1 if the supplied geometries have some, but not

all, interior points in common
contains returns true if and only if no points of b lie in the

exterior of a, and at least one point of the interior
of b lies in the interior of a

overlaps returns 1 if the geometries share space, are of the
same dimension, but are not completely contained by
each other

within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose

distance from this geometry is less than or equal to
distance

centroid returns the geometric center of a geometry
bounds returns a geometry which represents the bounding box of

an input geometry. Calculations are in the Spatial
Reference System of this Geometry.

bounds_width returns the width of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

bounds_height returns the height of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

convexHull returns the convex hull of a geometry (this represents
the minimum convex geometry that encloses all geometries
within the set)

difference returns a geometry that represents that part of geometry
a that does not intersect with geometry b

distance returns the minimum distance (based on spatial ref)
between two geometries in projected units

intersection returns a geometry that represents the shared portion
of geometry a and geometry b

symDifference returns a geometry that represents the portions of a and
b that do not intersect

combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of

the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata
geometry returns the feature’s geometry
transform returns the geometry transformed from the source CRS to

the dest CRS

Record Functions

Este grupo contiene funciones que operan sobre identificadores de registros.
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$rownum returns the number of the current row
$id returns the feature id of the current row
$currentfeature returns the current feature being evaluated.

This can be used with the ’attribute’ function
to evaluate attribute values from the current
feature.

$scale returns the current scale of the map canvas
$uuid generates a Universally Unique Identifier (UUID)

for each row. Each UUID is 38 characters long.
getFeature returns the first feature of a layer matching a

given attribute value.
attribute returns the value of a specified attribute from

a feature.
$map returns the id of the current map item if the map

is being drawn in a composition, or "canvas" if
the map is being drawn within the main QGIS
window.

Fields and Values

Contains a list of fields from the layer. Sample values can also be accessed via right-click.

Select the field name from the list, then right-click to access a context menu with options to load sample values
from the selected field.

Fields name should be double-quoted. Values or string should be simple-quoted.

.

12.5 Editar

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Nota: El procedimiento para edición de capas GRASS es diferente - vea la sección Digitalizar y editar una capa
vectorial GRASS para más detalles.

Truco: Las ediciones simultáneas
This version of QGIS does not track if somebody else is editing a feature at the same time as you are. The last
person to save their edits wins.

12.5.1 Configurar la tolerancia del autoensamblado y radio de búsqueda

Before we can edit vertices, we must set the snapping tolerance and search radius to a value that allows us an
optimal editing of the vector layer geometries.

Tolerancia de autoensamblado

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QGIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
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‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. A layer-based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer-based snapping overrides the global snapping option set in the Digitizing tab. So, if you need
to edit one layer and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer that
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Figure 12.40: Edit snapping options on a layer basis (Advanced mode)

The Snapping options enables you to make a quick and simple general setting for all layers in the project so that
the pointer snaps to all existing vertices and/or segments when using the ‘All layers’ snapping mode. In most cases
it is sufficient to use this snapping mode.

It is important to consider that the per-layer tolerance in ‘map units’ was actually in layer units. So if working
with a layer in WGS84 reprojected to UTM, setting tolerance to 1 map unit (i.e. 1 meter) wouldn’t work correctly
because the units would be actually degrees. So now the ‘map units’ has been relabeled to ‘layer units’ and the
new entry ‘map units’ operates with units of the map view. While working with ‘on-the-fly’ CRS transformation
it is now possible to use a snapping tolerance that refers to either the units of the reprojected layer (setting ‘layer
units’) or the units of the map view (setting ‘map units’).

Radio de búsqueda

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing, and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project- wide snapping tolerance.

12.5.2 Zooming and Panning

Before editing a layer, you should zoom in to your area of interest. This avoids waiting while all the vertex markers
are rendered across the entire layer.
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Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

Zooming and panning with the mouse wheel

While digitizing, you can press the mouse wheel to pan inside of the main window, and you can roll the mouse
wheel to zoom in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Panning with the arrow keys

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area,
and click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow
key to pan south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.

12.5.3 Edición topológica

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, you can activate the column Avoid Int., which avoids intersection of new polygons.

Habilitar edición topológica

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic, so you only have to move the vertex once, and QGIS will
take care of updating the other boundary.

Evitar intersecciones de nuevos polígonos

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons, avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitize the second one such that both intersect, and QGIS then cuts the second
polygon to the common boundary. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Habilitar autoensamblado en intersecciones

Otra opción es utilizar Habilitar autoensamblado en intersección. Le permitirá que se ajuste a una intersección
de las capas de fondo, incluso si no hay ningún vértice en la intersección.

12.5.4 Digitalizando una capa existente

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).
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In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitalización avanzada. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Icono Propósito Icono Propósito

Ediciones actuales Conmutar edición

Adding Features: Capture Point Adding Features: Capture Line

Adding Features: Capture Polygon Mover objeto espacial

Herramienta de nodos Borrar lo seleccionado

Cortar objetos espaciales Copiar objetos espaciales

Pegar objetos espaciales Guardar cambios de la capa

Edición de tabla: Barra de herramientas de edición básica de capa vectorial

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for a given layer.

Alternatively, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.

Truco: Guardar regularmente

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Añadir objetos espaciales

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to put the QGIS cursor into
digitizing mode.

For each feature, you first digitize the geometry, then enter its attributes. To digitize the geometry, left-click on
the map area to create the first point of your new feature.

For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing menu under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature and Reuse last entered
attribute values.

Figure 12.41: Enter Attribute Values Dialog after digitizing a new vector feature

With the Move Feature(s) icon on the toolbar, you can move existing features.
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Truco: Attribute Value Types
For editing, the attribute types are validated during entry. Because of this, it is not possible to enter a number into
a text column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the attributes
in a second step within the Attribute table dialog.

Current Edits

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

Las mismas funciones están disponibles para editar todas las capas del proyecto.

Herramienta de nodos

For shapefile-based layers as well as SpatialLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle Spatial tables,

the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It is possible to
simply select multiple vertices at once and to move, add or delete them altogether. The node tool also works with
‘on the fly’ projection turned on, and it supports the topological editing feature. This tool is, unlike other tools in
QGIS, persistent, so when some operation is done, selection stays active for this feature and tool. If the node tool
is unable to find any features, a warning will be displayed.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e., 10). Otherwise, QGIS will not be able to tell which vertex is being edited.

Truco: Marcadores vértices
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Operaciones básicas

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Añadir vértices: Para añadir un vértice, sólo haga doble clic cerca de un borde y un nuevo vértice aparecerá
en el borde cerca del cursor. Tome en cuenta que el vértice aparecerá en el borde, no el la posición del cursor;
por lo tanto se debe mover si es necesario.

• Deleting vertices: After selecting vertices for deletion, click the Delete key. Note that you cannot use the
Node Tool to delete a complete feature; QGIS will ensure it retains the minimum number of vertices for

the feature type you are working on. To delete a complete feature use the Delete Selected tool.
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• Moving vertices: Select all the vertices you want to move. Click on a selected vertex or edge and drag in
the direction you wish to move. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Cortar, copiar, y pegar objetos espaciales

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However, in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

Como un ejemplo, copiaremos algunos lagos a una nueva capa:

1. Cargar la capa desde donde desee copiar (capa fuente)

2. Cargar o crear la capa a la que desee copiar (capa destino)

3. Comenzar a editar la capa destino

4. Hacer la capa de fuente activa haciendo clic sobre ella en la leyenda

5. Use the Select Single Feature tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Hacer la capa de destino activa haciendo clic en la leyenda.

8. Click on the Paste Features tool

9. Detener edición y guardar los cambios

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Truco: Congruencia del pegado de objetos espaciales
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Truco: Copiar atributos de texto en otro
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accomodate for the length of the data to be inserted.
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Borrar objetos espaciales seleccionados

If we want to delete an entire polygon, we can do that by first selecting the polygon using the regular
Select Single Feature tool. You can select multiple features for deletion. Once you have the selection set, use the

Delete Selected tool to delete the features.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Guardar capas editadas

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Truco: Integridad de datos
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

12.5.5 Digitalización avanzada

Icono Propósito Icono Propósito

Deshacer Rehacer

Rotar objeto(s) espacial(es) Simplificar objeto espacial

Añadir anillo Añadir parte

Rellenar anillo Borrar anillo

Borrar parte Remodelar objetos espaciales

Desplazar curva Dividir objetos espaciales

Dividir partes Combinar objetos espaciales seleccionados

Combinar atributos de objetos espaciales seleccionados Rotar símbolos de puntos

Edición avanzada de tabla: la barra de herramientas de edición avanzada de capa vectorial

Deshacer y rehacer

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.
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Figure 12.42: Redo and Undo digitizing steps

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example, changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

Utilizar el widget de historial de deshacer/rehacer, sólo haga clic para seleccionar la operación en la lista del
histórico. Todos los objetos espaciales se revertirán al estado que tenían después de la operación de seleccionada.

Rotar objeto(s) espacial(es)

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and then
click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user input
widget. If you want to rotate several features, they shall be selected first.

Si se habilita la herramienta del mapa con objeto(s) seleccionados, su (ellos) centroide aparecerá y será el punto
de delimitación de rotación. Si se desea mover el punto de delimitación, mantenga el botón Ctrl y haga clic en
el mapa para colocarlo.

Si se mantiene Shift antes de hacer clic en el mapa, la rotación se hará en pasos de 45 grados, que pueden ser
modificados después en el widget de entrada del usuario.

Simplificar objeto espacial

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change. With the tool you can also simplify multi-part features. First, drag a rectangle over the feature.
The vertices will be highlighted in red while the color of the feature will change and a dialog where you can define
a tolerance in map units or pixels will appear. QGIS calculates the amount of vertices that can be deleted while
maintaining the geometry using the given tolerance. The higher the tolerance is the more vertices can be deleted.
After gaining the statistics about the simplification just klick the OK button. The tolerance you used will be saved
when leaving a project or when leaving an edit session. So you can go back to the same tolerance the next time
when simplifying a feature.

Añadir anillo

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.
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Añadir parte

You can add part polygons to a selected multipolygon. The new part polygon must be digitized outside the
selected multi-polygon.

Rellenar anillo

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Thus you need not first use the Add Ring icon and then the Add feature function anymore.

Borrar anillo

The Delete Ring tool allows you to delete ring polygons inside an existing area. This tool only works with
polygon layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used
on polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.

Borrar parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). It won’t delete the last part of the feature; this last part will stay untouched. This tool works with all
multi-part geometries: point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.

Remodelar objetos espaciales

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

Por ejemplo, se puede editar el limite de un polígono con esta herramienta. En primer lugar, haga clic en la zona
interior del polígono junto al punto en el que desea añadir un nuevo vértice. A continuación, cruce el limite y añada
los vértices fuera del polígono. Para finalizar, haga clic derecho en la zona interior del polígono. La herramienta
añadirá automáticamente un nodo en la nueva línea que cruza el limite. También es posible eliminar parte de la
zona del polígono, a partir de la nueva línea fuera del polígono, agregar vértices en el interior, y poner fin a la línea
exterior del polígono con un clic derecho.

Nota: La herramienta de remodelar podría alterar la posición inicial de un anillo de polígono o una linea cerrada.
Por lo tanto, el punto que está representado ‘dos veces’ no será más el mismo. Esto puede no ser un problema
para la mayoría de las aplicaciones, pero es algo a considerar.

Desplazar curva

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar.
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To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input
widget. Your changes may then be saved with the|mActionSaveEdits|:sup:Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.

Dividir objetos espaciales

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Dividir partes

In QGIS 2.0 it is now possible to split the parts of a multi part feature so that the number of parts is increased. Just

draw a line across the part you want to split using the Split Parts icon.

Combinar objetos espaciales seleccionados

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Combinar atributos de objetos espaciales

The Merge Attributes of Selected Features tool allows you to merge attributes of features with common boundaries

and attributes without merging their boundaries. First, select several features at once. Then press the
Merge Attributes of Selected Features button. Now QGIS asks you which attributes are to be applied to all selected objects.
As a result, all selected objects have the same attribute entries.

Rotar símbolos de puntos

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.43: Rotate Point Symbols
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To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

Nota: Si se mantiene presionada la tecla Ctrl, la rotación se realiza en pasos de 15 grados.

12.5.6 El panel de Digitalización Avanzada

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geomtry.

_figure_advanced_edit 1:

Figure 12.44: The Advanced Digitizing panel

Las herramientas no están habilitadas si la vista del mapa esta en coordenadas geográficas.

12.5.7 Crear nueva capa vectorial

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Crear una nueva capa vectorial GRASS for more information on creating GRASS vector layers.

Crear una nueva capa de archivo shape

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Digitalizando una
capa existente above.

126 Chapter 12. Trabajar con catos vectoriales



QGIS User Guide, Publicación 2.8

Figure 12.45: Creating a new Shapefile layer Dialog

Crear una nueva capa SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_6.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitalizando una capa existente above.

Además de la gestión de capas SpatiaLite se puede hacer con la DBManager. Ver Complemento administrador de
BBDD.

Crear una nueva capa GPX

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.
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Figure 12.46: Creating a New SpatiaLite layer Dialog
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Crear una nueva capa temporal

Empty, editable memory layers can be defined using Layer → Create Layer → New Temporary Scratch Layer.
Here you can even create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon Layers. Temporary Scratch Layers are not saved and will be discarded when QGIS is closed. See also
paste_into_layer .

12.5.8 Working with the Attribute Table

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figure 12.47: Attribute Table for regions layer

Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).
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For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Calculadora de campo). The query result can then be saved as a new vector layer. For example, if you want
to find regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and
Values menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all
unique values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query
appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Constructor de consultas.

To show selected records only, use Show Selected Features from the menu at the bottom left.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the file:regions.shp with the expression

ID+5

as shown in figure_attributes_1 .

The other buttons at the top of the attribute table window provide the following functionality:

• Toggle editing mode to edit single values and to enable functionalities described below (also with Ctrl+E)

• Save Edits (also with Ctrl+S)

• Unselect all (also with Ctrl+U)

• Move selected to top (also with Ctrl+T)

• Invert selection (also with Ctrl+R)

• Copy selected rows to clipboard (also with Ctrl+C)

• Zoom map to the selected rows (also with Ctrl+J)

• Pan map to the selected rows (also with Ctrl+P)

• Delete selected features (also with Ctrl+D)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+W)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+L)

• Open field calculator (also with Ctrl+I)

Below these buttons is the Field Calculator bar, which allows calculations to be quickly applied attributes visible

in the table. This bar uses the same expressions as the Field Calculator (see Calculadora de campo).

Truco: Skip WKT geometry
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If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Map Legend). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.

Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Fields Menu to find out more.

12.5.9 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.
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Figure 12.48: Alaska region with airports

Layers

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demostrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in
Settings → Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly
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Figure 12.49: Relation Manager

Figure 12.50: Identification dialog regions with relation to airports
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• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.51: Identification dialog airport with relation to regions

.

12.6 Constructor de consultas

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause and to display the
result in the main window. The query result can then be saved as a new vector layer.

12.6.1 Consulta

Open the Query Builder by opening the Layer Properties and going to the General menu. Under Feature subset,
click on the [Query Builder] button to open the Query builder. For example, if you have a regions layer with a
TYPE_2 field, you could select only regions that are borough in the Provider specific filter expression box of the
Query Builder. Figure_attributes_2 shows an example of the Query Builder populated with the regions.shp
layer from the QGIS sample data. The Fields, Values and Operators sections help you to construct the SQL-like
query.
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Figure 12.52: Constructor de consultas

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

.

12.7 Calculadora de campo

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.
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Truco: Virtual Fields
• Virtual fields are not permanent and are not saved.

• To make a field virtual it must be done when the field is made.

The field calculator is now available on any layer that supports edit. When you click on the field calculator icon
the dialog opens (see figure_attributes_3). If the layer is not in edit mode, a warning is displayed and using the
field calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is editable.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on Update All button.

12.7.1 Expression tab

In the field calculator dialog, you first must select whether you want to only update selected features, create a new
attribute field where the results of the calculation will be added or update an existing field.

Figure 12.53: Field Calculator

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:
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1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Complete the expression by typing ‘’/ 1000” in the Field calculator expression box and click [Ok].

7. You can now find a new field length in the attribute table.

The available functions are listed in Expressions chapter.

12.7.2 Function Editor tab

With the Function Editor you are able to define your own Python custom functions in a comfortable way. The
function editor will create new Python files in qgis2pythonexpressions and will auto load all functions
defined when starting QGIS. Be aware that new functions are only saved in the expressions folder and not in
the project file. If you have a project that uses one of your custom functions you will need to also share the .py file
in the expressions folder.

Here’s a short example on how to create your own functions:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2 feature, parent):

pass

The short example creates a function ‘myfunc’ that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number of
arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)

Your function will be implemented in the ‘Custom’ Functions of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found on http://www.qgis.org/html/en/docs/pyqgis_developer_cookbook/index.html.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions. See also Expressions.

.
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CHAPTER 13

Trabajar con catos raster

.

13.1 Trabajar con Datos Raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

As of the date of this document, more than 100 raster formats are supported by the GDAL library
(see GDAL-SOFTWARE-SUITE in Referencias bibliográficas y web). A complete list is available at
http://www.gdal.org/formats_list.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Working with GRASS raster data is described in section Integracion GRASS SIG.

13.1.1 What is raster data?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.

139

http://www.gdal.org/formats_list.html


QGIS User Guide, Publicación 2.8

Once a raster layer is loaded in the map legend, you can click on the layer name with the right mouse button to
select and activate layer-specific features or to open a dialog to set raster properties for the layer.

Right mouse button menu for raster layers

• Zoom to Layer Extent

• Zoom to Best Scale (100%)

• Stretch Using Current Extend

• Show in Overview

• Remove

• Duplicate

• Set Layer CRS

• Set Project CRS from Layer

• Save as ...

• Properties

• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

.

13.2 Dialogo de Propiedades Raster

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog
(see figure_raster_1).

There are several menus in the dialog:

• General

• Style

• Transparency

• Pyramids

• Histogram

• Metadata

13.2.1 General Menu

Layer Info

The General menu displays basic information about the selected raster, including the layer source path, the display
name in the legend (which can be modified), and the number of columns, rows and no-data values of the raster.
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Figure 13.1: Raster Layers Properties Dialog

Coordinate reference system

Here, you find the coordinate reference system (CRS) information printed as a PROJ.4 string. If this setting is not
correct, it can be modified by clicking the [Specify] button.

Scale Dependent visibility

Additionally scale-dependent visibility can be set in this tab. You will need to check the checkbox and set an
appropriate scale where your data will be displayed in the map canvas.

At the bottom, you can see a thumbnail of the layer, its legend symbol, and the palette.

13.2.2 Estilo de Menu

Band rendering

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands)

2. Paletted - if a single band file comes with an indexed palette (e.g., used with a digital topographic map)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continous palette (e.g., used with a shaded relief
map)

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map)
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Multiband color

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. You can choose several Contrast
enhancement methods: ‘No enhancement’, ‘Stretch to MinMax’, ‘Stretch and clip to MinMax’ and ‘Clip to min
max’.

Figure 13.2: Raster Renderer - Multiband color

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Truco: Viewing a Single Band of a Multiband Raster
If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to “Not Set”. But this is not the correct way. To display the Red band, set the image type to
‘Singleband gray’, then select Red as the band to use for Gray.

Paletted

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS 2.2.
it’s now possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Contrast enhancement

Nota: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to stretch
to min max, regardless of if this is set to another value in the QGIS general options.
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Figure 13.3: Raster Renderer - Paletted

Singleband gray

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Singleband pseudocolor
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This is a render option for single-band files, including a continous palette. You can also create individual color
maps for the single bands here. Three types of color interpolation are available:

Figure 13.5: Raster Renderer - Singleband pseudocolor

1. Discrete

2. Linear

3. Exact

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the

144 Chapter 13. Trabajar con catos raster



QGIS User Guide, Publicación 2.8

original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Color rendering

For every Band rendering, a Color rendering is possible.

You can also achieve special rendering effects for your raster file(s) using one of the blending modes (see El
Dialogo de las Propiedades del Vector).

Further settings can be made in modifiying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Remuestreo

The Resampling option makes its appearance when you zoom in and out of an image. Resampling modes can
optimize the appearance of the map. They calculate a new gray value matrix through a geometric transformation.

Figure 13.6: Raster Rendering - Resampling

When applying the ‘Nearest neighbour’ method, the map can have a pixelated structure when zooming in. This
appearance can be improved by using the ‘Bilinear’ or ‘Cubic’ method, which cause sharp features to be blurred.
The effect is a smoother image. This method can be applied, for instance, to digital topographic raster maps.

13.2.3 Transparency Menu

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Additionally, you can enter a raster value that should be treated as NODATA in the Additional no data value menu.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are neccessary:
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1. Load the raster file landcover.tif.

2. Open the Properties dialog by double-clicking on the raster name in the legend, or by right-clicking and
choosing Properties from the pop-up menu.

3. Select the Transparency menu.

4. From the Transparency band menu, choose ‘None’.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Enter the raster value in the ‘From’ and ‘To’ column (we use 0 here), and adjust the transparency to 20%.

7. Press the [Apply] button and have a look at the map.

You can repeat steps 5 and 6 to adjust more values with custom transparency.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Pyramids Menu

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

You must have write access in the directory where the original data is stored to build pyramids.

Several resampling methods can be used to calculate the pyramids:

• Nearest Neighbour

• Average

• Gauss

• Cubic

• Mode

• None

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

Please note that building pyramids may alter the original data file, and once created they cannot be removed. If
you wish to preserve a ‘non-pyramided’ version of your raster, make a backup copy prior to building pyramids.

13.2.5 Histogram Menu

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.
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Figure 13.7: The Pyramids Menu

Figure 13.8: Raster Histogram
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13.2.6 Metadata Menu

The Metadata menu displays a wealth of information about the raster layer, including statistics about each band in
the current raster layer. From this menu, entries may be made for the Description, Attribution, MetadataUrl and
Properties. In Properties, statistics are gathered on a ‘need to know’ basis, so it may well be that a given layer’s
statistics have not yet been collected.

Figure 13.9: Raster Metadata

.

13.3 Calculadora Ráster

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

13.3.1 Ejemplos

Convert elevation values from meters to feet
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Figure 13.10: Calculadora Ráster

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:

"elevation@1" * 3.28

El uso de una máscara

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

.
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CHAPTER 14

Trabajar con datos OGC

.

14.1 QGIS as OGC Data Client

El Open Geospatial Consortium (OGC) es una organización internacional con miembros de más de 300 organi-
zaciones comerciales, gubernamentales, sin fines de lucro y de investigación de todo el mundo. Sus miembros
desarrollan e implementan estándares para contenido geoespacial y servicios, procesamiento de datos SIG y el
intercambio.

Al describir un modelo de datos básico para las características geográficas, un número cada vez mayor de las es-
pecificaciones son desarrollados por OGC para atender las necesidades específicas de ubicación interoperable y la
tecnología geoespacial, incluyendo SIG. Más información se puede encontrar en http://www.opengeospatial.org/.

Important OGC specifications supported by QGIS are:

• WMS — Web Map Service (Cliente WMS/WMTS)

• WMTS — Web Map Tile Service (Cliente WMS/WMTS)

• WFS — Web Feature Service (Cliente WFS y WFS-T)

• WFS-T — Web Feature Service - Transactional (Cliente WFS y WFS-T)

• WCS — Web Coverage Service (WCT Cliente)

• SFS — Simple Features for SQL (Capas PostGIS)

• GML — Lenguaje de Marcado Generalizado

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section Capas PostGIS).

14.1.1 Cliente WMS/WMTS

Información general de la implementación WMS

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
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images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.

Las capas WMS se pueden añadir sencillamente, siempre que conozca la URL para acceder al servidor WMS, si
tiene una conexión útil a ese servidor, y el servidor entiende HTTP como mecanismo de transporte de datos.

Información general de la implementación WMTS

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

Para mostrar los datos en una variedad de escalas cercanas a lo que el usuario podría querer, los conjuntos de
teselas WMTS se producen en varios niveles de escala diferentes y están disponibles para el cliente SIG para
pedirlos.

Este diagrama ejemplifica el concepto de conjunto de teselas:

Figure 14.1: Concepto de conjunto de teselas WMTS

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un ejemplo de este tipo de dirección es

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Para probar la capa topo2 en este WMTS funciona muy bien. Añadir esta cadena indica que un servicio web
WMTS se va a utilizar en lugar de un servicio WMS.

2. EL servicio RESTful WMTS toma una forma diferente, una URL sencilla. EL formato recomendado por
OGC es:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by simply
adding its address in the WMS setup in the URL field of the form. An example of this type of address for the case
of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.
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Nota: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just
add ?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Cuando se lee WMTS, a menudo se puede pensar en WMS-C también.

Seleccionar servidor WMS/WMTS

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

El diálogo Añadir capa(s) desde un servidor para añadir capas que aparezcan en el servidor WMS. Se
pueden agregar algunas capas para jugar haciendo clic en el botón [Añadir servidores predetermina-
dos]. Este añadirá dos servidores demo WMS para usar: los servidores WMS de DM Solutions Group y
Lizardtech. Para definir un nuevo servidor WMS en la pestaña Capas, seleccionar el botón [Nuevo]. A con-
tinuación introduzca los parámetros para conectarse a su servidor deseado, como se indica en table_OGC_1:

Nombre Un nombre para esta conexión. Este nombre se utilizará en la lista desplegable de
conexiones a servidor así que se puede distinguir de otros servidores WMS.

URL La URL del servidor provee los datos. Este debe ser un nombre de host soluble – el
mismo formato que usaría para abrir una conexión telnet o ping a un host.

Nombre de
usuario

Nombre de usuario para acceder a un servidor asegurado de WMS. Este parámetro es
opcional.

Contraseña Contraseña para una autentificación básica al servidor WMS. Este parámetro es opcional

Ignorar URI
GetMap

Ignorar URI GetMap reportada en las capacidades. Utilice un URI dado del campo
URL anterior.

Ignorar la URI
GetFeatureInfo

Ignorar la URI GetFeatureInfo reportada en las capacidades. Utilice un URI dado
del campo URL anterior.

Tabla OGC 1: Parámetros de conexión WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Truco: En las direcciones URL del servidor WMS
Asegúrese, al introducir la URL del servidor WMS, que tiene solo la base URL. Por ejemplo, no debe tener
fragmentos como request=GetCapabilities o version=1.0.0 en su URL.

Cargando capas WMS/WMTS

Una vez que haya llenado exitosamente en sus parámetros, puede utilizar el botón [Conectar] para recuperar
las capacidades del servidor seleccionado. Esto incluye la codificación de la imagen, capas, estilos de capa y
proyecciones. Como es una operación de la red, la velocidad de respuesta depende de la calidad de la conexión de
red al servidor WMS. Mientras descarga los datos desde el servidor WMS, el proceso de descarga se visualizara
en la parte inferior izquierda del dialogo WMS.

Su pantalla debe ahora lucir un poco como figure_OGR_1, que muestra la respuesta proporcionada por el servidor
WMS del European Soil Portal.

Codificación de la Imagen

La sección Codificación de la imagen lista los formatos que reconoce por ambos el cliente y el servidor. Elija uno
dependiendo de sus requerimientos de precisión de imagen.
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Figure 14.2: Dialog for adding a WMS server, showing its available layers
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Truco: Codificación de la Imagen
Normalmente, encontrará que un servidor WMS le ofrece la opción de codificación de la imagen en JPEG o PNG.
JPEG es un formato de compresión con pérdida, mientras que PNG reproduce fielmente los datos crudos raster.

Utilizar JPEG si se espera que los datos WMS sean de naturaleza fotográfica y/o no le importa cierta perdida de
calidad de la imagen. Esta disyuntiva típicamente reduce en cinco veces la necesidad de transferencia de datos en
comparación con PNG.

Utilice PNG si desea representaciones precisas de los datos originales y no le importa el incremento de los requi-
sitos de transferencia de datos.

Opciones

La zona Opciones del diálogo provee un campo de texto donde se puede añadir un Nombre de capa para la capa
WMS. Este nombre aparecerá en la leyenda después de cargar la capa.

Debajo del nombre de la capa, se puede definir Tamaño de la tesela, si desea establecer tamaños de tesela (por
ejemplo, 256x256) para dividir la petición WMS en múltiples peticiones.

El Límite del objeto espacial para GetFeatureInfo define los objetos espaciales del servidor a consultar.

Si se selecciona un WMS de la lista, aparece un campo con la proyección predeterminada proporcionada por el
servidor de mapas. Si el botón [Cambiar...] está activo, puede hacer clic en él y cambiar la proyección por defecto
de los WMS a otro SRC proporcionado por el servidor WMS.

Finalmente puede activar Utiliza leyenda-WMS contextual si el servidor WMS admite este objeto. Entonces
sólo la leyenda relevante para su actual extensión de vista de mapa se mostrará y así no incluirá los elementos de
la leyenda por cosas que no puede ver en el mapa actual.

Orden de la capa

La pestaña Orden de Capas lista las capas seleccionadas disponibles de la conexión actual al servidor WMS.
Puede notar que algunas capas son ampliables; esto significa que la capa se puede visualizar en una selección de
estilos de imagen.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Truco: Ordenar capas WMS
Las capas WMS representadas por un servidor son sobrepuestas en el orden listado en la sección de Capas, desde
la parte superior a la parte inferior de la lista. Si se desea cambiar el orden de la superposición, se puede usar la
pestaña Orden de capas.

Transparencia

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Truco: Transparencia de capa WMS
La disponibilidad de imagen WMS transparente depende de la codificación de la imagen utilizada: PNG y GIF
reconoce la transparencia, mientras JPEG deja sin reconocerlo.

Sistema de referencia de coordenadas

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Cada capa WMS se puede representar en múltiples SRC’s, dependiendo de la capacidad del servidor WMS.

Para elegir un SRC, seleccione [Cambiar...] y un cuadro de diálogo similar a Figure Projection 3 en Trabajar con
Proyecciones aparecerá. La principal diferencia con la versión WMS del diálogo es que sólo aquellos SRCs son
reconocidos por el servidor WMS se le mostrarán.
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Busqueda del servidor

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

Figure 14.3: Dialog for searching WMS servers after some keywords

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Básicamente, esta opción es una interfaz del API de http://geopole.org.

Conjunto de teselas

Al utilizar servicios WMTS (Cached WMS) como

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE and Windows) or View → Panels (Gnome and MacOSX), then choosing Tile
scale. This gives you the available scales from the tile server with a nice slider docked in.
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Utilizar la herramienta de Identificar objetos espaciales

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Selección de Formato

Si múltiples formatos de salida son reconocidos por el servidor, una lista desplegable con formatos admitidos se
añade automáticamente al diálogo de resultados identificados y el formato seleccionada puede ser almacenado en
el proyecto para la capa. Usar formato GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Ver propiedades

Una vez que haya añadido un servidor WMS, puede ver sus propiedades haciendo clic derecho sobre el mismo en
la leyenda y la seleccionar Propiedades. Pestaña de Metadatos

La pestaña Metadatos muestra una gran cantidad de información acerca del servidor WMS, generalmente obtenida
de la declaración de capacidades de ese servidor. Muchas definiciones pueden ser extraídas mediante la lectura
del estándar WMS (vea OPEN-GEOSPATIAL-CONSORTIUM en Referencias bibliográficas y web), pero aquí
hay algunas definiciones útiles:

• Propiedades del servidor

– Versión WMS — La versión WMS implementada por el servidor.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Propiedades de la capa
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– Seleccionar — Sea o no esta capa seleccionada cuando su servidor fue añadido a este proyecto.

– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Poder Identificar — Sea o no esta capa regresará algunos resultados cuando la herramienta de iden-
tificar se utilice en él.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Conteo en Cascada — Los servidores WMS pueden actuar como proxy para otros servidores WMS
para obtener datos ráster de una capa. Esta entrada muestra el número de veces que se remitió la
solicitud de esta capa para ver a los servidores WMS para obtener un resultado.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Disponible en SRC — Las proyecciones que esta capa puede representar por el servidor WMS. Éstos
se enumeran en el formato nativo de WMS.

– Disponible en estilo — Los estilos de imagen que esta capa puede representar por el servidor WMS.

Mostrar leyenda gráfica WMS en la tabla de contenido y diseñador de impresión

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Si hay definida una legendGraphic, ésta se mostrará debajo de la capa. Es pequeña y hay que hacer clic sobre ella
para abrirla en tamaño real (debido a una limitación de la arquitectura de QgsLegendInterface). Al hacer clic en
la leyenda de la capa se abrirá un cuadro con la leyenda a la máxima resolución.

In the print composer, the legend will be integrated at it’s original (dowloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend -> WMS LegendGraphic to match your printing
requirements

La leyenda mostrará información contextual basada en su escala actual. La leyenda WMS se muestra sólo si el
servidor WMS tiene capacidad GetLegendGraphic y la capa tiene definida una url getCapability, para lo que se
debe seleccionar un estilo.

Limitaciones del cliente WMS

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

Editar la configuración de la capa WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

**Autentificación necesaria en servidores WMS **
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Actualmente, se admiten servicios WMS públicamente accesibles y garantizados. Los servidores WMS garantiza-
dos se puede acceder mediante autenticación pública. El usuario puede agregar las credenciales (opcional) cuando
agregue un servidor WMS. Vea la sección :ref: ogc-wms-servers para más detalles.

Truco: Acceso garantizado a capas OGC
Si necesita acceder a capas protegidas mediante métodos seguros que no sean la autenticación básica, puede
utilizar InteProxy como un proxy transparente, lo que lo hace compatible con varios métodos de autenticación.
Puede encontrar más información en el manual InteProxy en http://inteproxy.wald.intevation.org.

Truco: QGIS WMS Mapserver
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.

14.1.2 WCT Cliente

Un Web Coverage Service (WCS) proporciona acceso a los datos ráster en formas que son útiles para la
representación del lado cliente, como datos de entrada en los modelos científicos, y para otros clientes. El WCS
se puede comparar con la WFS y el WMS. Como WMS y WFS instancias de servicios, un WCS permite a los
clientes elegir partes de las explotaciones de información de un servidor basado en restricciones espaciales y otros
criterios de consulta.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

14.1.3 Cliente WFS y WFS-T

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

En general, añadir una capa WFS es muy similar al procedimiento utilizado con WMS. La diferencia es que no
hay servidores por defecto definidos, así que tenemos que añadir la nuestra.

Cargar una capa WFS

Como un ejemplo, utilizamos el servidor WFS de DM Solutions y mostramos una capa. La URL es
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Haga clic en la herramienta Añadir capa WFS en la barra de herramientas Capas. El diálogo Añadir capa
WFS de un servidor aparecera.

2. Haga clic en [Nuevo].

3. Ingrese ‘DS Solutions’ como nombre.

4. Introducir la URL (véase más arriba).

5. Haga clic en [Aceptar].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Haga clic en [Conectar]

8. Espere a que la capa de capas este poblada.

9. Seleccione la capa Parks en la lista.
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10. Haga clic en [Aplicar] para añadir la capa al mapa.

Tenga en cuenta que cualquier configuración de proxy que pueda haber establecido en sus preferencias también
son reconocidos.

Figure 14.4: Adding a WFS layer

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Sólo la versión 1.0.0 de WFS es compatible. Por ahora, no ha habido muchas pruebas contra versiones WFS
implementados en otros servidores de la CMA. Si tiene problemas con cualquier otro servidor WFS, por favor no
dude en ponerse en contacto con el equipo de desarrollo. Por favor, consulte la sección :ref: label_helpsupport
para más información sobre las listas de correo.

Truco: Encontrar servidores WFS
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

.

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. It is
funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In one of the following manuals, we will provide a sample configuration to set up a QGIS Server. For now, we
recommend to read one of the following URLs to get more information:
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• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Sample installation on Debian Squeeze

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian Squeeze. Many other OSs provide packages for QGIS Server, too. If you have to build
it all from source, please refer to the URLs above.

Firstly, add the following debian GIS repository by adding the following repository:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --recv-key DD45F6C3
$ sudo gpg --export --armor DD45F6C3 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS-Server:

$ sudo apt-get install qgis-server python-qgis

La instalación de un complemento de ejemplo HelloWorld para probar los servidores. Se puede crear un direc-
torio para mantener los complementos del servidor. Esto se especificará en la configuración del host virtual y
transmitirlo al servidor a través de una variable de entorno.

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Instalar el servidor Apache en un host virtual separado que escuche en el puerto 80. Habilitar el módulo de
reescritura de pasar encabezados HTTP BASIC de autenticación:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

Esta es la configuración del host virtual, almacenado en /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
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FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# ABP: needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Ahora habilitar el host virtual y reiniciar Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Probar el servidor con el complemento HelloWorld:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCpabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Truco: If you work with a feature that has many nodes then modyfying and adding a new feature will fail. In this
case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Creating a WMS/WFS/WCS from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.
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Figure 14.5: Definitions for a QGIS Server WMS/WFS/WCS project (KDE)
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Use the button below to select those CRS from the Coordinate Reference System Selector, or click Used to
add the CRS used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetCapabilities response, and they
can be used by the GetPrint request to create prints, using one of the print composer layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries at once.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format choosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of his attributes, also this information will be shown
in the GetFeatureInfo output.

QGIS support the following request for WMS service:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (perfil SLD)

• DescribeLayer (perfil SLD)

• GetStyles (perfil QGIS personalizado)

WFS capabilities

In the WFS capabilities area, you can select the layers that you want to publish as WFS, and specify if they
will allow the update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS
capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

QGIS support the following request for WFS service:

• GetCapabilities

• DescribeFeatureType

• GetFeature

• Transacción

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Ahora, guardarmos la sesión en un archivo de proyecto alaska.qgs. Para proveer el proyecto como
WMS/WFS, creamos una nueva carpeta /usr/lib/cgi-bin/project con privilegios de administrados y
añadimos el archivo del proyecto alaska.qgs y copiamos del archivo qgis_mapserv.fcgi - eso es todo.
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Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Cargando capas
WMS/WMTS, Cliente WFS y WFS-T and WCT Cliente to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS support the following request for WCS service:

• GetCapabilities

• DescribeCoverage

• GetCoverage

Ajuste fino de OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you want a specific
attribute not to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG anno-
tations to the project file. See section Annotation Tools in Herramientas generales for instructions on creating
annotations. For annotations to be displayed as watermarks on the WMS output, the Fixed map position check
box in the Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation
while one of the annotation tools is active. For SVG annotations, you will need either to set the project to save
absolute paths (in the General menu of the Project → Project Properties dialog) or to manually modify the path
to the SVG image in a way that it represents a valid relative path.

Parámetros extra soportados por la petición GetMap del WMS

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OCG WMS 1.3.0 specification:

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Ejemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• Parámetro DPI: El parámetro DPI se puede utilizar para especificar la resolución de la solicitud de salida.

Ejemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• Parámetro OPACITIES: La opacidad se puede establecer en una capa o nivel de grupo. Los valores permi-
tidos van de 0 (completamente transparente) a 255 (totalmente opaco).

Ejemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

QGIS Server logging

To log requests send to server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Especifica la ruta y el nombre de archivo. Comprobar que el servidor tiene
los permisos apropiados para escritura de archivo. El archivo debe ser creado automáticamente, sólo envié
algunas solicitudes al servidor. Si no está allá, verifique los permisos.
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• QGIS_SERVER_LOG_LEVEL: Especifica el nivel de registro deseado. los valores disponibles son:

– 0 INFO (registrar todas las solicitudes),

– 1 ADVERTENCIA,

– 2 CRÍTICA (Registrar sólo errores críticos, adecuado para fines de producción)

Ejemplo:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note

• ¡Al usar el módulo Fcgid utilice FcgidInitialEnv en lugar de SetEnv!

• Server logging is enabled also if executable is compiled in release mode.

Variables de entorno

• QGIS_OPTIONS_PATH: The variable specifies path to directory with settings. It works
the same ways as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini. For exaple, to set QGIS server on Apache to use
/path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

.
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Trabajar con datos GPS

.

15.1 Plugin de GPS

15.1.1 What is GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Loading GPS data from a file

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• GPS Tools

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Datos de ejemplo for more infor-
mation about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Figure 15.1: The GPS Tools dialog window

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importing GPS data

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

15.1.5 Downloading GPS data from a device

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Defining new device types).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• On Linux, this is something like /dev/ttyS0 or /dev/ttyS1.

• On Windows, it is COM1 or COM2.

168 Chapter 15. Trabajar con datos GPS

http://www.topografix.com/GPX/1/1/
http://www.gpsbabel.org


QGIS User Guide, Publicación 2.8

Figure 15.2: The download tool

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

15.1.6 Uploading GPS data to a device

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Defining new device types

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.

Once you have created a new device type, it will appear in the device lists for the download and upload tools.
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15.1.8 Download of points/tracks from GPS units

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

After that is necessary to be sure that the garmin_gps kernel module is not loaded

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (only Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Use same command (or settings if you use GPSBabel GUI) as in Windows. On Linux it maybe somehow common
to get a message like

skytraq: Too many read errors on serial port

it is just a matter to turn off and on the datalogger and try again.

BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

Nota: It needs to install its drivers before using it on Windows 7. See in the manufacturer site for the proper
download.

Downloading with GPSBabel, both with USB and BT returns always an error like

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1
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Ubuntu/Mint GNU/Linux

With USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

With Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

.

15.2 Seguimiento de GPS en Vivo

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

There are four possible screens in this GPS tracking window:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Advertencia: If you want to record your position to the canvas, you have to create a new vector layer first
and switch it to editable status to be able to record your track.

15.2.1 Position and additional attributes

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 GPS signal strength

Here, you can see the signal strength of the satellites you are receiving signals from.

15.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Figure 15.3: GPS tracking position and additional attributes

Figure 15.4: GPS tracking signal strength
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Figure 15.5: GPS tracking polar window

15.2.4 GPS options

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Connect to a Bluetooth GPS for live tracking

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Remember the number of the COM port assigned to the GPS connection as resulting by the Bluetooth properties.

After the GPS has been recognized, make the pairing for the connection. Usually the autorization code is 0000.
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Figure 15.6: GPS tracking options window
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Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

15.2.6 Using GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Then load the garmin_gps kernel module

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

And finally connect with the QGIS live tracking tool.

15.2.7 Using BTGP-38KM datalogger (only Bluetooth)

Using GPSD (under Linux) or GPSGate (under Windows) is effortless.

15.2.8 Using BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

For USB

The live tracking works both with GPSD

gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

For Bluetooth

The live tracking works both with GPSD
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gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).

.
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CHAPTER 16

Integracion GRASS SIG

The GRASS plugin provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Ref-
erencias bibliográficas y web). This includes visualizing GRASS raster and vector layers, digitizing vector layers,
editing vector attributes, creating new vector layers and analysing GRASS 2-D and 3-D data with more than 400
GRASS modules.

In this section, we’ll introduce the plugin functionalities and give some examples of managing and working with
GRASS data. The following main features are provided with the toolbar menu when you start the GRASS plugin,
as described in section sec_starting_grass:

• Open mapset

• New mapset

• Close mapset

• Add GRASS vector layer

• Add GRASS raster layer

• Create new GRASS vector

• Edit GRASS vector layer

• Open GRASS tools

• Display current GRASS region

• Edit current GRASS region

16.1 Iniciar el complemento GRASS

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore, go to the menu Plugins → Manage Plugins, select

GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section
sec_load_grassdata). Or, you can create a new GRASS LOCATION with QGIS (see section Crear una nueva
LOCALIZACIÓN GRASS) and import some raster and vector data (see section Importar datos dentro de una LO-
CALIZACIÓN DE GRASS) for further analysis with the GRASS Toolbox (see section La caja de herramientas
GRASS).
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16.2 Cargar capas ráster y vectorial de GRASS

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu.
As an example, we will use the QGIS Alaska dataset (see section Datos de ejemplo). It includes a small sample
GRASS LOCATION with three vector layers and one raster elevation map.

1. Create a new folder called grassdata, download the QGIS ‘Alaska’ dataset
qgis_sample_data.zip from http://download.osgeo.org/qgis/data/ and unzip the file into
grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase, browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click [OK]. The Alaska boundary
vector layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as
described in chapter El Dialogo de las Propiedades del Vector (e.g., change opacity, fill and outline color).

10. Also load the other two vector layers, rivers and airports, and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See the following sections for
editing GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the
GRASS website at http://grass.osgeo.org/download/sample-data/.

Truco: Cargando datos GRASS
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section Iniciar el complemento GRASS.

16.3 LOCALIZACIÓN y DIRECTORIO DE MAPA GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Referencias bibliográficas y web). In
order to analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION.
(This is not strictly true – with the GRASS modules r.external and v.external you can create read-only
links to external GDAL/OGR-supported datasets without importing them. But because this is not the usual way
for beginners to work with GRASS, this functionality will not be described here.)

16.3.1 Crear una nueva LOCALIZACIÓN GRASS

As an example, here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska

178 Chapter 16. Integracion GRASS SIG

http://download.osgeo.org/qgis/data/
http://grass.osgeo.org/download/sample-data/


QGIS User Guide, Publicación 2.8

Figure 16.1: Datos GRASS en la LOCALIZACIÓN alaska

will be used for all examples and exercises in the following GRASS-related sections. It is useful to download and
install the dataset on your computer (see Datos de ejemplo).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Loading a Shapefile) from the QGIS Alaska dataset (see
Datos de ejemplo).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Seleccione un conjunto de datos GRASS existente (GISDBASE) la carpeta grassdata, o cree una para la
nueva LOCALIZACIÓN utilizando un administrador de archivos en su computadores. A continuación haga
clic en [Siguiente].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Añadir un
nuevo DIRECTORIO DE MAPA) or to create a new LOCATION altogether. Select Create new location
(see figure_grass_location_2).

6. Escriba un nombre para la LOZALIZACIÓN – usemos ‘alaska’ y haga clic en [Siguiente].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Trabajar con Proyecciones)).

9. En Filtrar, inserte 2964 para seleccionar la proyección.

10. Clic [Siguiente].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current |qg| extent], to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Clic [Siguiente].

13. También necesitamos definir un DIRECTORIO DE MAPA dentro de nuestra nueva LOCALIZACIÓN (esto
es necesario al crear una nueva LOCALIZACIÓN). Puede nombrarlo como quiera - nosotros usamos ‘demo’.
GRASS automáticamente crea un DIRECTORIO DE MAPA especial llamado PERMANENT, designado
para almacenar los datos base para la proyección, su extensión espacial por defecto y sistema de coordenadas
definida (vea Neteler & Mitasova 2008 en Referencias bibliográficas y web)

14. Revise el resumen para asegurarse que es correcto y haga clic en [Finalizar]
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15. La nueva LOCALIZACIÓN, ‘alaska’, y los dos DIRECTORIO DE MAPAS, ‘demo’ y ‘PERMANENT’,
son creados. El conjunto de trabajo abierto actualmente es ‘demo’, como se ha definido.

16. Tenga en cuenta que algunas de las herramientas en la barra de herramientas de GRASS que estaban inhab-
ilitadas ahora están habilitadas.

Figure 16.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importar datos dentro de una LOCALIZACIÓN DE
GRASS). You can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’,
included in the QGIS ‘Alaska’ dataset Datos de ejemplo, and move on to section El modelo de datos vectoriales
de GRASS.

16.3.2 Añadir un nuevo DIRECTORIO DE MAPA

A user has write access only to a GRASS MAPSET he or she created. This means that besides access to your own
MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify or remove
only the maps in your own MAPSET.

Todos los DIRECTORIO DE MAPAS incluyen un archivo WIND que almacena los valores de las coordenadas de
los límites actuales y la resolución ráster actualmente seleccionado (vea Neteler & Mitasova 2008 en Referencias
bibliográficas y web, y la sección La herramienta de región GRASS).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Seleccione la base de datos GRASS (GISDBASE) la carpeta grassdata con la LOCALIZACIÓN
‘alaska’, donde queremos añadir otro DIRECTORIO DE MAPA llamado ‘test’.

4. Clic [Siguiente].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Introduzca el nombre text para el nuevo DIRECTORIO DE MAPA. A continuación en el asistente, se ve
una lista de un existente DIRECTORIO DE MAPAS y titulares correspondientes.

7. Haga clic en [Siguiente], valide el resumen para asegurarse que todo es correcto y haga clic en [Finalizar]
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16.4 Importar datos dentro de una LOCALIZACIÓN DE GRASS

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset. Therefore, we use the landcover raster map landcover.img and the
vector GML file lakes.gml from the QGIS ‘Alaska’ dataset (see Datos de ejemplo).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section La caja de herramientas GRASS)
dialog appears.

5. Para importar el mapa ráster landcover.img, haga clic en el modulo r.in.gdal en la pestaña
Árbol de módulos. Este modulo GRASS le permite importar archivos ráster GDAL-admitidos en un
LOCALIZACIÓN de GRASS. El diálogo del módulo para que r.in.gdal aparezca.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. Como nombre de salida del ráster, defina landcover_grass y haga clic en [Ejecutar].
en la pestaña Salida, y vea el comando GRASS actualmente ejecutado r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass.

8. When it says Succesfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. Para importar el archivo vector GML lakes.gml, haga clic en el modulo v.in.ogr en la pestaña Ár-
bol de módulos. Este modulo GRASS le permite importar archivos vectoriales OGR-admitidos en una
LOCAZACIÓN de GRASS. El diálogo del modulo para que v.in.ogr aparezca.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. Como nombre de salida del vector, define lakes_grass y haga clic en [Ejecutar]. No tiene que pre-
ocuparse por las otras opciones en este ejemplo. En la pestaña Salida se ve el comando GRASS ejecutado
actualmente v.in.ogr -o dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

16.5 El modelo de datos vectoriales de GRASS

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Además de los límites y centroides, un mapa vectorial también puede contener puntos y líneas. Todos estos
elementos geométricos se pueden mezclar en una vector y serán representados en diferentes denominadas ‘capas’
dentro de un mapa vectorial GRASS. Por lo que en GRASS, una capa no es un mapa vectorial o ráster pero un
nivel dentro de una capa vectorial. Esto es importante para distinguir cuidadosamente. (aunque es imposible
mezclar elementos, es inusual e incluso en GRASS, sólo se utiliza en casos especiales como análisis de redes
vectoriales. Usualmente, se debe preferir almacenar diferentes elementos geométricos en diferentes capas.)

Es posible almacenar varias ‘capas’ en un conjunto de datos vectoriales. Por ejemplo, campos, bosques y lagos se
pueden almacenar en un vector. Un bosque y lago adyacente pueden compartir el mismo límite, pero tienen tablas
de atributos separados. También es posible adjuntar atributos a límites. Un ejemplo podría ser el caso donde los
límites entre un lago y un bosque es una carretera, por lo que puede tener una tabla de atributos diferente.
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La ‘capa’ del objeto espacial es definido por la ‘capa’ dentro de GRASS. ‘Capa’ es el número que define si hay más
de una capa dentro del conjunto de datos (por ejemplo, si la geometría es bosque o lago). Por ahora, sólo puede
ser un número. En el futuro, GRASS también implementara nombres como campos en la interfaz de usuario.

Attributes can be stored inside the GRASS LOCATION as dBase or SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Los atributos en la tabla de base de datos están enlazadas a los elementos geométricos utilizando un valor ‘cate-
goría’.

‘Categoría’ (llave, ID) es un entero adjunto a la geometría primitiva, y se utiliza como el enlace a una columna
llave en la tabla de base de datos.

Truco: Aprendizaje del modelo vectorial GRASS
La mejor forma de aprender el modelo vectorial GRASS y sus capacidades es descargar uno de
los muchos tutoriales de GRASS donde el modelo vectorial se describe más profundo. Vea
http://grass.osgeo.org/documentation/manuals/ para más información, libros y tutoriales en varios idiomas.

16.6 Crear una nueva capa vectorial GRASS

To create a new GRASS vector layer with the GRASS plugin, click the Create new GRASS vector toolbar icon. Enter
a name in the text box, and you can start digitizing point, line or polygon geometries following the procedure
described in section Digitalizar y editar una capa vectorial GRASS.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Crear nueva capa vectorial).

Truco: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

16.7 Digitalizar y editar una capa vectorial GRASS

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

Truco: Digitalizando polígonos en GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason for this is that a topological vector model links the attribute information of a polygon always to the
centroid and not to the boundary.

Barra de herramientas

In figure_grass_digitizing_1, you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.
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Figure 16.3: GRASS Digitizing Toolbar

Icono Herramienta Propósito

Nuevo punto Digitalizar un nuevo punto

Nueva línea Digitalizar nueva línea

Nuevo límite Digitize new boundary (finish by selecting new tool)

Nuevo
centroide

Digitalizar nuevo centroide (etiqueta de área existente)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move
element

Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line into two parts

Delete
element

Delete existing boundary, line, point or centroid (confirm selected element by
another click)

Edit attributes Edit attributes of selected element (note that one element can represent more
features, see above)

Close Close session and save current status (rebuilds topology afterwards)

Tabla de digitalización GRASS 1: Herramientas de digitalización GRASS

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Figure 16.4: GRASS Digitizing Category Tab

• Mode: The category value that will be applied to new geometry elements.

– Next not used - Apply next not yet used category value to geometry element.

– Manual entry - Manually define the category value for the geometry element in the ‘Category’ entry
field.
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– No category - Do not apply a category value to the geometry element. This is used, for instance, for
area boundaries, because the category values are connected via the centroid.

• Category - The number (ID) that is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. The default layer number is 1.

Truco: Creating an additional GRASS ‘layer’ with |qg|
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab, you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Figure 16.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g., closed / opened boundary).

Figure 16.6: GRASS Digitizing Symbology Tab

Table Tab
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The Table tab provides information about the database table for a given ‘layer’. Here, you can add new columns
to an existing attribute table, or create a new database table for a new GRASS vector layer (see section Crear una
nueva capa vectorial GRASS).

Figure 16.7: GRASS Digitizing Table Tab

Truco: Editar permisos de GRASS
Debe ser el propietario del DIRECTORIO DE MAPA de GRASS que desee editar. Es imposible editar capas de
datos en un DIRECTORIO DE MAPA que no sea suyo, incluso si tiene permisos de escritura.

16.8 La herramienta de región GRASS

La definición de la región (ajuste una ventana de trabajo espacial) en GRASS es importante para trabajar con
capas ráster. Análisis vectorial esta por defecto no limitado a cualquier definición de región definida. Pero todas
los rásters recién creados tendrán la extensión espacial y resolución de la región GRASS definida actualmente,
independientemente de su extensión y resolución original. La región GRASS actual es almacenada en el archivo
$LOCALIZACIÓN/$DIRECTORIO DE MAPA/WIND, y define los límites norte, sur, este y oeste, número de
columnas y filas, resolución espacial horizontal y vertical.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon, you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution, and click [OK].
The dialog also allows you to select a new region interactively with your mouse on the QGIS canvas. Therefore,
click with the left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again
and click [OK].

El modulo GRASS g.region proporciona muchos más parámetros para definir una extensión de región apropi-
ada y resolución para su análisis ráster. Se puede utilizar estos parámetros con la caja de herramientas GRASS,
descrito en la sección La caja de herramientas GRASS.

16.9 La caja de herramientas GRASS

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.
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Figure 16.8: Caja de herramienta GRASS y módulo

16.9.1 Trabajando con módulos GRASS

La consola GRASS dentro de la caja de herramientas proporciona acceso a casi todo (más de 300) los módulos
GRASS en una interfaz de línea de comando. Para ofrecer un entorno de trabajo más fácil de usar, cerca de 200 de
los módulos de GRASS disponibles y funcionalidades también son proporcionados por diálogos gráficos dentro
de la caja de herramientas del complemento GRASS.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.8 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

También es posible personalizar el contenido de la caja de herramientas GRASS. Este procedimiento se describe
en la sección Personalizar la caja de herramientas GRASS.

Como se muestra en figure_grass_toolbox_1, puede buscar el modulo GRASS apropiado utilizando las temáticas
agrupadas Árbol de módulos o en la pestaña de búsqueda Lista de módulos.

Al hacer clic en un icono de modulo gráfico, una nueva pestaña se añadirá al diálogo de Caja de herramientas,
proporciona tres nuevas sub-pestañas Opciones, Salida y Manual.

Opciones

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Salida

La pestaña Salida proporciona información acerca del estado de salida del módulo. Cuando haga clic en botón
[Ejecutar], el módulo cambia a la pestaña de Salida y verá información acerca del proceso de análisis. Si todo
funciona bien finalmente verá un mensaje Finalizado con éxito

Manual

La pestaña Manual muestra la página de ayuda HTML del modulo GRASS. Se puede utilizar para comprobar
otros parámetros de los módulos y las banderas o para obtener un conocimiento más profundo acerca de la final-
idad del módulo. Al final de cada página del manual del módulo, se ven otros enlaces al Índice de ayuda
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Figure 16.9: Opciones del módulo de la caja de herramientas GRASS

Figure 16.10: Salida del módulo de la caja de herramientas GRASS
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Figure 16.11: Módulo Manual de la caja de herramientas

principal, al Índice temático y al Índice completo. Estos enlaces proporcionar información de
ejemplo como el modulo g.manual.

Truco: Mostrar resultados inmediatamente
Si desea mostrar sus resultados de cálculo inmediatamente en su lienzo de mapa, se puede utilizar el botón ‘Ver
Salida’ en la parte inferior de la pestaña de módulo.

16.9.2 Ejemplos del módulo GRASS

Los siguientes ejemplos demostrarán el poder de algunos módulos GRASS.

Crear curvas de nivel

El primer ejemplo crea un mapa de curvas de nivel vectoriales de un ráster de elevación (DEM). Aquí, se asume
que se tiene LOCALIZACIÓN Alaska configurado como se explica en la sección Importar datos dentro de una
LOCALIZACIÓN DE GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• En la lista de categorías de herramientas, haga doble clic Ráster → Administración de superficie→ Generar
curvas de nivel vectoriales.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Trabajando con
módulos GRASS). The gtopo30 raster should appear as the Name of input raster.
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• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Escriba en Nombre de salida del mapa vectorial el nombre ctour_100.

• Haga clic en [Ejecutar] para iniciar el proceso. Espere varios momentos hasta que el mensaje
Finalizado con éxito aparezca en la ventana de salida. A continuación haga clic en [Ver Salida] y
[Cerrar].

Dado que esta es una región grande, tomará un tiempo para mostrarla. Después de que termine la presentación,
puede abrir la ventana de propiedades de la capa para cambiar el color de línea así el contorno aparece claramente
sobre el ráster de elevación, como en El Dialogo de las Propiedades del Vector.

El siguiente acercamiento a una pequeña y montañosa área en el centro de Alaska. Al acercarse, se puede observar
que las curvas de nivel tienen esquinas afiladas. GRASS ofrece la herramienta v.generalize para alterar ligera-
mente mapas vectoriales, manteniendo su forma general. La herramienta utiliza varios algoritmos diferentes con
propósitos diferentes. Algunos de los algoritmos (es decir, Douglas Peucker y Vertex Reduction) simplificar la
línea mediante la eliminación de algunos de los vértices. El vector resultante se carga más rápido. Este proceso es
útil cuando se tiene un vector muy detallado, pero va a crear un mapa de escala muy pequeña, por lo que el detalle
es innecesario.

Truco: La herramienta de simplificar
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

Sin embargo, el proposito de este ejemplo es diferente. Las líneas de curvas de nivel creadas por r.contour
tiene ángulos agudos que deben ser suavizados. Entre el algoritmo v.generalize hay Chaiken’s, lo que hace
precisamente eso (también astillas de Hermite). Tenga en cuenta que estos algoritmos se pueden añadir vértices
adicionales al vector, haciendo que se cargue más lentamente

• Abra la caja de herramientas GRASS y haga doble clic en las categorías Vectorial → Desarrollar mapa →
Generalización,

• Compruebe que el vector ‘ctour_100’ aparece como el Nombre del vector de entrada.

• De la lista de algoritmos, elija Chaiken’s. Deje todas las otras opciones en su predeterminado y de-
splasece hacia abajo a la última fila para ingresar en el campo Nombre del mapa vectorial de salida
‘ctour_100_smooth’, y haga clic en [Ejecutar].

• El proceso toma varios minutos. Una vez que aparece Finalizo con éxito en la ventana de salida,
haga clic [Ver Salida] y a continuación [Cerrar].

• Se puede cambiar el color del vector para que se muestre claramente sobre el fondo del ráster y para con-
trastar con las curvas de nivel originales. Se dará cuenta de que las nuevas curvas de nivel tienen esquinas
más suaves que el original durante su estancia fiel a la original de forma general.

Truco: Otros usos de r.contour
El proceso descrito anteriormente se puede utilizar en otras situaciones equivalentes. Si tiene un mapa ráster de
datos de precipitación, por ejemplo, entonces el mismo método se utilizará para crear un mapa vectorial de líneas
isoyetas (lluvia constante).

Crear un efecto sombreado de relieve 3-D

Varios métodos se utilizan para mostrar capas de elevación y da un efecto #-D a mapas. El uso de líneas de
curvas de nivel, como se mostro anteriormente, es un método popular regularmente elejido para producir mapas
topológicos. El efecto de sombreado se crea de un ráster (elevación) DEM calculando primero la pendiente y el
aspecto de cada celda, entonces simula la posición del sol en el cielo y da un valor de reflectancia a cada celda. De
este modo se obtienen pendientes frente al sol iluminadas; las pendientes orientadas lejos del sol(en la sombra) se
oscurecen.

16.9. La caja de herramientas GRASS 189



QGIS User Guide, Publicación 2.8

Figure 16.12: Módulo GRASS v.generalize para suavizar un mapa vectorial

• Comience este ejemplo cargando el ráster de elevación gtopo30. Inicie la caja de herramientas GRASS y
bajo la categoría ráster, haga doble clic para abrir Análisis espacial → Análisis del terreno.

• A continuación haga clic en r.shaded.relief para abrir el módulo.

• Change the azimuth angle 270 to 315.

• Ingrese gtopo30_shade para el nuevo ráster de mapa de sombras y haga clic en [Ejecutar].

• Cuando el proceso finalice, añada el ráster de mapa de sombras al mapa. Debe verlo desplegado en escala
de grises.

• Para ver ambos sombreados y los colores de la gtopo30‘ juntos, mueva el mapa de sombreado abajo del mapa
gtopo30 en la tabla de contenido, a continuación abra la ventana Propiedades de gtopo30, cambie a la
pestaña de Transparencia y establezca su nivel de transparencia a cerca de 25%.

Ahora debe tener la elevación gtopo30 con su mapa de color y ajuste de transparencia mostrado arriba el mapa
de sombras en escala de grises. Con el fin de ver los efectos visuales en el mapa de sombras, apague el mapa
gtopo30_shade, a continuación, vuelva a encenderla.

Utilizar la consola de GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

El modulo r.shaded.relief puede tomar un parámetro zmult, que multiplica los valores de elevación relativas a
las unidades de las coordenadas X-Y por lo que el efecto de sombreado es incluso más pronunciado.

• Cargue el ráster de elevación gtopo30 como antes, a continuación inicie la caja de herramientas GRASS
y haga clic en la consola GRASS. En la ventana de la consola, escriba el comando r.shaded.relief
map=gtopo30 shade=gtopo30_shade2 azimuth=315 zmult=3 y presione [Enter].

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.
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Figure 16.13: La consola de GRASS, módulo r.shaded.relief

• Como se explicó anteriormente, mueva ráster del relieve sombreado a bajo del ráster gtopo30 en la tabla
de contenido, entonces valide la transparecia de la capa coloreada gtopo30. Debe ver que el efecto 3-D
destaca más fuertemente comparada con el primer mapa de relieve sombreado.

Estadísticas de ráster en un mapa vectorial

El siguiente ejemplo muestra como un módulo GRASS puede agregar datos ráster y añadir columnas de una
estadística para cada polígono en un mapa vectorial.

• De nuevo utilice los datos de Alaska, referirse a Importar datos dentro de una LOCALIZACIÓN DE GRASS
para importar los arboles de archivos shape del directorio shapefiles en GRASS.

• Ahora un paso intermedio es necesario: los centroides se deben añadir al mapa de árboles importado para
que sea una zona de GRASS completa del vector (incluyendo ambos límites y centroides).

• De la caja de herramientas, elija Vectorial → Desarrollar mapa -> Administrar objetos espaciales, y abra
el modulo v.centroids.

• Introduzca como el Mapa vectorial de salida ‘forest_areas’ y ejecute el módulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Estilo de Menu of the vector section.)

• A continuación vuelva a abrir la caja de herramientas de GRASS y abra Vectorial → Actualizacion vectorial
por otros mapas.

• Haga clic en el modulo v.rast.stats. Ingrese gtopo30 y forest_areas.

• Sólo un parámetro más es necesario: Ingrese Prefijo de columna elev, y haga clic en [Ejecutar]. Este es
una operación pesada computacionalmente, que se ejecutará por un largo tiempo (probablemente más de
dos horas).
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Figure 16.14: Mostrar relieve sombreado creado con el módulo de GRASS r.shaded.relief

• Finalmente, abra la tabla de atributos forest_areas, y verifique que varias de las nuevas columnas se
han añadido, incluyendo elev_min, elev_max, elev_mean, etc., para cada polígono de bosque.

16.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7,
you can see the current working LOCATION with its MAPSETs.

In the left browser windows, you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta-information for selected raster or vector layers (e.g., resolution, bounding box,
data source, connected attribute table for vector data, and a command history).

The toolbar inside the Browser tab offers the following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map

• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.
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Figure 16.15: GRASS LOCATION browser

16.9.4 Personalizar la caja de herramientas GRASS

Casi todos los módulos de GRASS se pueden añadir a la caja de herramientas de GRASS. Una interfaz XML se
proporciona para analizar los archivos XML muy sencillos que configuran la apariencia y los parámetros de los
módulos dentro de la caja de herramientas.

Un ejemplo del archivo XML para generar el módulo v.buffer (v.buffer.qgm) luce como esto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

.
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CHAPTER 17

QGIS processing framework

.

17.1 Introducción

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

En las siguientes secciones, revisaremos cómo usar los elementos gráficos de este sistema y sacar el máximo
provecho de cada uno de ellos.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox, as we will see) can be accessed from the Processing menu item. (You will see more than four
entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter.)

• La caja de herramientas. El elemento principal de la IUG, se usa para ejecutar un solo algoritmo o grupo de
procesos sobre la base de ese algoritmo.

Figure 17.1: Processing Toolbox
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• El modelador gráfico. Varios algoritmos se pueden combinar graficamente usando el modelador para definir
un flujo de trabajo, creando un proceso individual que involucre varios subprocesos.

Figure 17.2: Processing Modeler

• El administrador del historial. Todas las acciones que se llevan acabo mediante cualquiera de los elementos
mencionados se almacenan en un archivo de la historia y puede ser posteriormente producido usando el
administrador del historial.

• La interfaz de procesamiento por lote. Esta interfaz permite que ejecute procesos por lote y automatizar la
ejecución de un solo algoritmo a múltiples conjuntos de datos.

En las siguientes secciones, revisaremos cada uno de los elementos a detalle.

.

17.2 La caja de herramientas

La Caja de herramientas es el principal elemento de procesamiento de la interfaz gráfica de usuario, y el que más
se suele usar en el trabajo diario. Muestra un listado de todos los algoritmos disponibles agrupados en diferentes
bloques, y es el punto de acceso para ejecutarlos, bien haciéndolo como un proceso único o bien como un proceso
por lotes que realice varias ejecuciones del mismo algoritmo con diferentes conjuntos de entradas.

The toolbox contains all the available algorithms, divided into predefined groups. All these groups are found under
a single tree entry named Geoalgorithms.

Additionally, two more entries are found, namely Models and Scripts. These include user-created algorithms, and
they allow you to define your own workflows and processing tasks. We will devote a full section to them a bit
later.

En la parte superior de la caja de herramientas, hay una caja de texto. Para reducir el número de algoritmos que
se muestran en la caja de herramientas y que resulte más fácil encontrar el que se necesita, se puede introducir
cualquier palabra o frase en esa caja de texto. Según se va escribiendo, el número de algorimos que se muestra se
va reduciendo a sólo aquellos que contienen el texto introducido en su nombre.
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Figure 17.3: Processing History

Figure 17.4: Batch Processing interface
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Figure 17.5: Processing Toolbox

In the lower part, you will find a box that allows you to switch between the simplified algorithm list (the one
explained above) and the advanced list. If you change to the advanced mode, the toolbox will look like this:

In the advanced view, each group represents a so-called ‘algorithm provider’, which is a set of algorithms coming
from the same source, for instance, from a third-party application with geoprocessing capabilities. Some of
these groups represent algorithms from third-party applications like SAGA, GRASS or R, while others contain
algorithms directly coded as part of the processing plugin, not relying on any additional software.

This view is recommended to those users who have a certain knowledge of the applications that are backing the
algorithms, since they will be shown with their original names and groups.

Also, some additional algorithms are available only in the advanced view, such as LiDAR tools and scripts based
on the R statistical computing software, among others. Independent QGIS plugins that add new algorithms to the
toolbox will only be shown in the advanced view.

In particular, the simplified view contains algorithms from the following providers:

• GRASS

• SAGA

• OTB

• Native QGIS algorithms

In the case of running QGIS under Windows, these algorithms are fully-functional in a fresh installation of QGIS,
and they can be run without requiring any additional installation. Also, running them requires no prior knowledge
of the external applications they use, making them more accesible for first-time users.

If you want to use an algorithm not provided by any of the above providers, switch to the advanced mode by
selecting the corresponding option at the bottom of the toolbox.

Para ejecutar un algoritmo, basta con hacer doble click sobre su nombre en la caja de herramientas.

17.2.1 El cuadro de diálogo de algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).
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Figure 17.6: Processing Toolbox (advanced mode)

Figure 17.7: Parameters Dialog
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This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It of course has a different content, depending on the require-
ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side, the value of the parameter can be set.

Aunque el número y el tipo de parámetro dependen de las características del algoritmo, la estructura es similar
para todos ellos. Los parámetros encontrados en la tabla pueden ser de uno de los siguientes tipos.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

Se ve un botón por cada selector de capa vectorial, como se muestra en la figura inferior.

Figure 17.8: Vector iterator button

Si el algoritmo contiene varios de ellos, será capaz de cambiar cada uno de ellos. Si el botón correspondiente a
una entrada vectorial se cambia, el algoritmo será ejecutado iterativamente en cada uno de sus elementos, en lugar
de sólo una vez para toda la capa, produciendo mayor cantidad de salidas como veces que se ejecuta el algoritmo.
Esto permite la automatización del proceso cuando todas las características de una capa tienen que ser procesados
por separado.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Una opción, a elegir de una lista de selección de posibles opciones.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

• Un rango, con valores mínimo y máximo que se introducen en dos cuadros de texto.

• Una cadena de texto, que se introduce en un cuadro de texto.

• Un campo, a elegir desde la tabla de atributos de una capa vectorial o una tabla sencilla seleccionada en otro
parámetro.

• Un sistema de referencia de coordenadas. Que puede escribir el código EPSG directamente en la caja de
texto, o seleccionarlo desde el diálogo SRC que aparece cuando al hacer clic sobre el botón del lado derecho

• Una extensión que deberá inscribirse por cuatro números que representan sus límites xmin, xmax, ymin,
ymax. Al hacer clic en el botón en la parte derecha del selector de valor, aparecerá un menú emergente, que
le dará dos opciones: para seleccionar el valor de una capa o la extensión de la lienzo actual, o para definirlo
arrastrando directamente sobre el lienzo del mapa.

Si se selecciona la primera opción, se verá una ventana como la siguiente.

Si se selecciona la segunda opción, la ventana de parámetros se ocultará, para que se pueda definir el rectán-
gulo haciendo click y arrastrando dentro del lienzo. Una vez hecho esto, el cuadro de diálogo reaparecerá,
con los valores correspondientes ya rellenos en en cuadro de texto.
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Figure 17.9: Number Selector

Figure 17.10: Extent selector

Figure 17.11: Extent List

Figure 17.12: Extent Drag
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• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

Figure 17.13: Multiple Selection

• Una pequeña tabla para que la edite el usuario. Éstas se usan para definir parámetros como tablas de
búsqueda o matrices de convolución entre otros.

Click en el botón del lado derecho para ver la tabla y editar sus valores.

Figure 17.14: Fixed Table

Dependiendo del algoritmo, el número de filas que pueden ser modificadas o no al utilizar los botones del
lado derecho de la ventana.

You will find a [Help] tab in the the parameters dialog. If a help file is available, it will be shown, giving you
more information about the algorithm and detailed descriptions of what each parameter does. Unfortunately, most
algorithms lack good documentation, but if you feel like contributing to the project, this would be a good place to
start.
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Un comentario sobre proyecciones

Algorithms run from the processing framework — this is also true of most of the external applications whose
algorithms are exposed through it. Do not perform any reprojection on input layers and assume that all of them
are already in a common coordinate system and ready to be analized. Whenever you use more than one layer as
input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same coordinate
system.

Note that, due to QGIS‘s on-the-fly reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common
coordinate system. That reprojection should be done manually, and then the resulting files should be used as input
to the algorithm. Also, note that the reprojection process can be performed with the algorithms that are available
in the processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the processing configuration dialog, unchecking the Show CRS
option.

Si intenta ejecutar un algoritmo utilizando como entrada dos o más capas con SRC diferentes, se mostrará un
diálogo de advertencia.

Aún se puede ejecutar el algoritmo, pero en la mayoría de los casos se producirán resultados incorrectos, como
capas vacias debido a que las capas de entrada no se solapan.

17.2.2 Resultados generados por algoritmos

Los tipos de resultados que se pueden generar cor un algoritmo son los siguientes:

• Una capa ráster.

• Una capa vectorial.

• Una tabla

• Un archivo HTML (usado para salidas de texto y salidas gráficas).

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but the architecture
allows for any other way of storing it. For instance, a vector layer can be stored in a database or even uploaded
to a remote server using a WFS-T service. Although solutions like these are not yet implemented, the processing
framework is prepared to handle them, and we expect to add new kinds of output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save file
dialog, where you can select the desired file path. Supported file extensions are shown in the file format selector
of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension (usually .dbf‘ for tables, .tif for raster layers and .shp for vector layers) will
be appended to the file path, and the file format corresponding to that extension will be used to save the layer or
table.

If you do not enter any filename, the result will be saved as a temporary file in the corresponding default file
format, and it will be deleted once you exit QGIS (take care with that, in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
Processing menu), and in the General group, you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when executing an
algorithm.
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Al ejecutar un algoritmo que utiliza una capa vectorial en modo iterativo, la ruta del archivo introducido se utiliza
como la ruta de la base para todos los archivos generados, los cuales se denominan utilizando el nombre base y
añadiendo un número que representa el índice de la iteración. La extensión del archivo (y el formato) se utiliza
para todos los archivos generados.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Para todos los otros tipos de salida, encontrará una casilla de verificación que se puede utilizar para decirle al
algoritmo si se debe cargar el archivo una vez que se genera por el algoritmo o no. Por defecto, se abren todos los
archivos.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

17.2.3 Configurar el entorno de trabajo de procesamiento

Como se ha mencionado, el menú de configuración permite el acceso a un nuevo diálogo donde se puede configurar
cómo funcionan los algoritmos. Los parámetros de configuración están estructurados en bloques separados que se
pueden seleccionar en la parte izquierda del cuadro de diálogo.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Los estilos de renderizado se pueden configurar individualmente para cada algoritmo y cada una de sus salidad.
Basta con hacer clic derecho en el nombre del algoritmo en la caja de herramientas y seleccionar Editar estilos de
renderizados para salidas. Aparecerá un cuadro de diálogo como el mostrado a continuación.

Figure 17.15: Rendering Styles
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Seleccionar el archivo de estilo (.qml) que se desee para cada salida y presionar [Aceptar].

Otras parámetros de configuración se en listan en el grupo General a continuación:

• Utilizar nombre de archivo como nombre de capa. El nombre de cada capa resultante creado por un al-
goritmo se define por el propio algoritmo. En algunos casos, un nombre fijo podría ser utilizado, lo que
significa que el mismo nombre de salida será utilizada, no importa que capa de entrada se utiliza. En otros
casos, el nombre podría depender del nombre de la capa de entrada o algunos de los parámetros utilizados
para ejecutar el algoritmo. Si esta casilla de verificación está marcada, el nombre se toma del nombre de
archivo de salida en su lugar. Tenga en cuenta que, si la salida se guarda en un archivo temporal, el nombre
de archivo de este suele ser largo y sin sentido, destinada a evitar la colisión con otros nombres de archivos
ya existentes.

• Utilice sólo objetos espaciales seleccionados. Si se selecciona esta opción, cada vez que se utiliza una capa
vectorial como entrada para un algoritmo, sólo se utilizan sus objetos espaciales seleccionados. Si la capa
no tiene elementos seleccionadas, se utilizarán todos los objetos.

• :Archivo script pre-ejecución y Archivo script post-ejecución. Estos parámetros se refieren a scripts escritos
utilizando la funcionalidad de secuencias de comandos de procesamiento, y se explican en la sección de
secuencias de comandos de cobertura y la consola.

Aparte del bloque General en el diálogo de configuración, también encontrará un bloque para los proveedores de
algoritmo. Cada entrada en este bloque contiene un elemento :guilabel: Activar que se puede utilizar para hacer
que algoritmos aparezcan o no en la caja de herramientas. Además, algunos proveedores de algoritmos tienen
sus propios elementos de configuración, que explicaremos más adelante en la cobertura de los proveedores de
algoritmos particulares.

.

17.3 Modelador gráfico

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead.
Using the graphical modeler, that chain of processes can be wrapped into a single process, so it is as easy and
convenient to execute as a single process later on a different set of inputs. No matter how many steps and different
algorithms it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger
models.

El modelador puede ser abierto desde el menu de procesamiento

El modelador tiene un cambas funcional donde la estructura del modelo y el flujo de trabajo que representa se
puede ver. En la parte izquierda de la ventana, un panel con dos pestañas se pueden utilizar para agregar nuevos
elementos al modelo.

Crear un modelo requiere dos pasos:

1. “Definición de entradas no necesarias”. Estas entradas se agregaran a la ventana de parámetros, asi el
usuario puede poner sus valores cuando se ejecutan los modelos. El modelo en si es un algoritmo, asi la
ventana de parámetros de genera automáticamente como pasa con todos los algoritmos disponibles en el
marco de referencia del procesador.

2. “Definición de un flujo de trabajo”. Usando los datos entrantes de un modelo, el flujo de trabajo se define
por algoritmos adicionales y seleccionando como se utilizan las entradas o salidas generados por otros
almoritmos que ya estan en el modelo.

17.3.1 Definir entradas

El primer paso de crear un modelo es definir las entradas que se necesitan. Los siguientes elemenos se encuentran
en la pestaña en el lado izquierdo de la ventana de modelos.

• Capa Raster
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Figure 17.16: Modeler

• Capa Vector

• Cadena

• Campo de la tabla

• Tabla

• Extensión

• NUmero

• Boolean

• Archivo

Haga doble clic en cualquiera de estos elementos, un diálogo se muestra para definir sus características. Depende
de los parámetros en si. EL diálogo podría contener sólo un elemento básico (la descripción, que es la que el
usuario verá al ejecutar el modelo) o más de ellos. Por ejemplo, al añadir un valor numérico, como se puede ver
en la siguiente figura, parte de la descripción del parámetro, tiene que establecer un valor y un rango de valores
validos.

Para cada entrada adicional, un nuevo elemento se agrega al canvas modelador.

También puede añadir entradas al arrastrar el tipo de entrada de la lista y soltarlo en la vista del modelador, en la
posición donde dese ubicarla.

17.3.2 Definicion del flujo de trabajo.

Una vez que se ha definido las entradas, es tiempo para definir los algoritmos que se les aplica. Los algoritmos
se peuden encontrar en la pestaña Algorithms , agupados de una manera parecida a como estan en la caja de
herramientas.
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Figure 17.17: Model Parameters

Figure 17.18: Model Parameters

Figure 17.19: Model Parameters
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The appearance of the toolbox has two modes here as well: simplified and advanced. However, there is no element
to switch between views in the modeler, so you have to do it in the toolbox. The mode that is selected in the toolbox
is the one that will be used for the list of algorithms in the modeler.

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm, the same example we saw in the section dedicated to the toolbox.

Figure 17.20: Model Parameters

Como se puede ver, existen algunas diferencias. En lugar de la caja de salida de archivo que se utiliza para
establecer la ruta del archivo para capas y tablas de salida, una caja de texto simple se utiliza aquí. Si la capa
generada por el algoritmo es sólo un resultado temporal que será utilizado como la entrada de otro algoritmo y
no debe ser mantenida como resultado final, simplemente no modificar ese cuadro de texto. No escribir nada en
él significa que el resultado es definitivo y el texto que se proporciona es la descripción de la salida, que será la
salida que el usuario verá cuando se ejecute el modelo.

Seleccionar el valor de cada parámetro también es un poco diferente, ya que hay diferencias importantes entre
contexto del modelador y de la caja de herramientas. Vamos a ver cómo introducir los valores para cada tipo de
parámetro

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Los valores numéricos. Los valores literales se pueden introducir directamente en la caja de texto. Pero
esta caja de texto también es una lista que se puede utilizar para seleccionar cualquiera de las entradas de
valor numérico del modelo. En este caso, el parámetro tomará el valor introducido por el usuario cuando se
ejecuta el modelo.

• Cadena. Como en el caso de valores numéricos, cadenas literales se pueden escribir, o una cadena de entrada
se puede seleccionar.

• Campo de tabla. Los campos de la tabla padre o capa no se pueden conocer en tiempo de diseño, ya
que dependen de la selección del usuario cada vez que el modelo es ejecutado. Para establecer el valor
de este parámetro, escriba el nombre de un campo directamente en la caja de texto, o utilice la lista para
seleccionar una entrada de campo de la tabla ya agregado al modelo. La validez del campo seleccionado
será comprobada en tiempo de ejecución.
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En todos los casos, se encontrará un parámetro adicional llamado Algoritmos padres que no esta disponible cuando
llama al algoritmo de la caja de herramientas. Este parámetro permite definir el orden en que se ejecuten los
algoritmos definiendo explícitamente un algoritmo como padre de la actual, lo que obligará al padre a ser ejecutado
antes del actual.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes an SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Una vez que a todos los parámetros se les han asignados valores validos, haga clic en [Aceptar] y el algoritmo
se añadirá a la vista. Será enlazado a todos los otros elementos en la vista, si los algoritmos o entradas, eso
proporciona objetos que se utilizan como entrada de ese algoritmo.

Los elementos se pueden arrastrar a una diferente posición dentro de la vista, para cambiar la forma de la estructura
del modulo se muestra y hace más claro e intuitivo. Enlaces entre los elementos se actualizan automáticamente.
Se puede acercar y alejar utilizando la rueda del ratón.

You can run your algorithm anytime by clicking on the [Run] button. However, in order to use the algorithm from
the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.3 Guardar y cargar modelos.

Utilice el botón actual [Guardar] para guardar el modelo actual y el botón [Abrir] para abrir cualquier modelo
previamente guardado. Los modelos se guardan con la extensión .model. Si el modelo ha sido previamente
guardado desde la ventana del modelador, no se le pedirá un nombre de archivo. Dado que ya existe un archivo
asociado con ese modelo, el mismo archivo se utilizará para guardar cualquier subsiguiente.

Antes de guardar un modelo, tienes que entrar el nombre y el grupo, utilizando las cajas de texto en la parte
superior de la ventana.

Los modelos guardados en la carpeta modelos (la carpeta predeterminada cuando se le pide un nombre de
archivo para guardar el modelo) aparecerá en la caja de herramientas en la rama correspondiente. Cuando se
invoca la caja de herramientas, que busca en la carpeta modelos de archivos con la extensión .model y carga
los modelos que contienen. Puesto que un modelo es en sí mismo un algoritmo, este se puede añadir a la caja de
herramientas al igual que cualquier otro algoritmo.

The models folder can be set from the processing configuration dialog, under the Modeler group.

Se puede cargar modelos desde la carpeta models que no solo aparece en la caja de herramientas sino tambien
en el arbol de argoritmos en la pestaña Algorithms de la ventana modeladora.

In some cases, a model might not be loaded because not all the algorithms included in its workflow are available.
If you have used a given algorithm as part of your model, it should be available (that is, it should appear in the
toolbox) in order to load that model. Deactivating an algorithm provider in the processing configuration window
renders all the algorithms in that provider unusable by the modeler, which might cause problems when loading
models. Keep that in mind when you have trouble loading or executing models.

17.3.4 Editar un modelo.

Puedes editar un modelo que actualmente estar creando, redefiniendo el flujo de trabajo y la relacion entre los
algoritmos y las entradas que definen el modelo en si.

Si haces click derecho en un algoritmo en el cambas representado en el modelo, puedes ver el menu de contexto
parecido a lo siguiente:

Seleccionando la opción Remove va a causar que el algoritmo seleccionado se elimine. Un algoritmo se puede
eliminar solo si no hay otros algoritmas dependiendo de este. Eso es, si ninguna salida del algoritmo se utiliza en
uno diferente de salida. Si intentar elimiar el algoritmo donde hay dependencia, un mensaje de advertencia como
el que se ve abajo va a salir.
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Figure 17.21: Modeler Right Click

Figure 17.22: Cannot Delete Algorithm

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Seleccionar valores nuevos y luego hacer click en el boton de [OK] como es usual. Las conecciones entre ele-
mentos de modelos cambian de acuerdo con el ambas de modelar.

17.3.5 Editando archivos de ayuda y meta informacion de modelos

Puedes documentar tus modelos del modelador en si. Solo hacer click en el boton de **[Edit model help]* y un
dialogo paresido al siguiente va a aparecer.

Figure 17.23: Help Edition

En el lado derecho, verá una página HTML simple, creado mediante la descripción de los parámetros de entrada
y salidas del algoritmo, junto con algunos elementos adicionales como una descripción general del modelo o su
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autor. La primera vez que se abre el editor de ayuda, todas estas descripciones están vacíos, pero se pueden editar
utilizando los elementos en la parte izquierda del cuadro de diálogo. Seleccione un elemento en la parte superior
y luego escriba su descripción en el cuadro de texto de abajo.

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.

17.3.6 Acerca de algoritmos disponibles

Puede notar que algunos algoritmos que pueden ser ejecutados desde la caja de herramientas no aparecen en la
lista de algoritmos disponibles cuando se está diseñando un modelo. Para ser incluidos en un modelo, un algoritmo
debe tener una semántica correcta, de modo que sea adecuadamente enlazado a los otros en el flujo de trabajo. Si
un algoritmo no tiene tal bien definida la semántica (por ejemplo, si el número de capas de salida no puede ser
conocido de antemano), entonces no es posible utilizarlo dentro de un modelo, y por lo tanto, no aparece en el
lista de algoritmos que se puede encontrar en el diálogo modelador.

Además, se verán algunos algoritmos en el modelador que no se encuentran en la caja de herramientas. Estos
algoritmos están destinados a ser utilizados exclusivamente como parte de un modelo, y que no son de interés
en un contexto diferente. El algoritmo de ‘Calculadora’ es un ejemplo de ello. Es simplemente una calculadora
aritmética simple que se puede utilizar para modificar valores numéricos (introducidos por el usuario o generados
por algún otro algoritmo). Esta herramienta es muy útil dentro de un modelo, pero fuera de ese contexto, no tiene
demasiado sentido.

.

17.4 La interfaz de procesamiento por lotes

17.4.1 Introducción

Todos los algoritmos (incluyendo modelos) se pueden ejecutar como un proceso por lotes. Es decir, que se pueden
ejecutar utilizando no sólo un único conjunto de insumos, sino varios de ellos y ejecutar el algoritmo tantas veces
sea necesario. Esto es útil al procesar grandes cantidades de datos, ya que no es necesario poner en marcha el
algoritmo muchas veces desde la caja de herramientas.

Para ejecutar un algoritmo como un proceso por lotes, haga clic en su nombre en la caja de herramientas y
seleccionar la opción Ejecutar como proceso por lotes en el menú emergente que aparecerá.

Figure 17.24: Batch Processing Right Click

17.4.2 La tabla de parámetros

La ejecución de un proceso por lotes es similar a la realización de una sola ejecución de un algoritmo. Los valores
de los parámetros tienen que ser definidos, pero en este caso no sólo necesitan un valor único para cada parámetro,
sino un conjunto de ellos en su lugar, una por cada vez que el algoritmo tiene que ser ejecutado. Los valores se
introducen mediante una tabla como la que se muestra a continuación.

Cada línea de esta tabla representa una sola ejecución del algoritmo, y cada celda contiene el valor de uno de
los parámetros. Es similar al diálogo de los parámetros que se ve cuando se ejecuta un algoritmo de la caja de
herramientas, pero con una disposición diferente.

Por defecto, la tabla contiene sólo dos filas. Puede agregar o quitar filas utilizando los botones de la parte inferior
de la ventana.
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Figure 17.25: Batch Processing

Una vez que el tamaño de la tabla se ha establecido, este tiene que ser llenado con los valores deseados.

17.4.3 Llenado de la tabla de parámetros

Para la mayoría de los parámetros, establecen el valor es trivial. Sólo tienes que escribir el valor o seleccionarlo
de la lista de opciones disponibles, dependiendo del tipo de parámetro.

The main differences are found for parameters representing layers or tables, and for output file paths. Regarding
input layers and tables, when an algorithm is executed as part of a batch process, those input data objects are taken
directly from files, and not from the set of them already opened in QGIS. For this reason, any algorithm can be
executed as a batch process, even if no data objects at all are opened and the algorithm cannot be run from the
toolbox.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If
the input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If the parameter represents a multiple input, all the selected files will be
added to a single cell, separated by semicolons (;).

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving to
a temporary file is not permitted. You can type the name directly or use the file chooser dialog that appears when
clicking on the accompanying button.

Una ves que seleccione el archivo, un nuevo diálogo se mostrará para permitir la terminación automática de otras
celdas en la misma columna (mismo parámetro).

Si se selecciona el valor por defecto (‘No autocompletar’), se acaba de poner el nombre del archivo seleccionado
en la celda seleccionada de la tabla de parámetros. Si se selecciona cualquiera de las otras opciones, todas las
celdas debajo de la seleccionada será automáticamente llenado basado en un criterio definido. De esta manera, es
mucho más fácil llenar la tabla, y el proceso por lotes se puede definir con menos esfuerzo.

El llenado automático puede hacerse por simple adición de los números correlativos a la ruta del archivo selec-
cionado, o al añadir el valor de otro campo en la misma fila. Esto es particularmente útil para nombrar a los objetos
de datos de salida de acuerdo con los de entrada.
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Figure 17.26: Guardar Procesamiento por lotes

Figure 17.27: Batch Processing File Path

17.4.4 Ejecutar el proceso por lotes

Para ejecutar el proceso por lotes una vez que haya introducido todos los valores necesarios, simplemente haga
clic en [Aceptar]. El progreso de la tarea por lotes global se mostrará en la barra de progreso en la parte inferior
del diálogo

.

17.5 Utilizar algoritmos de procesamiento desde la consola

La consola permite a los usuarios avanzados incrementar su productividad y realizar operaciones complejas que
no se pueden realizar utilizando cualquiera de los otros elementos de la GUI del marco de procesamiento. Mod-
elos que involucran varios algoritmos se pueden definir mediante la interfaz de línea de comandos y operaciones
adicionales tales como bucles y sentencias condicionales que se pueden añadir para crear flujos de trabajo más
flexibles y potentes.

There is not a proccesing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

El código se puede ejecutar desde la consola de Python, incluso si no especifica ningún método de procesamiento,
se puede convertir en un nuevo algoritmo que más tarde puede llamar desde la caja de herramientas, el mode-
lador gráfico o algún otro componente, tal como lo hace con cualquier otro algoritmo. De hecho, algunos de los
algoritmos que se pueden encontrar en la caja de herramientas son sencillas secuencias de comandos.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

17.5.1 Invocando algoritmos desde la consola de Python

Lo primero que tiene que hacer es importar las funciones de procesamiento con la siguiente línea:

>>> import processing

Ahora, hay básicamente solo una cosa (interesante) que puede hacer con eso desde la consola: ejecutar un
algoritmo. Eso se hace utilizando el método runalg()‘, que toma el nombre del algoritmo a
ejecutar como su primer parámetro, y luego un número variable de parámetros
adicionales dependiendo de los requisitos del algoritmo. Así lo primero
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que necesita saber es el nombre del algoritmo a ejecutar. Ese no es el
nombre que se ve en la caja de herramientas, si no más bien un nombre de
linea de comando única. Para encontrar el nombre correcto de su algoritmo,
se puede utilizar el método ‘‘algslist(). Escribir la siguiente línea en su consola:

>>> processing.alglist()

Veras algo como esto:

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Esa es una lista de todos los algoritmos disponibles, ordenada alfabéticamente, junto con sus nombres de linea de
comandos correspondientes.

Puede utilizar una cadena como parámetro para este método. En lugar de devolver la lista completa de algoritmos,
que sólo mostrará aquellos que incluyen esa cadena. Si, por ejemplo, se busca un algoritmo para calcular la
pendiente de un DEM, el tipo‘‘alglist(“slope”)‘‘ obtendrá el siguiente resultado:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

El resultado podría cambiar dependiendo de los algoritmos que se tienen disponibles.

Ahora es más fácil encontrar el algoritmo que se busca y el nombre de línea de comando, en este caso
saga:slopeaspectcurvature.

Una vez que se conoce el nombre de línea de comandos del algoritmo, el siguiente paso es determinar la sintaxis
correcta para ejecutarlo. Eso significa saber que parámetros se necesitan y el orden en el que tienen para pasarlos
cuando se llame al método runalg(). Hay un método para describir un algoritmo a detalle, que se puede utilizar
para obtener una lista de los parámetros que requiere un algoritmo y las salidas que va a generar. Para obtener
esta información, se puede utilizar el método alghelp (name_of_the_algorithm). Utilice el nombre de
línea de comandos del algoritmo, no el nombre descriptivo completo.

Llamar al método con saga:slopeaspectcurvature como parámetro, se obtiene la siguiente descripción:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
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HCURV <OutputRaster>
VCURV <OutputRaster>

Ahora se tiene todo lo necesario para ejecutar cualquier algoritmo. Como ya hemos mencionado, sólo hay un solo
comando para ejecutar algoritmos: runalg(). Su sintaxis es la siguiente:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

La lista de parámetros y salidas para añadir dependen del algoritmo que se desean ejecutar, y es exactamente la
lista que el método alghelp() le da, en el mismo orden que se muestra.

Dependiendo del tipo de parámetro, los valores se introducen de manera diferente. La siguiente lista da una rápida
revisión de cómo introducir los valores para cada tipo de parámetro de entrada.

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selección. Si un algoritmo tiene un parámetro de selección, el valor de ese parámetro debe ser intro-
ducido mediante un valor entero. Para conocer las opciones disponibles, se puede utilizar el comando
algoptions(), como se muestra en el siguiente ejemplo

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

En este caso, el algoritmo tiene uno de tales parámetros, con siete opciones. Tenga en cuenta que ordenar
en base cero.

• La entrada múltiple. El valor es una cadena con descriptores de entrada separadas por punto y coma (;).
Como en el caso de capas individuales o tablas, cada descriptor de entrada se puede el nombre del objeto de
datos, o su ruta de archivo.

• El campo de la tabla de XXX. Utilice una cadena con el nombre del campo a usar. Este parámetro es
sensible a mayúsculas y minúsculas.

• Tabla fija. Escribir la lista de todas las tablas de valores separadas por comas (,) y cerrar entre comillas
("). Los valores que empiezan en la fila superior y van de izquierda a derecha. También se puede utilizar
un arreglo 2-D de valores que representen la tabla.

• SRC. Introduzca el número del código EPSG del SRC deseado.

• Extensión. Se debe utilizar una cadena con valores de xmin, xmax, ymin y ymax‘ separados por
comas (,‘‘).

Los parámetros boolean, archivo, cadena y numéricos no necesitan alguna explicación adicional.

Los parámetros de entrada tales como valores string, booleanos o numericos tienen valores predeterminados. Para
utilizarlos, especificar None en la entrada del parámetro correspondiente.

Para objetos de datos de salida, escriba la ruta del archivo que se utilizará para guardarlo, del mismo modo que se
hace desde la caja de herramientas. Si desea guardar el resultado a un archivo temporal, use None. La extensión
del archivo determina el formato de archivo. Si se ingresa la extensión no reconocida por el algoritmo, el formato
de archivo predeterminado par el tipo de salida se utilizará, y su extensión correspondiente anexa a la ruta del
archivo dado.
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Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

El método runalg regresa un diccionario con los nombres de salida (los que se muestran en la descripción del
algoritmo) como llaves y la ruta del archivo de esas salidas como valores. Se pueden cargar esas capas al pasar las
rutas de archivo correspondientes al método load().

17.5.2 Funciones adicionales para manipular datos

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Table of Contents.

• values(layer, fields): Regresa los valores en la tabla de atributos de una capa vectorial, para los
campos pasados. Los campos se pueden pasar como nombres de campos o como indices de archivos de base
cero. Devuelve un diccionario de listas, con el identificador del campo pasado como llaves. Se considera la
selección existente.

• features(layer): Devuelve un iterador sobre las características de una capa vectorial, considerando
la selección existente.

• uniqueValues(layer, field): Devuelve una lista de valores únicos para un atributo dado. Los
atributos se pueden pasar como un nombre de campo o indice de campo de base cero. Se considera la
selección existente.

17.5.3 Crear scripts y ejecurarlos desde le Caja de Herramientas

Puede crear sus propios algoritmos escribiendo código Python y añadiendo unas pocas líneas extras para sum-
inistrar información adicional necesaria para definir la semántica del algoritmo. Se puede encontrar en el menú
guilabel:Crear nuevo script bajo el grupo Herramientas en el bloque de algoritmos Script de la caja de herramien-
tas. Haga doble clic en él para abrir el diálogo de edición de script. Eso es donde debe escribir su código. Guarde
el script en la carpeta scripts (la carpeta predeterminada cuando abre el diálogo del archivo guardado) con la
extensión .py automáticamente crea el algoritmo correspondiente.

El nombre del algoritmo (el que podrá ver en la caja de herramientas) se crea a partir del nombre de archivo, la
eliminación su extensión y la sustitución de guiones bajos con espacios en blanco.

Vamos a echar un vistazo a el siguiente código, que calcula el Índice de Humedad topográfica (TWI) directamente
de un DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Como puede ver, el calculo implica tres algoritmos, todos ellos provenientes de SAGA. El último que calcula el
TWI, pero se necesita una capa de pendientes y una capa de acumulación de flujo. No tenemos estas capas, pero
ya tenemos el DEM, podemos calcularlas llamando a los algoritmos SAGA correspondientes.
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La parte del código donde este procesamiento se lleva a cabo no es difícil de entender si ha leído las secciones an-
teriores de este capítulo. Las primeras líneas, sin embargo, necesitan alguna explicación adicional. Proporcionan
la información que se necesita para convertir su código en un algoritmo que se puede ejecutar desde cualquiera de
los componentes GUI, como la caja de herramientas o el modelador gráfico.

Estas líneas comienzan con un doble símbolo de comentario en Python (##) y tiene la siguiente estructura:

[parameter_name]=[parameter_type] [optional_values]

Aquí esta una lista de todos los tipos de parámetros que se admiten en scripts de procesamiento, su sintaxis y
algunos ejemplos.

• ráster. Una capa ráster.

• vector. Una capa vectorial.

• table. Una tabla.

• número. Un valor numérico. Un valor por defecto debe ser proporcionado. Por ejemplo, depth=number
2.4.

• string. Una cadena de texto. Como en el caso de valores numéricos, por defecto se debe añadir un valor.
Por ejemplo, name=string Victor.

• boolean. Un valor boolean. Añade True o False después para establecer el valor predeterminado. Por
ejemplo, verbose=boolean True.

• ráster múltiple. Un conjunto de capas ráster de entrada.

• Vector múltiple. Un conjunto de capas vectoriales de entrada.

• Campo. Un campo es la tabla de atributos de una capa vectorial. El nombre de la capa se tiene que añadir de-
spués de la etiqueta Campo. Por ejemplo, si ha declarado una vectorial de entrada con mylayer=vector,
podría utilizar myfield=field mylayer para añadir un campo de esa capa como parámetro.

• folder. Una carpeta.

• file. A nombre de archivo.

El nombre del parámetro es el nombre que se mostrará al usuario cuando ejecuta el algoritmo, y también el nombre
de variable a utilizar en la secuencia de código. El valor introducido por el usuario para ese parámetro se asignará
a la variable con ese nombre.

Cuando muestra el nombre del parámetro al usuario, el nombre será editado para mejorar su apariencia, en susti-
tución de guiones bajos con espacios. Así, por ejemplo, si desea que el usuario vea un parámetro llamado Un
valor numérico, puede utilizar el nombre de la variable A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Las salidas están definidas en una manera similar, utilizando los siguientes etiquetas:

• ráster de salida

• vector de salida

• tabla de salida

• html de salida

• archivo de salida

• número de salida

• texto de salida

El valor asignado a las variables de salida es siempre una cadena con una ruta de archivo. Corresponderá a una
ruta de archivo temporal en caso de que el usuario no haya introducido ningún nombre de archivo de salida.
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When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

No utilice el método load() en sus algoritmos de script, sino sólo cuando se trabaja con la línea de la consola. Si
una capa es creada como salida de un algoritmo, debe ser declarada como tal. De lo contrario, usted no será capaz
de utilizar correctamente el algoritmo en el modelador, ya que su sintaxis (según la definición de las etiquetas
explicadas anteriormente) no coincidirá con lo que crea realmente el algoritmo.

Salidas ocultas (números y cadenas) no tienen un valor. En cambio, tiene que asignar un valor a los mismos. Para
ello, basta con establecer el valor de una variable con el nombre que utilizó para declarar la salida. Por ejemplo,
si ha utilizado esta declaración,

##average=output number

La siguiente linea establecerá el valor de salida a 5:

average = 5

Además de las etiquetas para los parámetros y resultados, también puede definir el grupo en las que se muestra el
algoritmo, utilizando la etiqueta grupo.

Si su algoritmo toma mucho tiempo para procesar, es una buen idea informar al usuario. Se tiene una global lla-
mada progreso disponible, con dos métodos posibles: setText(text) y setPercentage(percent)
para modificar el texto y la barra de progreso.

Varios ejemplos son proporcionados. Por favor, consulte con ellos para ver ejemplos reales de cómo crear algorit-
mos utilizando las clases del marco de procesamiento. Haga clic derecho en cualquier script y seleccione Editar
script para editar su código o sólo para verlo.

17.5.4 Documentación de las secuencias de comandos

Al igual que en el caso de los modelos, puede crear documentación adicional para sus scripts, para explicar qué
hacen y como utilizarlos. En el diálogo de edición de scripts, encontrará un botón [Editor de ayuda]. Haga clic
en él y le llevará al diálogo de editor de ayuda. Compruebe la sección acerca del modelador gráfico para conocer
más sobre este diálogo y cómo utilizarlo.

Los archivos de ayuda se guardan en el mismo folder como el script mismo, añadiendo la extensión .help
al nombre del archivo. Tenga en cuenta que puede editar la ayuda de su script antes de guardarlo la primera
vez. Si después cierra el diálogo de edición de script sin guardarlo (es decir, descartarlo), el contenido de la
ayuda que escribió se perderá. Si su script ya fue guardado y tiene asociado un nombre de archivo, se guardara
automáticamente.

17.5.5 Pre y post-ejecución de la secuencia de comandos hooks

Los scripts también pueden ser utilizados para establecer ganchos pre- y post ejecuciones, que se ejecutan antes y
después de la ejecución de un algoritmo. Esto se puede utilizar para automatizar tareas que deben realizarse cada
vez que se ejecuta un algoritmo.

La sintaxis es idéntica a la que se ha explicado anteriormente, pero una variable global adicional llamada alg está
disponible, lo que representa el algoritmo que acaba de ser (o está a punto de ser) ejecutado.

En el grupo General del cuadro de diálogo de configuración de procesamiento se encuentran dos entradas llamadas
Script preejecución y el :guilabel: Script postejecución donde el nombre de archivo de los scripts a ser ejecutados
en cada caso se pueden introducir.

.

218 Chapter 17. QGIS processing framework



QGIS User Guide, Publicación 2.8

17.6 El administrador del historial

17.6.1 El historial del procesamiento

Cada vez que ejecutas un algoritmo, la información acerca del proceso es almacenado en el administrador de la
historia. Junto con los parámetros usados, la fecha y hora de la ejecución también se guardan.

This way, it is easy to track and control all the work that has been developed using the processing framework, and
easily reproduce it.

El administrador del historial es un conjunto de entradas de registros agrupados de acuerdo a su fecha de ejecución,
por lo que es más fácil encontrar información sobre un algoritmo ejecutado en cualquier momento en particular.

Figure 17.28: Historial

Información del proceso se mantiene como una expresión de línea de comandos, incluso si el algoritmo fue lanzado
desde la caja de herramientas. Esto hace que sea también útil para aquellos que están aprendiendo cómo utilizar la
interfaz de línea de comandos, ya que se pueden llamar un algoritmo usando la caja de herramientas y compruebe
el administrados del historial para ver cómo ese mismo algoritmo podría ser llamado desde la línea de comandos.

Parte de la navegación por las entradas en el registro, también puede volver a ejecutar los procesos al hacer doble
clic en la entrada correspondiente.

Along with recording algorithm executions, the processing framework communicates with the user by means of
the other groups of the registry, namely Errors, Warnings and Information. In case something is not working
properly, having a look at the Errors might help you to see what is happening. If you get in contact with a
developer to report a bug or error, the information in that group will be very useful for her or him to find out what
is going wrong.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is stored in the Information group
each time you run one of those algorithms. If, for instance, you are having problems executing a SAGA algorithm,
look for an entry named ‘SAGA execution console output’ to check all the messages generated by SAGA and try
to find out where the problem is.
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Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to the Warning block if they detect potential problems with the data, in order to warn you. Make sure
you check those messages if you are having unexpected results.

17.7 Escribir nuevos algoritmos de procesamiento como scripts
python

Puede crear sus propios algoritmos escribiendo el código Python correspondiente y añadiendo algunas líneas
adicionales para suministrar la información adicional necesaria para definir la semántica del algoritmo. Puede
encontrar un menú Crear nuevo script bajo el grupo Herramientas en el bloque de algoritmos Script de la caja
de herramientas. Haga doble clic en él para abrir el diálogo de edición de script. Ahí es donde se debe escribir
el código. Guardar el script desde allí en la carpeta scripts (el predeterminado cuando se abre el diálogo de
guardar archivo), con la extensión .py, creará automáticamente el algoritmo correspondiente.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Vamos a tener el siguiente código, que calcula el Índice de Humedad Topográfico (TWI) directamente desde un
DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
we can calculate them calling the corresponding SAGA algorithms.

La parte del código donde este procesamiento se lleva a cabo no es difícil de entender si has leído el capítulo
anterior. Las primeras líneas, sin embargo, necesitan una explicación adicional. Proporcionan la información que
se necesita para convertir su código en un algoritmo que se pueda ejecutar desde cualquiera de los componentes
GUI, como la caja de herramientas o el modelador gráfico.

Estas líneas comienzan con un doble símbolo de comentario en Python (##) y tiene la siguiente estructura

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processign scripts, their syntax and some examples.

• raster. Una capa ráster

• vector. Una capa vectorial

• table. Una tabla

• number. Un valor numérico. Un valor predeterminado debe ser proporcionado. Por ejemplo,
depth=number 2.4

• string. Una cadena de texto. Como en el caso de los valores numéricos, un valor predeterminado se debe
añadir. Por ejemplo, name=string Victor

• longstring. Igual que el string, pero un cuadro de texto más grande se mostrará, por lo que es más
adecuado para cadenas largas, como para un script esperando un pequeño fragmento de código.

• boolean. Un valor boolean. Añade True o False después para establecer el valor predeterminado. Por
ejemplo, verbose=boolean True.

• multiple raster. Un conjunto de capas ráster de entrada.
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• multiple vector‘. Un conjunto de capas vectoriales de entrada.

• field. Un campo en la tabla de atruibutos de una capa vectorial. El nombre de la capa se tiene
que añadir después de la etiqueta field. Por ejemplo, si ha declarado una vectorial de entrada con
mylayer=vector, podría utilizar myfield=field mylayer para añadir un campo de esa capa
como parámetro.

• folder. Una carpeta

• file. Un nombre de archivo

• crs. Un Sistema de Referencia de Coordenadas

El nombre del parámetro es el nombre que se mostrará al usuario cuando ejecute el algoritmo, y también el nombre
de la variable a utilizar en el código del script. El valor introducido por el usuario para ese parámetro será asignado
a una variable con ese nombre.

When showing the name of the parameter to the user, the name will be edited it to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Las salidas son definidas en una manera similar, utilizando las siguientes etiquetas:

• ráster de salida

• vector de salida

• tabla de salida

• html de salida

• archivo de salida

• número de salida

• texto de salida

• Extensión de salida

El valor asignado a las variables de salida es siempre una cadena con una ruta de archivo. Corresponderá a una
ruta de archivo temporal en el caso de que el usuario no ha introducido ningún nombre de archivo de salida.

Además de las etiquetas para los parámetros y resultados, también puede definir el grupo en las que se muestra el
algoritmo, utilizando la etiqueta group.

La última etiqueta que se puede utilizar en su cabecera guión es ##nomodeler. Utilice que cuando no quiere
que su algoritmo se muestra en la ventana modelador. Esto se debe utilizar para los algoritmos que no tienen una
sintaxis clara (por ejemplo, si el número de capas que se crearon no se conoce de antemano, en tiempo de diseño),
que los hacen inadecuados para el modelador gráfico

17.8 Manipulación de datos producidos por el algoritmo

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

No utilice el método load() en sus algoritmos de script, sino sólo cuando se trabaja con la línea de la consola.
Si se crea una capa como salida de un algoritmo, que debe ser declarada como tal. De lo contrario, usted no
será capaz de utilizar correctamente el algoritmo en el modelador, ya que su sintaxis (según la definición de las
etiquetas se ha explicado anteriormente) no coincidirá con lo que crea realmente el algoritmo.
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Salidas ocultas (números y cadenas) no tienen un valor. En cambio, es quien tiene que asignar un valor a los
mismos. Para ello, acaba de establecer el valor de una variable con el nombre que utilizó para declarar la salida.
Por ejemplo, si ha usado esta declaración,

##average=output number

En la siguiente línea se establezerá el valor de la salida a 5:

average = 5

17.9 La comunicación con el usuario

Si su algoritmo toma mucho tiempo para procesar, es una buen idea informar al usuario. Se tiene un nombre global
progreso disponible, con dos métodos disponibles: setText(text) y setPercentage(percent)
para modificar el texto y la barra de progreso.

Si tiene información para proporcionar al usuario, no relacionada al progreso del algoritmo, se puede utilizar el
método setInfo(text), también del objeto progreso.

Si su script tiene algún problema, la forma correcta de propagación es plantear una excepción de tipo
GeoAlgorithmExecutionException(). Se puede pasar un mensaje como argumento al constructor de la
excepción. El procesamiento se hará cargo de la manipulación y comunicación con el usuario, dependiendo desde
donde se este ejecutando el algoritmo (Caja de herramientas, modelador, consola Python...)

17.10 Documentando sus scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.11 Scripts de ejemplo

Varios ejemplos están disponibles en la colección en línea de scripts, que pueden acceder al seleccionarlo la
herramienta Obtener script de la colección de script en línea bajo la entrada Scripts/herramientas en la caja de
herramientas.

Por favor, compruebe con ellos para ver ejemplos reales de cómo crear algoritmos que utilizan las clases de la
arquitectura de procesamiento. Puede hacer clic derecho sobre cualquier algoritmo de secuencia de comandos y
seleccione Editar script para editar su código o simplemente para verlo.
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17.12 Las mejores practivas al escribir scripts de algoritmos

Aquí esta un resumen rápido de ideas a considerar cuando crea su propio script de algoritmos y especialemente,
si se desea compartir con otros usuarios de QGIS. Siguiendo estas sencillas reglas asegurará la consistencia entre
los diferentes elementos de procesamiento, tales como la caja de herramientas, el modelador o la interfaz de
procesamiento por lotes.

• No cargar la capa resultante. Deje al Procesamiento manejar sus resultados y cargue sus capas si es nece-
sario.

• Declarar siempre las salidas de su algoritmo creado. Evitar cosas tales como declarar una salida y luego
usando el nombre de archivo de destino establecido para esa salida para crear una colección de ellos. Eso
romperá la semántica correcta del algoritmo y hará que sea imposible usar de forma segura en el modelador.
Si usted tiene que escribir un algoritmo así, asegúrese de agregar la etiqueta ##nomodeler.

• No mostrar cajas de mensaje o utilice algún elemento GUI desde el script. Si desea comunicarse con el
usuario, utilice el método setInfo() o lance GeoAlgorithmExecutionException

• Como una regla de oro, no olvide que su algoritmo puede ser ejecutado en un contexto que no sea la caja de
herramientas de procesamiento.

17.13 Pre y post ejecución de ganchos de scripts

Los scripts también pueden ser utilizados para establecer ganchos pre y post ejecución, que se ejecutan antes y
después de un algoritmo. Esto se puede utilizar para automatizar tareas que deben realizarse cada vez que se
ejecuta un algoritmo.

La sintaxis es idéntica a la que se ha explicado anteriormente, pero una variable global adicional llamada alg esta
disponible, lo que representa el algoritmo que acaba de ser (o esta a punto de ser) ejecutado.

En el grupo General del cuadro de diálogo de configuración de procesamiento se encuentran dos entradas llamadas
Archivo de script de pre-ejecución y el script :guilabel: Archivo script post-ejecución donde el nombre de archivo
de los scripts que deben ejecutarse en cada caso se pueden introducir.

.

17.14 Configurar aplicaciones externas

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external application are managed by their own algorithm provider.

Esta sección le mostrará cómo configurar el entorno de procesamiento para incluir estas aplicaciones adicionales,
y le explicará algunas de las características particulares de los algoritmos basados en ellos. Una vez que haya
configurado correctamente el sistema, usted será capaz de ejecutar algoritmos externos de cualquier componente,
como la caja de herramientas o el modelador gráfico, tal como lo hace con cualquier otro geoalgoritmo.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the configuration dialog. Make sure that the corresponding application is already installed in your
system. Enabling an algorithm provider without installing the application it needs will cause the algorithms to
appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and provide the information
needed about the algorithm) are not included with each application, but with QGIS instead. That is, they are part
of QGIS, so you have them in your installation even if you have not installed any other software. Running the
algorithm, however, needs the application binaries to be installed in your system.
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17.14.1 Aclaración para los usuarios de Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration. If installing through OSGeo4W application, make sure you select for insttallation SAGA and OTB
as well.

Si quiere saber más sobre cómo funcionan estos proveedores, o si quiere utilizar algún algoritmo que no se en-
cuentre en la Caja de Herramientas simplificada (como los scripts de R), siga leyendo.

17.14.2 Aclaración respecto a los formatos de archivos

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Utilizar capas raster de GRASS es, por ejemplo, uno de los casos en los que pueden existir problemas y no
completarse el trabajo si se invoca un algoritmo externo que use dicha capa como entrada. Por este motivo, estas
capas no aparecerán como disponibles para los algoritmos.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common raster layer formats that can later
be transformed by QGIS automatically. As in the case of input layers, if this conversion is needed, that might
increase the processing time.

If the extension of the filename specified when calling an algorithm does not match the extension of any of the
formats supported by QGIS, then a suffix will be added to set a default format. In the case of raster layers, the
.tif extension is used, while .shp is used for vector layers.

17.14.3 Nota referente a las seleccion de capas vectoriales

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

En otros casos sólo es necesario exportar un conjunto de características seleccionadas, lo que hará que los tiempos
de ejecución sean mayores.

SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.
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If you have installed SAGA yourself (remember, you need version 2.1), the path to the SAGA executable must be
configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named SAGA
Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you are
ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with SEXTANTE, so you have to download and install
the software yourself. Please check the SAGA website for more information. SAGA 2.1 is needed.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folders.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

17.14.4 Sobre las limitaciones del sistema de cuadrícula de SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

La definición de este sistema de cuadrícula común es controlado por el usuario, y se encontrará varios parámetros
en el grupo SAGA de la ventana de configuración para hacerlo. Hay dos formas de establecer el sistema de
cuadrícula de destino.

• Establecerlo manualmente. se define la extensión estableciendo los valores de los siguientes parámetros:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Ajuste de forma automática a partir de capas de entrada. Para seleccionar esta opción, simplemente marque
la opción Utilizar el sistema de cuadrícula mínima para remuestreo. Todos los demás ajustes se ignoran y
la medida mínima que cubre todas las capas de entrada que se utilizarán. El tamaño de celda de la capa de
destino es el máximo de todos los tamaños celulares de las capas de entrada.

Para los algoritmos que no utilizan múltiples capas raster, o para aquellos que no necesitan un único sistema de
cuadrícula de entrada, no se realizará un remuestreo antes de invocar SAG y dichos parámetros no son utilizados.

17.14.5 Limitaciones para las capas multibanda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

17.14.6 Limitaciones en el tamaño de celda

SAGA asume que las capas ráster tienen el mismo tamaño de celda en el eje X y Y. Si se está trabajando con
una capa con diferentes valores para el tamaño de celda horizontal y vertical, es posible que obtenga resultados
inesperados. En este caso, se añadirá una advertencia al registro de procesamiento, lo que indica que una capa de
entrada podría no ser adecuada para ser procesada por SAGA.
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17.14.7 Registro

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

La mayoría del resto de proveedores que utilizan una aplicación externa y la invocan a través de la línea de
comandos tienen opciones similares, de forma que las podrá encontrar también en otros lugares de la lista de
ajustes de procesamiento.

R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

De nuevo, esto es diferente en Linux, dónde sólo hay que asegurarse de que el directorio de R está correctamente
incluido en la variable de entorno PATH. Si R puede iniciarse simplemente escribiendo R en una consola, entonces
la configuración es correcta.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

Los archivos de script de R tienen la extensión .rsx, y crearlos es bastante sencillo si sólo tiene un conocimiento
básico de la sintaxis y script de R. Deben ser almacenados en la carpeta de scripts de R. Se puede establecer esta
carpeta en el grupo de ajustes R (disponible desde el diálogo de Configuración de procesamiento), al igual que se
hace con la carpeta para scripts de procesamiento regular.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again.

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of a
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parameter is also the name of the variable that we can use in R for accesing the value of that parameter (thus, you
should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Las tablas se abren con el comando read.csv(). Sin una tabla introducida por el usuario no esta en formato
CSV, será convertirá antes de importarlo en R.

Además, los ráster se pueden leer con el comando readGDAL()‘ en lugar de ‘‘brick() utilizando el
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilename tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Con la información anterior, se puede comprender la primera línea de nuestro primer script de ejemplo (la primera
línea que no comienza con un comentario de Python).

pts=spsample(polyg,numpoints,type="random")

La variable polygon ya contiene un objeto SpatialPolygonsDataFrame, por lo que se puede utilizar para
llamar al método spsample, al igual que numpoints, que indica el número de puntos a añadir a la rejilla de
ejemplo creada.

Como hemos declarado una salida de tipo vectorial llamada salida, tenemos que crear una vari-
able llamada salida y almacenar un objeto Spatial*DataFrame en ella (en este caso, un
SpatialPointsDataFrame). Se puede utilizar cualquier nombre para sus variables intermedias. Sólo
asegúrese de que la variable almacena su resultado final y que tiene el mismo nombre que utilizó al declararla, y
que contiene un valor adecuado.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

Si el algoritmo genera capas raster, la forma en que se guardan dependerá de si o no han utilizado la opción
#dontuserasterpackage. En que lo ha usado, las capas se guardan utilizando el método writeGDAL ().
Si no, se utilizará el método writeRaster() del paquete ráster.

Si ha utilizado la opción #passfilename, las salidas se generan utilizando el paquete raster (mediante
writeRaster()), incluso cuando no se utiliza para las entradas.

Si el algoritmo no genera ninguna capa, sino más bien en su lugar regresa un texto en la consola, tiene que indicar
lo que desea que la consola mostrará una vez finalizada la ejecución. Para ello, basta con iniciar la línea de
comandos que producen los resultados que desea imprimir con el signo > ‘(‘mayor’). La salida de todas las otras
líneas no se mostrará. Por ejemplo, aquí está el archivo de descripción de un algoritmo que realiza una prueba
normalmente en un determinado campo (columna) de los atributos de una capa vectorial:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Si su algoritmo crea algún tipo de gráficos (utilizando el método plot()), añada la siguiente línea:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Tanto los resultados gráficos como de consola, se mostrará en el gesto de resultados de procesamiento.
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For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Nota: rgdal and maptools libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R distribution).
However, other additional libraries that you might need have to be explicitly loaded. Just add the necessary com-
mands at the beginning of your script. You also have to make sure that the corresponding packages are installed in
the R distribution used by QGIS. The processing framework will not take care of any package installation. If you
run a script that requires a package that is not installed, the execution will fail, and Processing will try to detect
which packages are missing. You must install those missing libraries manually before you can run the algorithm.

GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Si se utiliza Linux, hay que asegurarse de que GRASS está correctamente instalado y que se puede ejecutar sin
problemas desde una consola.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behaviour you prefer, just check the
Use min covering region option in the GRASS configuration parameters.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and the
processing framework creates a temporary one for each execution. You have to specify if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

Caja de Herramientas de Orfeo

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are runing Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Entonces, configurar la ruta al directorio donde las aplicaciones de línea de comandos y las librerías de OTB se
encuentran instaladas:

• Normalmente, el directorio de aplicaciones de OTB apunta a ‘/usr/lib/otb/applications‘‘ y el directorio
con los programas de línea de comandos de OTB es ‘/usr/bin‘‘.
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• If you use the OSGeo4W installer, then install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder. These values should be configured by de-
fault, but if you have a different OTB installation, configure them to the corresponding values in your
system.

TauDEM

To use this provider, you need to install TauDEM command line tools.

17.14.8 Windows

Please visit the TauDEM homepage for installation instructions and precompiled binaries for 32-bit and 64-bit
systems. IMPORTANT: You need TauDEM 5.0.6 executables. Version 5.2 is currently not supported.

17.14.9 Linux

There are no packages for most Linux distributions, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Alternatively, TauDEM works fine with Open
MPI, so you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract the files in some folder.

Abrir el archivo linearpart.h , y después de la línea

#include "mpi.h"

añadir una nueva linea con

#include <stdint.h>

y obtendrá

#include "mpi.h"
#include <stdint.h>

Guardar los cambios y cerrar el archivo. Ahora abir tiffIO.h, buscar la línea #include "stdint.h" y
sustituir las comillas ("") con <>, para obtener

#include <stdint.h>

Save the changes and close the file. Create a build directory and cd into it

mkdir build
cd build

Configure your build with the command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile

make

Finally, to install TauDEM into /usr/local/bin, run

sudo make install

.
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17.15 Los Comandos QGIS

El procesado incluye una herramienta practica que le permite ejecutar algoritmos sin tener que utilizar la caja de
herramientas, pero tan solo escribir el nombre del algoritmo que se desee ejecutar.

Esta herramienta es conocida como Comandos GQIS, y esto es solo una sencilla caja de texto con autocompletado
donde se escribe el nombre del comando que se desee ejecutar.

Figure 17.29: The QGIS Commander

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). Apart from
executing Processing algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

17.15.1 Comandos disponibles

Los comandos disponibles en el Comandante caen en la siguiente categoría:

• Algoritmos de procesado. Estos se muestran como Algoritmo de procesamiento: <nombre
del algoritmo>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Funciones Python. Puede crear funciones cortas en Python que serán entonces incluidas en la lista de
comandos disponibles. Ellos se muestran como Function: <nombre de la función>.

Para ejecutar cualquiera de los anteriores, inicie escribiendo y a continuación, seleccione el elemento de la lista de
comandos disponibles que aparecen después de filtrar toda la lista de comandos con el texto que ha introducido.

In the case of calling a Python function, you can select the entry in the list, which is pre-
fixed by Function: (for instance, Function: removeall), or just directly type the
function name (‘‘removeall in the previous example). There is no need to add brackets after the func-
tion name.

17.15.2 Crear funciones personalizadas

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis/sextante/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.
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The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favorite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Por ejemplo, puede añadir la siguiente función, la cual borre todas las capa:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Una vez que se haya añadido la función, estará disponible en Comandos, y puede invocarlo escribiendo
removeall. No hay necesidad de hacer algo más aparte de escribir la función en sí.

Las funciones pueden recibir parámetros. Añadir *args a la definición de su función para recibir argumentos.
Cuando llame a la función desde Comandos, los parámetros tienen que ser pasados separados por espacios.

Aquí esta un ejemplo de una función que carga una capa y toma un parámetro con el nombre del archivo de la
capa cargada.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type load /home/myuser/points.shp
in the Commander text box.

.
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Diseñadores de impresión

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an
image or an SVG-file. This is a powerfull way to share geographical information produced with QGIS that can be
included in reports or published.

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust the properties to create your layout.
The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working
properly with some recent Qt4 versions; you should try and check individually on your system). You can save the
layout as a template and load it again in another session. Finally, generating several maps based on a template can
be done through the atlas generator. See a list of tools in table_composer_1:
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Icono Propósito Icono Propósito

Guardar Proyecto Nuevo diseñador de impresión

Duplicar diseñador de impresión Administrador de diseñadores

Cargar de plantilla Guardar como plantilla

Print or export as PostScript Exportar a un formato de imagen

Exportar como SVG Exportar como PDF

Revertir el último cambio Restaurar el último cambio

Zum general Zoom to 100%

Acercar Zum Alejar Zum

Refresh View

Pan Zoom to specific region

Seleccionar/Mover elementos Mover contenido dentro de un elemento

Añadir nuevo mapa de QGIS a la vista del
mapa

Añadir imagen a diseño de impresión

Añadir etiqueta al diseño de impresión Añadir nueva leyenda a diseño de impresión

Add scale bar to print composition Añadir figura básica al diseño de impresión

Añadir flecha Añadir tabla de atributos

Add an HTML frame

Agrupar elementos Desagrupar elementos

Lock Selected Items Unlock All items

Subir los elementos seleccionados Bajar elementos seleccionados

Mover elementos seleccionados arriba Mover elementos seleccionados abajo

Alinear a la izquierda elementos
seleccionados

Alinear a la derecha elementos seleccionados

Alinear al centro elementos seleccionados Alinear al centro vertical los elementos
seleccionados

Alinear arriba los elementos
seleccionados

Alinear abajo los elementos seleccionados

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Tabla Diseñador 1: Herramientas del Diseñador de Impresión

Todas las herramientas del diseñador de impresión estan disponibles en los menús y como iconos en la barra de
herramientas. La barra de herramientas se puede prender y apagar utilizando el botón derecho del ratón sobre la
barra de herramientas.
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18.1 Primeros pasos

18.1.1 Abrir una plantilla del diseñador de impresión

Before you start to work with the Print Composer, you need to load some raster and vector layers in the QGIS
map canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized

to your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will
be prompted to choose a title for the new Composer.

18.1.2 Overview of the Print Composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items; the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 18.1: Diseñador de impresión

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.
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• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

• Finally, you can save your print composition with the Save Project button.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number and a combo box to set the zoom level.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

Herramientas de navegación

To navigate in the canvas layout, the Print Composer provides some general tools:

• Acercar zum

• Alejar zum

• Zoom full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Pan composer

• Zoom (zoom to a specific region of the Composer)

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need to
switch to pan mode while working in the Composer area, you can hold the Spacebar or the the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to zoom mode, and with Ctrl+Shift+Spacebar, to
zoom out mode.

18.1.3 Sample Session

To demonstrate how to create a map please follow the next instructions.

1. On the left site, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and place the map item with the left mouse button on the Print
Composer canvas. A scalebar will be added to the canvas.
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3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Finally, you can save your print composition with the Save Project button.

18.1.4 Print Composer Options

From Settings → Composer Options you can set some options that will be used as default during your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

18.1.5 Pestaña de Diseño — Configuración general de diseño

En la pestaña Diseño, puede definir la configuración global de su diseño.

• You can choose one of the Presets for your paper sheet, or enter your custom width and height.

• Composition can now be divided into several pages. For instance, a first page can show a map canvas, and
a second page can show the attribute table associated with a layer, while a third one shows an HTML frame
linking to your organization website. Set the Number of pages to the desired value. You can choose the

page Orientation and its Exported resolution. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

• Grid and guides lets you customize grid settings like spacings, offsets and tolerance to your need. The
tolerance is the maximum distance below which an item is snapped to smart guides.

Snap to grid and/or to smart guides can be enabled from the View menu. In this menu, you can also hide or show
the grid and smart guides.

18.1.6 Composer items common options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

• El diálogo Posición y tamaño le permite definir tamaño y posición del marco que contiene los elementos.
También puede optar por Punto de referencia para establecer las coordenadas X y Y previamente definidas.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the label. Use the Frame color and Thickness menus to
adjust those properties.

• Use the Background color menu for setting a background color. With the dialog you can pick a color (see
Color Picker ).
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Figure 18.2: Diálogo de propiedades de elementos comunes

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
any potential web client. You can set an ID on an item (e.g., a map and a label), and then the web client can
send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will list
what items and which IDs are available in a layout.

• Rendering mode can be selected in the option field. See Rendering_Mode.

Nota:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map item
or use expressions. These are particularly helpful with atlas generation (See atlas_data_defined_overrides).

18.2 Modo de representación

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 18.3: Modo de representación

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.
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• Exclude item from exports: You can decide to make an item not visible in all exports. After activating
this checkbox, the item will not be included in PDF’s, prints etc..

• Blending mode: You can achieve special rendering effects with these tools that you previously only may
know from graphics programs. The pixels of your overlaying and underlaying items are mixed through the
settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it; the colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with pixel values of the other. In case
of values above 1 (as in the case of RGB), white is displayed. This mode is suitable for highlighting
features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the numbers for the
corresponding pixel of the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This mode is supposed to emulate shining a soft light onto an image.

– Iluminar fuerte: Ilumina fuerte es muy similar a la del modo de superposición. Se supone que es
emular a la proyección de una luz muy intensa en una imagen.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer with pixel values of the other. In
case of negative values, black is displayed.

18.3 Elementos de diseño

18.3.1 The Map item

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties tab:

• Rectángulo es la configuración predeterminada. Solo muestra una caja vacía con un mensaje ‘El mapa será
impreso aquí’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.
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• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button. After you have found the right place for an item,

you can lock the item position within the Print Composer canvas. Select the map item and use the toolbar
Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected using the Items tab. Once

selected you can use the Items tab to unlock individual items. The Unlock All Items icon will unlock all locked
composer items.

Propiedades principales

The Main properties dialog of the map Item Properties tab provides the following functionalities (see fig-
ure_composer_map_1):

Figure 18.4: Pestaña de propiedades de elementos del mapa

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• El campo Escala establece una escala manual
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• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on

the button you will see the list of all the preset views: just select the preset you want to display. The

map canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you

want to unselect the preset, just uncheck the and press on the button. See Map Legend to find out
how to create presets views.

Extensión

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Figure 18.5: Diálogo de Extensión de Mapa

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grids

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

After you have added a grid, you can activate the checkbox Show grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.
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Figure 18.6: Map Grids Dialog

Figure 18.7: Draw Grid Dialog
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As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the devisions
section of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid
can be chosen. See section Rendering_Mode. Furthermore, you can define an interval in the X and Y directions,
an X and Y offset, and the width used for the cross or line grid type.

Figure 18.8: Grid Frame Dialog

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘LatitudeY/ only’ and ‘Longitude/X only’ setting in the devisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids (see section Rendering_mode).

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose
the annotation numeric format, the options range from decimal to degrees, minute and seconds, with or
without suffix, and aligned or not. You can choose which annotation to show. The options are: show all,
latitude only, longitude only, or disable(none). This is useful when the map is rotated. The annotation can
be drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical
ascending or vertical descending. In case of map rotation you can Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map. Next you create the map
you want to use as the overview map, just like a normal map.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

Open Overviews and press the green plus icon-button to add an overview. Initially this overview is named
‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the overview
item in the list named ‘Overview 1’ and change it to another name.

When you select the overview item in the list you can customize it.
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Figure 18.9: Grid Draw Coordinates dialog

Figure 18.10: Map Overviews Dialog
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• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes. See Rendering_Mode.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

18.3.2 The Label item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 18.11: Pestaña de propiedades de elemento de etiqueta

Propiedades principales

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be

18.3. Elementos de diseño 245



QGIS User Guide, Publicación 2.8

useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Appearance

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

18.3.3 The Image item

To add an image, click the Add image icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the image Item Properties tab.

The picture Item Properties tab provides the following functionalities (see figure_composer_image_1):

Figure 18.12: Pestaña de propiedades de elemento imagen

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.
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2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes
the rotation of a picture in the QGIS map canvas (i.e., a rotated north arrow) with the appropriate Print Composer
image.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Nota: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

18.3.4 The Legend item

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Propiedades principales

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

In Main properties you can:

• Change the title of the legend.

• Set the title alignment to Left, Center or Right.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.
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Figure 18.13: North arrows available for selection in provided SVG library

Figure 18.14: Pestaña de propiedades del elemento leyenda

Figure 18.15: Diálogo de Propiedades de la leyenda principal
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Elementos de la leyenda

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

Figure 18.16: Diálogo de elementos de la leyenda

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer-, groupname or title, first you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• Se puede cambiar la fuente del título de la leyenda, grupo, subgrupo y elementos (capa) en la leyenda. Haga
clic en un botón de categoría para abrir un diálogo Seleccionar fuente.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can change the width and height of the legend symbol in this dialog.
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Figure 18.17: Diálogo de Fuentes de leyenda, Columnas, Símbolo y Espaciado

WMS LegendGraphic and Spacing

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

Figure 18.18: WMS LegendGraphic Dialogs

When you have added a WMS layer and you insert a legend composer item, a request will be send to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.
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18.3.5 The Scale Bar item

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see fig-
ure_composer_scalebar_1):

Figure 18.19: Scale Bar Item properties Tab

Propiedades principales

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_scalebar_2):

Figure 18.20: Scale Bar Main properties Dialog

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).

Unidades y Segmentos

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

In these two dialogs, you can set how the scale bar will be represented.
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Figure 18.21: Scale Bar Units and Segments Dialogs

• Select the map units used. There are four possible choices: Map Units is the automated unit selection;
Meters, Feet or Nautical Miles force unit conversions.

• The Label field defines the text used to describe the units of the scale bar.

• The Map units per bar unit allows you to fix the ratio between a map unit and its representation in the scale
bar.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar, and how
long each segment will be (Size field). Height can also be defined.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

Figure 18.22: Scale Bar Display

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing

• Line width : line widht of the scale bar drawing

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)
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Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 18.23: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font

• Font color: set the font color

• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

18.3.6 The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon or the Add Arrow icon, place
the element holding down the left mouse. Customize the appearance in the Item Properties tab.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

Figure 18.24: Pestaña de propiedades del elemento figura

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.
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You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Nota: Unlike other items, you can not style the frame or the background color of the frame.

18.3.7 The Arrow item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties tab.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see the_image_item).

Figure 18.25: Pestaña de propiedades del elemento flecha

Item Properties

The Arrow item properties tab allows you to configure an arrow item.

The [Line style ...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default : To draw a regular arrow, gives you options to style the arrow head

• None : To draw a line without arrow head

• SVG Marker : To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color : Set the outline color of the arrow head

• Arrow fill color : Set the fill color of the arrow head
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• Arrow outline width : Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker : Choose an SVG image to draw at the beginning of the line

• End marker : Choose an SVG image to draw at the end of the line

• Arrow head width: Sets the size of Start and/or End marker

SVG images are automatically rotated with the line. The color of the SVG image can not be changed.

18.3.8 The Attribute Table item

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, place the element with the left mouse button on the Print Composer canvas, and position and customize the
appearance in the Item Properties tab.

The Item properties of an attribute table item tab provides the following functionalities (see fig-
ure_composer_table_1):

Figure 18.26: Attribute table Item properties Tab

Propiedades principales

The Main properties dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_2):

• For Source you can normally select only ‘Layer features’.

• With Layer you can choose from the vector layers loaded in the project.

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
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Figure 18.27: Attribute table Main properties Dialog

layer. Choosing ‘Relation children’, an option with the relation name will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and it will
show the children rows of the atlas coverage layer’s current feature (for further information about the atlas
generation see atlasgeneration).

Figure 18.28: Attribute table Main properties for ‘Current atlas feature’

Figure 18.29: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table.

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in a row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cel in the Headings column to change the Heading, just type in a new name.

– Select a cel in the Alignment column and you can choose between Left, Center or Right alignment.

– Select a cel in the Width column and you can change it from Automatic to a width in mm, just type a
number. When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

In the Sorting section you can:
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– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.

– use the minus button to remove an attribute from the sort order list.

Figure 18.30: Seleccionar tabla de atributos Diálogo de atributos

Feature filtering

The Feature filtering dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_4):

Figure 18.31: Attribute table Feature filtering Dialog

You can:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.
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• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the arpoirts that have a letter ‘i’ in the attribute field ‘USE’.

Appearance

The Appearance dialogs of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_5):

Figure 18.32: Attribute table appearance Dialog

• Click Show empty rows to make empty entries in the attribute table visible.

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have choosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Draw empty cells, will fill the attribute table with empty cells, this option can also be used to provide
additional empty cells when you have a result to show!

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table.

Show grid

The Show grid dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_6):
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Figure 18.33: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Stroke width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table Item Properties tab provide the following functionalities
(see figure_composer_table_7):

Figure 18.34: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment and choose from Follow column align-
ment, Left, Center or Right. The column alignment is set using the Select Attributes dialog (see Fig-
ure_composer_table_3 ).

Frames

The Frames dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_8):

Figure 18.35: Attribute table Frames Dialog
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• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

18.3.9 The HTML frame item

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties tab (see
figure_composer_html_1).

Figure 18.36: HTML frame, the item properties Tab

HTML Source

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_html_2):
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Figure 18.37: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Source you can enter text in the textbox with some HTML tags or provide a full HTML page.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activate Evaluate QGIS expressions in HTML code to see the result of the expression you have included,
otherwise you will see the expression instead.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Frames

The Frames dialog of the HTML frame Item Properties tab provides the following functionalities (see fig-
ure_composer_html_3):

Figure 18.38: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.
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• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Figure 18.39: HTML frame, Use smart page breaks and User stylesheet properties

• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

18.4 Manage items

18.4.1 Size and position

Each item inside the Composer can be moved/resized to create a perfect layout. For both operations the first step is

to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while holding
the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the Shift
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while moving the mouse. If you need a better precision, you can move a selected item using the Arrow keys
on the keyboard; if the movement is too slow, you can speed up it by holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. Guides are set by clicking
and dragging in the rulers. Guides are moved by clicking in the ruler, level with the guide and dragging to a new
place. To delete a guide move it off the canvas. If you need to disable the snap on the fly just hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group just like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

18.4.2 Alignment

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1). This order is shown in the Items tab. You can also raise
or lower objects in the Items tab by clicking and dragging an object’s label in this list.

There are several alignment functionalities available within the Align selected items pull-down menu (see ta-
ble_composer_1). To use an alignment functionality, you first select some elements and then click on the matching
alignment icon. All selected elements will then be aligned within to their common bounding box. When moving
items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

18.4.3 Copy/Cut and Paste items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position.

Nota: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties tab.

18.5 Revertir y Restaurar herramientas

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change
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Figure 18.40: Líneas auxiliares de alineación en el diseño de impresión
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This can also be done by mouse click within the Command history tab (see figure_composer_29).

Figure 18.41: Historial de comandos en el diseñador de impresión

18.6 Generación de Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_atlas):

Figure 18.42: Pestaña de Generación de Atlas

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the geometries
on which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• Una caja de texto Expresión de nombre de archivo de salida que se utiliza para generar un nombre de archivo
para cada geometría si es necesario. Se basa en expresiones. Este campo es significativo solo para presentar
múltiples archivos.
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• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A radiobutton Margin around feature that allows you to select the amount of space added around each
geometry within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project –> Project Properties –> General –> Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

18.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. For example, for
a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’ format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ is ‘ format_number($area/1000000,2) %] is an
expression used inside the label. That would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

18.6.2 Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly usefull with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than it’s width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. press the button of field Orientation,
select Edit ... so the Expression string builder dialog opens. Give following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically for each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) - 20
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Use the button of field Heigth to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 210 ELSE 297 END) - 20

When you want to give a title above map in the center of the page, insert a label item above the map. First use the
item properties of the label item to set the horizontal alignment to Center. Next activate from Reference point
the upper middle checkbox. You can provide following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when page
is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in english and portugese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use Data Defined Overrides.

18.6.3 Preview

Once the atlas settings have been configured and map items selected, you can create a preview of all the pages by
clicking on Atlas → Preview Atlas and using the arrows, in the same menu, to navigate through all the features.

18.6.4 Generación

The atlas generation can be done in different ways. For example, with Atlas → Print Atlas, you can directly print
it. You can also create a PDF using Atlas → Export Atlas as PDF: The user will be asked for a directory for saving

all the generated PDF files (except if the Single file export when possible has been selected). If you need to
print just a page of the atlas, simply start the preview function, select the page you need and click on Composer
→ Print (or create a PDF).

18.7 Hide and show panels

To maximise the space available to interact with a composition you can use View –> Hide panels or press F10.

:: note:

It’s also possible to switch to a full screen mode to have more space to interact by pressing
:kbd:‘F11‘ or using :guilabel:‘View --> |checkbox| :guilabel:‘Toggle full screen‘.

18.8 Crear salida

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the sections above.

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View –> Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.
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Figure 18.43: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• Export as PDF saves the defined Print Composer canvas directly as a PDF.

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will also create a world file.

Nota:
• Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying Qt

library. This will hopefully be sorted out in future versions.

• Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is also a problem
with the underlying Qt management of rasters.

18.9 Administrar el diseñador de impresión

With the Save as template and Add items from template icons, you can save the current state of a Print Composer
session as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in Composer → Composer Manager allows you to add a
new Composer template, create a new composition based on a previously saved template or to manage already
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existing templates.

Figure 18.44: EL Administrador de diseñadores

By default, the Composer manager searches for user templates in ~/.qgis2/composer_template.

The New Composer and Duplicate Composer buttons in the QGIS toolbar and in Composer → New Composer
and Composer → Duplicate Composer allow you to open a new Composer dialog, or to duplicate an existing
composition from a previously created one.

Finally, you can save your print composition with the Save Project button. This is the same feature as in the QGIS
main window. All changes will be saved in a QGIS project file.

.
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CHAPTER 19

Complementos

.

19.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

Puede administrar sus complementos en el diálogo de complementos que se puede abrir con Complementos >
Administrar e instalar complementos....

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface
could display a blue link in the status bar to tell you that there are some updates for plugins waiting to be applied.

19.1.1 El diálogo de complementos

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin have some metadatas displayed in the right panel:

• information if the plugin is experimental

• descripción

• rating vote(s) (you can vote for your prefered plugin!)

• etiquetas

• some useful links as the home page, tracker and code repository

• autor(es)

• versión disponible

Puede utilizar el filtro para encontrar un complemento específico.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin], if a plugin is listed but not installed,
and [Uninstall plugin] as well as [Reinstall plugin], if a plugin is installed. If a plugin is installed, it can be
de/activated using the checkbox.

Installed

En este menú, se pueden encontrar solo los complementos instalados. Los complementos instalados pueden ser
desinstalados y reinstalados usando los botones [Desinstalar complemento] y [Reinstalar complemento]. Se
puede [Actualizar todo] aquí también.
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Figure 19.1: The All menu

Figure 19.2: The Installed menu
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No instalado

This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Figure 19.3: The Not installed menu

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for
more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons.

Settings

Este menú, puede utilizar las siguientes opciones:

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Mostrar también complementos obsoletos. Estos complementos están en desuso y generalmente no
aptos para uso en producción.

Para añadir un repositorio de un autor externo, haga clic [Añadir...] en la sección Repositorios de complementos.
Si no desea uno o más de los repositorios añadidos, se pueden deshabilitar con el botón [Editar...], o eliminar
completamente con el botón [Borrar]

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.

Truco: Core and external plugins
QGIS plugins are implemented either as Core Plugins or External Plugins. Core Plugins are maintained by
the QGIS Development Team and are automatically part of every QGIS distribution. They are written in one of
two languages: C++ or Python. External Plugins are currently all written in Python. They are stored in external
repositories and are maintained by the individual authors.
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Figure 19.4: The Upgradeable menu

Figure 19.5: The Settings menu
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Detailed documentation about the usage, minimum QGIS version, home page, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, documentation might be available with the external plugins themselves. In general, it is not included
in this manual.

.
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19.2 Using QGIS Core Plugins

Icono Complemento Descripción Manual de referencia
Accuracy Assessment Generate an error matrix accuracy
CadTools Perform CAD-like functions in QGIS cadtools

Captura de
coordenadas

Captura de coordenadas del ratón en
diferentes SRC

Complemento Captura de
coordenadas

DB Manager Manage your databases within QGIS Complemento administrador
de BBDD

Conversor DXF2Shp Convertir de archivo DXF a formato SHP Complemento Conversor
DxfaShp

eVis Herramienta de visualización de eventos Complemento Visualización de
Eventos

fTools Un conjunto de herramientas vectoriales Complemento fTools

Herramientas de GPS Herramientas para cargar e importar datos
GPS

Plugin de GPS

GRASS Funcionalidad GRASS Integracion GRASS SIG

Herramientas GDAL Funcionalidad ráster GDAL Complemento Herramientas de
GDAL

Georreferenciador
GDAL

Georeferenciación de rásteres con GDAL Complemento
Georreferenciador

Mapa de calor Crear mapa de calor de un capa de puntos
de entrada.

Complemento Mapa de calor

Complemento de
interpolación

Interpolación en base a vétices de una
capa vectorial

Complemento de interpolación

Edición fuera de línea Edición fuera de línea y sincronización
con la base de datos

Complemento Edición fuera de
linea

Georaster Espacial de
Oracle

Acceso a Georasters Espaciales de Oracle Complemento GeoRaster
espacial de Oracle

Administrar
complementos

Administrar complementos núcleo y
externos

El diálogo de complementos

Análisis del terreno
ráster

Calcular entidades geomorfológica de un
DEMs

Complemento Análisis de
Terreno

Complemento Grafo
de rutas

Análisis de la ruta más corta Complemento Grafo de rutas

SQL Anywhere
plugin

Access SQL anywhere DB sqlanywhere

Consulta espacial Consulta espacial en vectores Complemento Consulta
espacial

SPIT Shapefile to PostgreSQL/PostGIS Import
Tool

Complemento SPIT

Estadísticas de zona Calcular estadísticas de ráster para
polígonos.

Complemento de Estadísticas
de zona

MetaSearch Interactuar con metadata catalogue
services (CSW)

MetaSearch Catalogue Client
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.

19.3 Complemento Captura de coordenadas

El complemento de captura de coordenadas es fácil de usar y proporciona la capacidad de mostrar coordenadas en
la vista del mapa para dos sistemas de referencia de coordenadas (SRC).

Figure 19.6: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Pulse en la casilla de verificación Activar transformación de SRC al vuelo y seleccione un sistema de
coordenadas proyectadas de su elección (vea también Trabajar con Proyecciones)

3. Activar el complemento de Captura de coordenadas en el Administrador de complementos (vea El diálogo

de complementos) y asegúrese que el diálogo es visible, vaya a Ver → Paneles y y asegúrese que Captura
de coordenadas está habilitada. El diálogo de captura de coordenadas aparece como se muestra en la Figura
figure_coordinate_capture_1. Alternativamente, también puede ir a Vectorial → Captura de coordenadas y

vea si Captura de coordenadas está habilitada.

4. Haga clic en el icono Pulse para seleccionar el SRC a usar para la visualización de coordenadas y elija un SRC diferente al
que seleccionó anteriormente.

5. Para empezar a capturar coordenadas, pulse [Comenzar captura]. Ahora puede hacer clic en cualquier
lugar de la vista del mapa y el complemento mostrará las coordenadas en ambos SRC seleccionados.

6. Para habilitar el seguimiento de coordenadas del ratón, pulse el icono Seguimiento del ratón.

7. También se pueden copiar las coordenadas seleccionadas al portapapeles.

.

19.4 Complemento administrador de BBDD

The DB Manager Plugin is officially part of the QGIS core and is intended to replace the SPIT Plugin and,

additionally, to integrate all other database formats supported by QGIS in one user interface. The DB Manager

Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and it will
import your layer into your spatial database. You can drag and drop tables between spatial databases and they will
get imported. .. _figure_db_manager:

El menú Base de datos permite conectar a una base de datos existente, para iniciar la ventana de SQL y para
finalizar el componente de Administrador de BBDD. Una vez que este conectado a la base de datos existente, los
menús Esquema y Tabla aparecerá de forma adicional.

EL menú Esquema incluye herramientas para crear y eliminar (vaciar) esquemas y, si la topología esta disponible
(e.j., PostGIS 2), iniciar un TopoViewer.
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Figure 19.7: DB Manager dialog

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

Si se está conectado a una base de datos, la ventana principal del Administrador de BBDD ofrece tres pestañas.
La pestaña Info proporciona información acerca de la tabla y su geometría, así como de los campos existentes,
limitaciones e índices. También permite que ejecute Vacuum Analyze y crear índices espaciales en una tabla
seleccionada, si no está ya hecho. La pestaña de Tabla muestra todos los atributos y la pestaña Vista preliminar
representa las geometrías como vista previa.

19.4.1 Trabajar con la ventana SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

.

19.5 Complemento Conversor DxfaShp

El complemento Conversor DxfaShp se puede usar para convertir datos vectoriales del formato DXF a archivo
shape. Requiere que se especifiquen los siguientes parámetros antes de ejecutarlo:
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Figure 19.8: Executing SQL queries in the DB Manager SQL window

Figure 19.9: Complemento Conversor DxfaShp
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• Archivo DXF de entrada: Introduzca la ruta al archivo DXF a convertir.

• Archivo shp de salida: Introduzca el nombre deseado para el archivo shape a crear.

• Tipo de archivo de salida: Especificar el tipo de geometría del archivo de salida. Actualmente los tipos
soportados son polilíneas, polígonos y puntos.

• Exportar etiquetas de texto: Cuando esta casilla de verificación esta habilitada, se creará una capa de
puntos adicional, y la tabla DBF asociada contendrá información sobre los campos “texto” que se encuentran
en el archivo DXF y las cadenas de texto en sí.

19.5.1 Usar el complemento

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see El diálogo de complementos) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Introduzca el archivo DXF de entrada, un nombre para el archivo shape de salida y el tipo de archivo shape.

3. Habilitar la casilla de verificación Exportar etiquetas de texto si desea crear una capa extra de puntos
con etiquetas.

4. Hacer clic en [Aceptar]

.

19.6 Complemento Visualización de Eventos

(En esta sección se deriva de Horning, N., K, Koy, P. Ersts. 2009. eVis (v1.1.0) Guía de Usuario.
Museo Americano de Historia Natural, Centro para la Biodiversidad y Conservación. Disponible de
http://biodiversityinformatics.amnh.org/, y realizado bajo GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see El diálogo de complementos).

El complemento de visualización de eventos se compone de tres módulos: la ‘Herramienta para conexión a la base
de datos’, ‘Herramienta de ID evento’, y el ‘Eventos del navegador’. Estos trabajan juntos para permitir la visual-
ización de fotografías geocodificadas y otros documentos que están vinculados a objetos espaciales almacenados
en archivo de vectores, base de datos o hojas de cálculo.

19.6.1 Explorador de Eventos

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.
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Iniciar el módulo de Explorador de eventos

Para poner en marcha el modulo Explorador de Eventos, haga clic en Base de datos→ eVis → Explorador de
Eventos eVis. Esto abrirá la ventana Explorador de Eventos Genérico.

La ventana Explorador de eventos tiene tres pestañas desplegadas en la parte superior de la ventana. La pestaña Vi-
sualizar se utiliza para ver las fotografías y los datos de sus atributos asociados. La pestaña Opciones proporciona
un número de ajustes para controlar el funcionamiento del complemento eVis. Por último, la pestaña Config-
uración de aplicaciones externas se utiliza para mantener una tabla de extensiones de archivos y su aplicación
asociada para permitir a eVis desplegar documentos que no sean imágenes.

Comprender la ventana Visualizar

Para ver la ventana Visualizar, haga clic en la pestaña Visualizar en la ventana Explorador de Eventos. La ventana
Visualizar se utiliza para visualizar las fotografías geocodificadas y los atributos asociados a ellas.

Figure 19.10: La ventana de eVis visualizar

1. Ventana de Visualizar: Una ventana donde la fotografía aparece.

2. Botón de Acercar zoom: Acercar zoom para ver más detalle. Si la imagen completa no puede ser visual-
izada en la ventana de visualizar, las barras de desplazamiento aparecerán en del lado izquierdo e inferior
de la ventana para permitirle desplazarse por la imagen.

3. Botón de Alejar zoom: Alejar zoom para ver más área.

4. Botón Zum general: Despliega la fotografía completa.

5. Ventana de información de atributos: Toda la información de atributos del punto asociado con la foto que
se está viendo se muestra aquí. Si el tipo de archivo al que hace referencia del registro mostrado no es una
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imagen sino un tipo de archivo definido en la pestaña Configurar aplicaciones externas cuando haga doble
clic en el valor del campo que contiene la ruta al archivo se abrirá la aplicación para ver u oír el contenido
del archivo. Si se reconoce la extensión del archivo los datos de los atributos se mostrarán en verde.

6. Botones de Navegación: Utiliza el botón anterior y siguiente para cargar el objeto anterior o siguiente
cuando mas de un objeto espacial esta seleccionado.

Comprender la ventana de Opciones

Figure 19.11: La ventana de eVis Opciones

1. Ruta del archivo: Una lista desplegable para especificar el campo de atributo que contiene la ruta del
directorio o URL para las fotografías u otros documentos que se muestran. Si la ubicación es una ruta
relativa, entonces la casilla de verificacion debe hacer clic. LA ruta base para una ruta relativa puede ser
introducida en la caja de texto Ruta Base a continuación. La información sobre las diferentes opciones
para especificar la ubicación del archivo se indica en la sección Especificar la ubicación y nombre de la
fotografía a continuación.

2. Rumbo de la brújula: Una lista desplegable para especificar el campo de atributo que contiene el rumbo
de la brújula asociado con las fotografías que se muestran. Si la información del rumbo de la brújula esta
disponible, es necesario hacer clic en casilla de verificación a continuación el título del menú desplegable.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Ruta del archivo: La ruta de la base sobre la que se añadirá la ruta relativa se define en Figure_eVis_2 (A).
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5. Sustituir la ruta: Si esta casilla de verificación esta marcada, solo el nombre del archivo de A se anexará a
la ruta base.

6. Aplicar regla a todos los documentos: Si se marco, las mismas reglas de ruta que están definidas para
las fotografías se utilizarán para los documentos sin imagen, tales como películas, documentos de texto
y archivos de sonido. Si no se marca, las reglas de ruta sólo se aplicarán a las fotografías, y los otros
documentos ignorarán el parámetro de la ruta base.

7. Recordar ajustes: Si la casilla de verificación es marcada, los valores de los parámetros asociados se
guardarán para la siguiente sesión cuando la ventana se cierra o cuando el botón [Guardar] de abajo sea
presionado.

8. Restablecer: Restablecer los valores en esta línea a la configuración predeterminada.

9. Restaurar los valores predeterminados: Esto restablecerá todos los campos a su configuración predeter-
minada. Tiene el mismo efecto hacer clic en todos los botones de [Restablecer].

10. Guardar: Esto guardará los ajustes sin cerrar el panel Opciones.

Comprender la ventana de Configurar aplicaciones externas

Figure 19.12: La ventana de eVis Aplicaciones externas

1. Tabla de referencia de archivo: Una tabla contiene los tipos de archivo que se pueden abrir utilizando
eVis. Cada tipo de archivo necesita una extensión de archivo y la ruta de una aplicación que pueda abrir ese
tipo de archivo. Esto proporciona la capacidad de abrir una amplia gama de archivos tales como películas,
grabaciones sonoras y documentos de texto en lugar de solo imágenes.

2. Añadir nuevo tipo de archivo: Añadir un nuevo tipo de archivo con una única extensión y la ruta para la
aplicación que puede abrirlo.

3. Borrar la fila actual: Borrar el tipo de archivo destacado en la tabla y definido por una extensión de archivo
y una ruta a una aplicación asociada.

19.6.2 Especificar la ubicación y nombre de la fotografía

La ubicación y nombre de la fotografía se pueda almacenar utilizando una ruta relativa o absoluta, o una URL,
si la fotografía esta disponible en el servidor web. Ejemplos de los diferentes enfoques están listados en la tabla
evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76
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19.6.3 Especificar la ubicación y nombre de otros documentos soportados

Los documentos de apoyo tales como documentos de texto, videos, y clips de sonido también se pueden visualizar
o reproducir por eVis. Para ello, es necesario añadir una entrada en el archivo de tabla de referencia que se puede
acceder desde la ventana Configurar Aplicaciones Externas ‘ en el :guilabel:‘Generic Event Browser que coincide
con la extensión de archivo a una aplicación que se puede utilizar para abrir el archivo. También es necesario
disponer de la ruta o URL para el archivo en la tabla de atributos de la capa vectorial. Una regla adicional que
puede ser utilizada para las direcciones URL que no contienen una extensión de archivo para el documento que
desea abrir es especificar la extensión del archivo antes de la URL. El formato es — file extension:URL.
La URL es precedida por la extensión de archivo y dos puntos; esto es particularmente útil para el acceso a los
mismos a partir de los wikis y otros sitios web que utilizan una base de datos para gestionar las páginas web (véase
Table evis_examples).

19.6.4 Utilizar el Explorador de eventos

Cuando la ventana :guilabel: Navegador de Eventos se abre, una fotografía aparecerá en la pantalla si el documento
se hace referencia en la tabla de atributos de archivo vectorial es una imagen y si la información de la ubicación
del archivo en la ventana Opciones es correctamente establecida. Si se espera una fotografía y no aparece, será
necesario ajustar los parámetros en la ventana :guilabel: Opciones.

Si un documento de apoyo (o una imagen que no tiene una extensión de archivo reconocido por eVis) se hace
referencia en la tabla de atributos, el campo que contiene la ruta del archivo se resaltará en verde en la ventana de
información de atributos si esa extensión de archivo se define en el archivo de la tabla de referencia se encuentra
en la ventana Configurar Aplicaciones Externas. Para abrir el documento, haga doble clic en la línea verde
resaltado en la ventana de información de atributos. Si un documento de apoyo se hace referencia en la ventana
de información de atributos y la ruta del archivo no está resaltado en verde, entonces será necesario añadir una
entrada para la extensión de nombre de archivo del archivo en la ventana Configurar Aplicaciones Externas. Si la
ruta del archivo se resalta en verde, pero no se abre al hacer doble clic, será necesario ajustar los parámetros en la
ventana :guilabel: Opciones por lo que el archivo puede ser localizado por eVis.

Si no se proporciona una brújula en la ventana :guilabel: Opciones, un asterisco rojo se mostrará en la parte
superior de la característica de vector que se asocia con la fotografía que se muestra. Si se proporciona una
brújula, a continuación, aparecerá una flecha apuntando en la dirección indicada por el valor en el campo de
visualización de brújula en la ventana :guilabel: Navegador de Eventos. La flecha estará centrado sobre el punto
que se asocia con la fotografía u otro documento.

Para cerrar la ventana Explorador de eventos, haga clic en el botón [Cerrar] de la ventana Visualizar.

19.6.5 Herramienta ID evento

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Iniciar el módulo ID evento

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.
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19.6.6 Conexión a base de datos

El módulo ‘Conexión a base de datos’ proporciona herramientas para conectar a y consultar una base de datos u
otros recursos ODBC, tales como una hoja de cálculo.

eVis puede conectar directamente a los siguientes tipos de base de datos: PostgreSQL, MySQL, y SQLite; también
puede leer desde conexiones ODBC (por ejemplo, MS Access). Al leer desde una base de datos ODBC (por
ejemplo una hoja de Excel), es necesario configurar su driver ODBC para el sistema operativo que esté utilizando

Iniciar el módulo de Conexión a base de datos

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectar a una base de datos

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Introduzca el host de base de datos en el cuadro de texto :guilabel: Host de Base de Datos. Esta opción no está
disponible si ha seleccionado ‘MS Access’ como el tipo de base de datos. Si la base de datos reside en su equipo,
usted debe seleccionar “localhost”.

Introducir el nombre de la base de datos en la caja de texto Nombre de la base de datos. Si seleccionó ‘ODBC’
como el tipo de base de datos, es necesario introducir el nombre de la fuente de datos.

Cuando todos los parámetros están llenos, haga clic en el botón [Conectar]. Si la conexión es satisfactoria, un
mensaje se escribirá en la ventana Consola de salida, inicia que la conexión fue establecida. Si una conexión no
se establece, se necesita comprobar los parámetros correctos fueron insertados anteriormente.

1. Tipo de base de datos: Una lista desplegable para especificar el tipo de base de datos que se utilizará.

2. Host de la base de datos: El nombre del host de la base de datos.

3. Puerto: El numero de puerto si una un tipo de base de datos MySQL o PostgreSQL es seleccionado.

4. Nombre de la base de datos: EL nombre de la base de datos.

5. Conectar: Un botón para conectar a la base de datos utilizando los parámetros definidos anteriormente.

6. Salidas a la Consola: La ventana de consola donde los mensajes relacionados a procesos son mostrados.

7. Nombre del Usuario: Nombre del usuario para utilizar cuando una base de datos este protegida con con-
traseña.

8. Contraseña: Para usar cuando la base de datos esta protegida con contraseña.

9. Consultas predefinidas: Pestaña para abrir la ventana “Consultas Predefinidas”.

10. Conexión a base de datos: Pestaña para abrir la ventana “Conexión a base de datos”.

11. Consulta SQL: Pestaña para abrir la ventana “Consulta SQL”.

12. Ayuda: Muestra la ayuda en línea.

13. Aceptar: Cierra la ventana principal “Conexión a Base de datos”
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Figure 19.13: La ventana de conexión a base de datos eVis

Ejecutar consultas SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Haga clic en el botón [Ejecutar Consulta] para ejecutar el comando. Si la consulta es satisfactoria, una ventana
Selección de archivo de base de datos se mostrará. Si la consulta no es satisfactoria, aparecerá un mensaje de error
en la ventana Consola de salida.

En la ventana Selección de archivo de base de datos, introduzca el nombre de la capa que será creada de los
resultados de la consulta en la caja de texto Nombre de la nueva capa

1. Ventana de texto de consulta SQL: Una pantalla para consultas tipo SQL.

2. Ejecutar consulta: El botón para ejecutar la consulta introducida en la Consulta SQL.

3. Consola de salida: La consola de salida donde se muestran los mensajes relacionados con el procesamiento.

4. Ayuda: Muestra la ayuda en línea.

5. Aceptar: Cierra la ventana principal Conexión a base de datos.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Truco: Crear una capa vectorial de una Hoja de cálculo de Microsoft Excel
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Figure 19.14: La pestaña Consulta SQL de eVis

When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Ejecutar consultas predefinidas

Con las consultas predefinidas, se pueden seleccionar consultas escritas previamente almacenadas en un archivo
de formato XML. Esto es particularmente útil, si no esta familiarizado con comandos SQL. Haga clic en la pestaña
Consultas predefinidas para visualizar la interfaz de consultas predefinidas.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Seleccione la consulta que desee ejecutar del menú desplegable y después haga clic en la pestaña Consulta SQL
para ver las consultas que se han estado cargando en la ventana de consultas. Si es la primera vez puede ejecutar
una consulta predefinida o esta cambiando a base de datos, necesita estar seguro para conectarse a la base de datos.

Haga clic en el botón [Ejecutar consulta] en la pestaña Consulta SQL para ejecutar el comando. Si la consulta
es satisfactoria, una ventana Selección de archivo de base de datos se mostrará. Si la consulta no es satisfactoria,
aparecerá un mensaje de error en la ventana Consola de salida

1. Abrir Archivo: Iniciar el archivo “Abrir Archivo” navegar para buscar el archivo XML manteniendo las
consultas predefinidas.
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Figure 19.15: La pestaña de eVis Consultas predefinidas

2. Consultas predefinidas: Una lista desplegable con todas las consultas definidas por el archivo XML de
consultas predefinidas.

3. Descripción de consulta: Una descripción corta de la consulta. Esta descripción es del archivo XML de
consultas predefinidas.

4. Consola de salida: La consola de salida donde se muestran los mensajes relacionados con el procesamiento.

5. Ayuda: Muestra la ayuda en línea.

6. Aceptar: Cierra la ventana principal “Conexión a Base de datos”

El formato XML para consultas predefinidas eVis

Las etiquetas XML leídas por eVis
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Etiquetas Descripción
Consulta Definir el inicio y fin de una sentencia de consulta.
Descripción
corta

Una descripción corta de la consulta que aparece en el menú desplegable de eVis.

Descripción Una descripción más detallada de la consulta desplegada en la ventana de texto de consulta
predefinida.

Tipo de base
de datos

El tipo de la base de datos, definido en el menú desplegable de Tipo de base de datos en la
pestaña de Conexión a base de datos.

Puerto El puerto como se define en el cuadro de texto Puerto en la pestaña de Conexión a base de
datos.

Nombre de la
base de datos

El nombre de la base de datos como se define en el cuadro de texto en la pestaña de
Conexión a base de datos.

Nombre de
usuario

El nombre de usuario de la base de datos como se define en el cuadro de texto Nombre de
usuario en la pestaña de Conexión a base de datos.

databasepass-
word

La contraseña de la base de datos como se define en el cuadro de texto Contraseña en la
pestaña Conexión a base de datos.

Sentencia sql El comando SQL
autoconectar Una bandera (“verdadero” o “falso”) para especificar si las etiquetas anteriores deben

utilizarse para conectarse automáticamente a la base de datos sin ejecutar la rutina de
conexión de base de datos en la solapa Conexión de Base de Datos.

Se muestra un archivo XML de ejemplo completo con tres preguntas a continuación:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
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<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

.

19.7 Complemento fTools

El objetivo del complemento fTools Python es proporcionar un recurso integral para muchas tareas comunes de
SIG basados en vectores, sin necesidad de software adicional, bibliotecas, o complejas soluciones temporales.
Proporciona un conjunto cada vez mayor de las funciones de gestión y análisis de datos espaciales que son a la
vez rápidos y funcionales.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see El diálogo de complementos). When enabled, the fTools
plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry
and Geoprocessing Tools, as well as several useful Data Management Tools.

19.7.1 Herramientas de Análisis

IconoHerramienta Propósito

Matriz de
distancia

Medida de distancias entre dos puntos en la capa, y el resultado de salida como a)
Matriz de distancia cuadrada, b) Matriz de distancia lineal, o c) Matriz de distancia
resumen. Puede limitar las distancias de las entidades k más cercanas.

Sumar longitud
de líneas

Calcular la suma total de la longitudes de linea para cada polígono de una capa
vectorial de poligonos.

Puntos en
polígonos

Contar el número de puntos que se encuentran en cada polígono de una capa
vectorial de polígonos de entrada.

Listar valores
únicos

Lista de todos los valores únicos en un campo de la capa vectorial de entrada.

Estadísticas
básicas

Estadísticas básicas (media, desviación estándar, N, suma, CV)en un campo de
entrada.

Análisis del
vecino más
próximo

Calcular estadísticas del vecino más cercano para evaluar el nivel de agregación en
una capa vectorial de puntos.

Coordenada(s)
media

Calcular el centro medio normal o ponderado de una capa vectorial completa, o
múltiples entidades basadas en un campo ID único.

Intersecciones
de líneas

Localizar intersecciones entre líneas, y los resultados de salida como un archivo
shape de puntos. Útil para localizar calles o intersecciones de corrientes, ignora
intersecciones de línea con longitud > 0.

Tabla Ftools 1: Herramientas de Análisis fTools
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19.7.2 Herramientas de investigación

Icono Herramienta Propósito

Selección aleatoria Selección aleatoria de un número n de entidades, o n porcentaje de entidades.

Selección aleatoria
dentro de subconjutos

Selección aleatoria de entidades dentro de subconjuntos basado en un campo
ID único

Puntos aleatorios Generar puntos pseudo-aleatorios más de una capa de entrada.

Puntos regulares Generar una cuadrícula regular de puntos sobre una región específica y
exportarlos como un archivo shape de puntos.

Cuadrícula vectorial Generar una cuadrícula de línea o polígono en base aun espaciado de
cuadrícula especificada.

Seleccionar por
localización

Seleccionar entidades en función de su ubicación con respecto a otra capa
para formar una nueva selección, o sumar o restar de la selección actual.

Polígono de la
extensión de la capa

Crear un rectángulo sencillo en la capa de polígono de extensión de una capa
de entrada ráster o vectorial.

Tabla Ftools 2: Herramientas de investigación fTools

19.7.3 Herramientas de geoproceso

Icono Herramienta Propósito

Envolvente(s)
convexa(s)

Crear un envolvente convexo para una capa de entrada, o en función de un campo
ID.

Buffer(s) Crear buffer(s) en torno a las entidades basado en la distancia, o un campo de
distancia.

Intersección Sobrepone capas de manera que la salida contenga áreas donde ambas capas se
cruzan.

Unión sobreponer capas de manera que la salida contenga las áreas intersectadas y las
no intersectadas.

Diferencia
Simétrica

Sobreponer capas de manera que la salida contenga esas zonas de las capas de
entrada y diferencia que no se intersectan.

Cortar Sobreponer capas de tal manera que la salida contenga zonas que cruzo la capa de
corte.

Deferencia Sobreponer capas de tal manera que la salida contenga las zonas que no intersectó
la capa de corte.

Disolver Combinar entidades basadas en el campo de entrada. Todas los rasgos con
valores de entrada idénticos se combinan para formar una solo rasgo.

Eliminar
polígonos
<<astilla>>

Merges selected features with the neighbouring polygon with the largest area or
largest common boundary.

Tabla Ftools3: Herramientas de geoproceso fTools
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19.7.4 Herramientas de geometría

IconoHerramienta Propósito

Comprobar validez
de geometría

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behaviour. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Exportar/Añadir
columnas de
geometría

Añadir a capa vectorial información de geometría de la capa de punto
(XCOORD, YCOORD), línea(LONGITUD), o polígono (ÁREA, PERÍMETRO)
.

Centroides de
polígonos

Calcular los verdaderos centroides de cada polígono en una capa de polígonos de
entrada.

Triangulación de
Delaunay

Calcular y salida (como polígonos) de la triangulación Delaunay de una capa
vectorial de puntos de entrada.

Polígonos Voronoi Calcular polígonos Voronoi de una capa vectorial de puntos de entrada.

Simplificar
geometrías

Generalizar líneas o polígonos con un algoritmo Douglas-Peucker modificado.

Densificar
geometrías

Densificar líneas o polígonos al añadir vértices.

Multipartes a
partes sencillas

Convertir entidad multiparte a entidades múltiples de partes sencillas. Crear
polígonos y líneas sencillas

Partes sencillas a
multiparte

Unir múltiples entidades a una sencilla multiparte en base a un campo ID único.

Polígonos a líneas Convertir polígonos a líneas, polígonos multiparte a líneas multiple de parte
sencilla

Líneas a polígonos Convertir líneas a polígonos, líneas multiparte a polígonos de múltiple parte
sencilla.

Extraer nodos Extraer nodos de las capas de líneas y polígonos y la salida de ellos como puntos.

Tabla Ftools 4: Herramientas de geometría fTools

Nota: La herramienta de Simplificar geometría se puede utilizar para borrar nodos duplicados en geometrías de
líneas y polígonos. Solo tiene que establecer el parámetro de Tolerancia de simplificado a 0 y esto hará el truco.
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19.7.5 Herramientas de gestión de datos

IconoHerramienta Propósito

Definir la
proyección
actual

Especificar el SRC para archivos shape cuyo SRC no ha sido definido.

Unir atributos
por localización

Unir atributos adicionales a la capa de vectorial en función de su relación espacial.
Los atributos de una capa vectorial se adjunta a la tabla de atributo de otra capa y se
exporta como un archivo shape.

Dividir capa
vectorial

Dividir la capa de entrada en varias capas separadas basadas en el campo de entrada.

Combinar
archivos shape
en uno

Combinar varios archivos shape dentro de una carpeta en un nuevo archivo shape
basándose en el tipo de capa (punto, linea, polígono)

Crear índice
espacial

Crear un índice espacial para formatos OGR soportados.

Tabla Ftools 5: Herramientas de gestión de datos

.

19.8 Complemento Herramientas de GDAL

19.8.1 ¿Qué son las herramientas GDAL?

El complemento de herramientas GDAL ofrece una GUI para la colección de herramientas en Geospatial Data
Abstraction Library, http://gdal.osgeo.org. Estas son las herramientas de gestión ráster para consultar, re-proyecto,
urdimbre y combinar una amplia variedad de formatos ráster. También se incluyen herramientas para crear una
capa (vector) del contorno, o un relieve sombreado de un ráster MDT, y para hacer una VRT (Virtual Raster Tile
en formato XML) a partir de una colección de uno o más archivos ráster. Estas herramientas están disponibles
cuando se instala el complemento y es activado.

La biblioteca GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDALTools plugin offers an easy interface to the tools, exposing only the most popular options.

19.8.2 Lista de Herramientas GDAL

Figure 19.16: La lista del menú Herramientas GDAL

19.8. Complemento Herramientas de GDAL 293

http://gdal.osgeo.org


QGIS User Guide, Publicación 2.8

Projecciones

Warp
(Reproject)

Esta utilidad es una imagen de mosaicos, reproyección y utilidad deformación. El programa
puede reproyectar a cualquier proyección apoyada, y también se puede aplicar GCPs
almacenados con la imagen si la imagen es “crudo” con información de control. Para obtener
más información, se puede leer en el sitio web GDAL http://www.gdal.org/gdalwarp.html

Assign
projection

Esta herramienta le permite asignar proyección a rásters que ya tengan una referencia
geográfica, que le falte la información de la proyección. También con su ayuda, es posible
alterar las definiciones de proyección existentes. Ambos archivos simples y el modo por lotes
son compatibles. Para obtener más información, por favor visite la página de utilidad en el
sitio GDAL http://www.gdal.org/gdalwarp.html.

Extract
projection

Esta utilidad te ayuda a extraer información de la proyección de un archivo de entrada. Si
desea extraer información de un directorio completo, puede usar el modo por lotes. Este crea
ambos archivos .prj and .wld

Conversión

Rasterize
Este programa fusiona geometrías vectoriales (puntos, líneas y polígonos) en la banda(s) ráster
de una imagen raster. Los vectores se leen de formatos vectoriales reconocidos por OGR. Tenga
en cuenta que los datos vectoriales debe estar en el mismo sistema de coordenadas como los
datos ráster; en la reproyección al vuelo no se proporciona. Para obtener más información,
consulte http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

Esta utilidad crea polígonos vectoriales para todas las regiones conectadas de píxeles del ráster
que comparte un valor de píxel en común. Cada polígono se crea con un atributo que indica el
valor de píxel de dicho polígono. La utilidad crea el vector de salida de origen de datos si no
existe ya, predeterminado a el formato de archivo shape de ESRI. Ver también
http://www.gdal.org/gdal_polygonize.html.

Translate
Esta utilidad se puede utilizar para convertir los datos ráster entre diferentes formatos, lo que
podría llevar a cabo algunas operaciones como subconjuntos, remuestreo, y reescalar píxeles en
el proceso. Para obtener más información se puede leer en
http://www.gdal.org/gdal_translate.html.

RGB
to PCT

Esta utilidad calculará una tabla de pseudocolor óptima para una imagen RGB determinada,
utilizando un algoritmo de corte medio de un histograma RGB downsampled. Luego se convierte
la imagen en una imagen pseudocoloreada usando la tabla de colores. Esta conversión utiliza
Floyd-Steinberg (difusión de errores) para maximizar la imagen de salida de calidad visual. La
utilidad también se describe en http://www.gdal.org/rgb2pct.html.

PCT
to RGB

Esta utilidad convertirá una banda pseudocolor en el archivo de entrada en un archivo RGB de
salida del formato deseado. Para mayor información, vea http://www.gdal.org/pct2rgb.html.
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Extracción

Con-
tour

Este programa genera un archivo vectorial de curvas de nivel del modelo del terreno ráster (MDT).
En http://www.gdal.org/gdal_contour.html, se puede encontrar más información.

Clip-
per

Esta utilidad le permite que acorte rásteres (extraer un subconjunto) utilizando una extensión
seleccionada o en base a límites de la capa de máscara.. Más información se puede encontrar en
http://www.gdal.org/gdal_translate.html.

Análisis

Sieve Esta utilidad elimina polígonos ráster más pequeños que un tamaño umbral previsto (en
píxeles) y los reemplaza con el valor del píxel del polígono vecino más grande. El resultado
se puede escribir de nuevo a la banda del ráster existente, o copiado en un nuevo archivo.
Para mayor información, vea http://www.gdal.org/gdal_sieve.html.

Near
Black

Esta utilidad escaneará una imagen y tratar de establecer todos los píxeles que son casi
negros (o casi blancos) alrededor del borde para exactamente negro (o blanco). Esto se
utiliza a menudo para “arreglar” comprimir pérdidas de fotos aéreas de modo que los
píxeles de color se pueden tratar como transparentes cuando se hace el mosaico. También
vea http://www.gdal.org/nearblack.html.

Fill
nodata

Esta utilidad rellena regiones de ráster seleccionadas (generalmente áreas sin datos) por
interpolación de píxeles válidos alrededor de los bordes de las áreas. En
http://www.gdal.org/gdal_fillnodata.html, se puede encontrar más información.

Proximity Esta utilidad genera un mapa ráster de proximidad que indica la distancia desde el centro de
cada píxel al centro del píxel más cercano identificado como un píxel objetivo. Los pixeles
objetivo son los del ráster fuente para la cual el valor de píxel del ráster está en el conjunto
de valores de píxel objetivo. Para obtener más información, consulte
http://www.gdal.org/gdal_proximity.html.

Grid (In-
terpolation)

Esta utilidad crea una cuadrícula regular (ráster) a partir de los datos dispersos leídos desde
la fuente de datos OGR. Los datos de entrada serán interpolados para rellenar nodos de la
cuadrícula con los valores, y puede elegir entre varios métodos de interpolación. La utilidad
también se describe en el el sitio web GDAL, http://www.gdal.org/gdal_grid.html.

DEM
(Terrain
models)

Herramientas para analizar y visualizar DEMs. Esto puede crear un relieve sombreado,
pendiente, orientación, color de relieve y un indice de irregularidad del terreno, un indice de
posición topográfica y un mapa de irregularidad de algún ráster de elevación reconocido
GDAL. Para mayor información , vea http://www.gdal.org/gdaldem.html.
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Miscelánea

Build Virtual
Raster (Catalog)

Este programa crea un VRT (Conjunto de datos virtual) que es un mosaico de la lista de
conjunto de datos GDAL de entrada. Vea también
http://www.gdal.org/gdalbuildvrt.html.

Merge Esta utilidad automáticamente hará el mosaico un conjunto de imágenes. Todas las
imágenes deben estar en el mismo sistema de coordenadas y tener un número
correspondiente de bandas, pero pueden ser superpuestas, y en diferentes resoluciones.
En áreas de superposición, la última imagen se copiará en las anteriores. La utilidad
también se describe en http://www.gdal.org/gdal_merge.html.

Information Esta utilidad muestra diversa información acerca de un conjunto de datos ráster
GDAL-implementado. En http://www.gdal.org/gdalinfo.html, puede encontrar más
información.

Build
Overviews

La utilidad gdaladdo se puede utilizar para construir o reconstruir las vistas generales
para los formatos más compatibles con un de varios algoritmos de disminución de
resolución. Para obtener más información, vea http://www.gdal.org/gdaladdo.html.

Tile Index Esta utilidad crea un archivo shape con un registro para cada archivo de entrada ráster,
un atributo contiene el nombre del archivo y una geometría de polígono delineando el
ráster. Vea también http://www.gdal.org/gdaltindex.html.

Configuración de herramientas GDAL

Utilice este diálogo para integrar las variables GDAL.

.

19.9 Complemento Georreferenciador

El complemento Georreferenciador es una herramienta para generar archivos de referencia de ráster. Permite
referenciar los ráster a sistemas de coordenadas geográficas o proyectadas mediante la creación de un nuevo
GeoTiff o añadiendo un archivo de referencia a la imagen existente. El enfoque básico para georreferenciar un
ráster es localizar puntos del ráster para los que se puedan determinar con precisión las coordenadas.

Características
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Icono Propósito Icono Propósito

Abrir ráster Comenzar georreferenciado

Generar script de GDAL Cargar puntos PCT

Guardar puntos PCT como Configuración de la transformación

Añadir punto Borrar punto

Mover punto PCT Desplazar

Acercar zum Alejar zum

Zum a la capa Zum anterior

Zum siguiente Link Georeferencer to QGIS

Link QGIS to Georeferencer Estiramiento total del histograma

Estiramiento local del histograma

Tabla Georreferenciador 1: Herramientas de Georreferenciador

19.9.1 Procedimiento habitual

Como coordenadas X e Y (GMS (gg mm ss.ss), GG (gg.gg) o coordenadas proyectadas (mmmm.mm)), que
correspondan al punto seleccionado en la imagen, se pueden usar dos procedimientos alternativos:

• El propio ráster a veces proporciona cruces con coordenadas “escritas” sobre la imagen. En este caso se
pueden introducir las coordenadas manualmente.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

El procedimiento habitual para georreferenciar una imagen consiste en seleccionar múltiples puntos en el ráster,
especificando sus coordenadas, y elegir un tipo de transformación adecuado. Sobre la base de los parámetros y
datos de entrada, el complemento calculará los parámetros del archivo de referencia. Cuantas más coordenadas
suministre, mejor será el resultado.

The first step is to start QGIS, load the Georeferencer Plugin (see El diálogo de complementos) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.

Para este ejemplo usaremos una hoja topográfica de Dakota del Sur del SDGS. Más tarde se puede visualizar
junto con los datos de la localización spearfish60 de GRASS. Puede descargar la hoja topográfica aquí:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Introducir puntos de control sobre el terreno (PCT)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Hacer clic en un punto de la imagen ráster e introducir las coordenadas X e Y manualmente.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.
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Figure 19.17: Diálogo del complemento Georreferenciador

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continuar introduciendo puntos. Debe tener por lo menos cuatro puntos y cuantas más coordenadas pueda
proporcionar mejor será el resultado. Existen herramientas adicionales en el cuadro de diálogo del comple-
mento para hacer zum o desplazar la zona de trabajo con el fin de localizar un conjunto relevante de puntos
PCT.

Figure 19.18: Añadir puntos a la imagen ráster

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.

Definir la configuración de la transformación

Después de añadir los PCT a la imagen ráster, debe definir la configuración de la transformación para el proceso
de georreferenciación.
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Figure 19.19: Definir la configuración de la transformación del georreferenciador

Algoritmos de transformación disponibles

Dependiendo del número de puntos de control sobre el terreno que haya capturado, es posible que desee utilizar
diferentes algoritmos de transformación. La elección del algoritmo de transformación también depende del tipo
y la calidad de los datos de entrada y la cantidad de distorsión geométrica que está dispuesto a introducir en el
resultado final.

Actualmente están disponibles los siguientes Tipos de transformación:

• El algoritmo Lineal se utiliza para crear un archivo de referencia y es diferente de los otros algoritmos, ya
que realmente no trasforma el ráster. Este algoritmo probablemente no será suficiente si se trata de material
escaneado.

• La trasformación Helmert realiza un escalado sencillo y trasformaciones de rotación.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves colliniarity and allows scaling, translation and rotation only.

• El algoritmo Thin Plate Spline (TPS) es un método de georreferenciación más moderno, que es capaz de
introducir deformaciones locales en los datos. Este algoritmo es útil cuando se georreferencian originales
de muy baja calidad.

• La trasformación Proyectiva es una rotación lineal y traducción de coordenadas.

Definir el método de remuestreo

El tipo de remuestreo que elija probablemente dependerá de los datos de entrada y el objetivo último del ejercicio.
Si no se desea cambiar las estadísticas de la imagen, es posible que desee elegir “Vecino más próximo”, mientras
que un ‘Remuestreo cúbico’ probablemente proporcionará un resultado más suavizado.

Es posible elegir entre cinco diferentes métodos de remuestreo:

1. Vecino más próximo
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2. Lineal

3. Cúbica

4. Spline cúbica

5. Lanczos

Definir la configuración de la trasformación

Hay varias opciones que deben definirse para el ráster de salida georreferenciado.

• La casilla de verificación checkbox| Crear archivo de referencia esta disponible solo si se decide utilizar
la transformación lineal, porque esto quiere decir que la imagen ráster no será transformada realmente. En
este caso, el campo Ráster de salida no se activa, porque solo se creará el nuevo archivo de referencia.

• Para todos los otros tipos de transformación hay que definir un Ráster de salida. Por omisión se creará un
nuevo archivo ([nombre de archivo] _modificado) en la misma carpeta junto con la imagen ráster original.

• Como siguiente paso, tiene que definir el SRE de destino (Sistema de Referencia Espacial) para la imagen
georeferenciada (vea Trabajar con Proyecciones).

• Si lo desea, puede generar un mapa en pdf y también un informe en pdf. El informe incluye información
acerca de los parámetros de trasformación utilizados, una imagen de los residuos y una lista con todos los
PCT y sus errores RMS.

• Además, puede activar la casilla de verificación Establecer resolución de destino y definir la resolución
del píxel del archivo de salida. Por omisión la resolución horizontal y vertical es 1.

• Se puede activar la casilla Usar 0 para transparencia cuando sea necesario, si los píxeles con valor
0 deben visualizarse trasparentes. En nuestra hoja topográfica de ejemplo todas las áreas blancas serían
transparentes.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Mostrar y adaptar las propiedades del ráster

Al hacer clic en el diálogo Propiedades del ráster en el menú Configuración se abren las propiedades del ráster
de la capa que desea georreferenciar.

Configurar el georreferenciador

• You can define whether you want to show GCP coordiniates and/or IDs.

• Como unidades residuales se pueden elegir píxeles y unidades del mapa.

• Para el informe PDF puede definir un margen izquierdo y derecho y también puede establecer el tamaño del
papel para el mapa PDF.

• Finalmente, puede activar Mostrar la ventana del Georeferenciador adosada.

Ejecutar la transformación

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

.
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19.10 Complemento Mapa de calor

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.

19.10.1 Activar el complemento Mapa de calor

En primer lugar este complemento núcleo necesita ser activado utilizando el Administrador de Complementos

(véase El diálogo de complementos). Después de activarlo, el icono de mapa de calor se puede encontrar en
la barra de herramientas de Ráster, y bajo el menú Ráster → Mapa de calor.

Seleccione el menú Ver → Barras de herramientas → Ráster para mostrar la barra de herramientas Ráster, si no
está visible.

19.10.2 Usar el complemento de Mapa de calor

Haga clic en el botón de la herramienta Mapa de calor para abrir el diálogo del complemento Mapa de calor
(vea figure_heatmap_2).

El diálogo tiene las siguientes opciones:

• Capa de puntos de entrada: Lista todas las capas vectoriales de puntos del proyecto actual y se usa para
seleccionar la capa a analizar.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be choosen, in
most cases GeoTIFF is the best format to choose.

• Radio: Se usa para especificar el radio de búsqueda del mapa de calor (o ancho de banda del kernel) en
metros o unidades del mapa. El radio especifica la distancia alrededor de un punto a la que se notará la
influencia del punto. Los valores más altos dan lugar a un mayor suavizado, mientras que los valores más
pequeños pueden mostrar detalles y variación más finos en la densidad de puntos.

Cuando la casilla de verificación Avanzado está marcada, hay disponibles opciones adicionales:

• Filas y Columnas: Utilizado para cambiar las dimensiones del ráster de salida. Estos valores también
están ligados a los valores de Tamaño X de celda y Tamaño Y de celda. Incrementar el número de
filas y columnas disminuirá el tamaño de la celda e incrementará el tamaño del archivo de salida. Los
valores en Filas y Columnas también están vinculados, por lo que duplicar el número de filas duplicará
automáticamente el número de columnas y el tamaño de las celdas también se reducirá a la mitad. ¡El área
geográfica del ráster de salida seguirá siendo el mismo!

• Tamaño X de celda y Tamaño Y de celda: Controlan el tamaño geográfico de cada píxel en el ráster de
salida. Cambiar estos valores también cambiará el número de filas y columnas en el ráster de salida.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Relación de decadencia: Se puede utilizar con kernel Triangulares para un mayor control de cómo dismin-
uye el calor de una entidad con la distancia a la misma.

– Un valor de 0 (= mínimo) indica que el calor estará concentrado en el centro del radio dado y se
extinguirá por completo en el borde.
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– Un valor de 0.5 indica que a los píxeles del borde del radio se les dará la mitad del calor que a los
píxeles del centro del radio de búsqueda.

– Un valor de 1 significa que el calor se distribuye uniformemente por todo el círculo del radio de
búsqueda. (Esto es equivalente al kernel ‘Uniforme’.)

– Un valor mayor que 1 indica que el calor es mayor hacia el borde del radio de búsqueda que en el
centro.

La capa de puntos de entrada también puede tener campos de atributos que pueden afectar la forma en que influyen
en el mapa de calor:

• Usar radio a partir de campo: Establece el radio de búsqueda para cada entidad a partir de un campo de
atributos de la capa de entrada.

• Usar peso a partir de campo: Permite ponderar las entidades de entrada por un campo de atributos. Esto
se puede utilizar para aumentar la influencia que ciertas entidades tienen en el mapa de calor resultante.

Cuando se especifica un nombre para el archivo ráster de salida se puede utilizar el botón [Aceptar] para crear el
mapa de calor.

19.10.3 Tutorial: crear un mapa de calor

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see Datos
de ejemplo). Another exellent QGIS tutorial on making heatmaps can be found at http://qgis.spatialthoughts.com.

En Figure_Heatmap_1, se muestran los aeropuertos de Alaska.

Figure 19.20: Airports of Alaska

1. Seleccione el botón de la herramienta Mapa de calor para abrir el diálogo de Mapa de calor (vea
Figure_Heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.
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3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Deje el Formato de salida como el formato predeterminado, GeoTIFF.

5. Cambie el Radio a 1000000 metros.

6. Haga clic en [Aceptar] para crear y cargar el mapa de calor de aeropuertos (vea Figure_Heatmap_3).

Figure 19.21: The Heatmap Dialog

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

1. Abra el diálogo de propiedades de la capa heatmap_airports (seleccione la capa
heatmap_airports, abra el menú contextual con el botón derecho del ratón y seleccione Propiedades).

2. Seleccione la pestaña Estilo.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.

5. Haga clic en el botón [Cargar] para recabar los valores mínimo y máximo del ráster, después pulse el botón
[Clasificar].

6. Pulse [Aceptar] para actualizar la capa.

El resultado final se muestra en Figure_Heatmap_4.

.

19.11 Complemento de interpolación

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
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Figure 19.22: The heatmap after loading looks like a grey surface

Figure 19.23: Styled heatmap of airports of Alaska
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polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.

• Atributo de interpolación: Seleccionar la columna de atributos a usar para la interpolación o habilitar la

casilla Usar coordenada-Z para usar los valores Z almacenados en la capa.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’. With the TIN method you can create a surface formed by
triangles of nearest neighbour points. To do this, circumcircles around selected sample points are created
and their intersections are connected to a network of non overlapping and as compact as possible triangles.
The resulting surfaces are not smooth. When using the IDW method the sample points are weighted during
interpolation such that the influence of one point relative to another declines with distance from the unknown
point you want to create. The IDW interpolation method also has some disadvantages: the quality of the
interpolation result can decrease, if the distribution of sample data points is uneven. Furthermore, maximum
and minimum values in the interpolated surface can only occur at sample data points. This often results in
small peaks and pits around the sample data points.

• Número de columnas/filas: Especificar el número de filasy columnas para el archivo ráster de salida.

• Archivo de salida: Especifica un nombre para el fichero ráster de salida.

• Añadir el resultado al proyecto para cargar el resultado en la vista del mapa.

Note that using lines as constraints for the interpolation the triangulation (TIN method) you can either use ‘struc-
ture lines’ or ‘break lines’. When using ‘break lines’ you produce sharp breaks in the surface while using ‘structure
lines’ you produce continous breaks. The triangulation is modified by both methods such that no edge crosses a
breakline or structure line.

Figure 19.24: Interpolation Plugin

19.11.1 Usar el complemento

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see El diálogo de complementos) and click on the

Raster → Interpolation → Interpolation , which appears in the QGIS menu bar. The Interpolation
plugin dialog appears as shown in Figure_interpolation_1.

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Seleccionar un método de interpolación( ej. ‘Red Irregular Triangulada (Triangulated Irregular Network-
TIN)’) y especificar un tamaño de celda de 5000 así como el nombre del archivo ráster de salida
(ej.:file:elevation_tin).
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5. Pulse [Aceptar].

.

19.12 MetaSearch Catalogue Client

19.12.1 Introducción

MetaSearch is a QGIS plugin to interact with metadata catalogue services, supporting the OGC Catalogue Service
for the Web (CSW) standard.

MetaSearch provides an easy and intuitive approach and user-friendly interface to searching metadata catalogues
within QGIS.

19.12.2 Instalación

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Install MetaSearch from the QGIS plugin manager, or manually from http://plugins.qgis.org/plugins/MetaSearch.

19.12.3 Working with Metadata Catalogues in QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse, and query metadata about data, services, and other potential resources.

Startup

To start MetaSearch, click the MetaSearch icon or select Web / MetaSearch / MetaSearch via the QGIS main
menu. The MetaSearch dialog will appear. The main GUI consists of two tabs: ‘Services’ and ‘Search’.
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Managing Catalogue Services

The ‘Services’ tab allows the user to manage all available catalogue services. MetaSearch provides a default list
of Catalogue Services, which can be added by pressing ‘Add default services’ button.

To all listed Catalogue Service entries, click the dropdown select box.

To add a Catalogue Service entry, click the ‘New’ button, and enter a Name for the service, as well as the
URL/endpoint. Note that only the base URL is required (not a full GetCapabilities URL). Clicking ok will add
the service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the ‘Edit’ button, and
modify the Name or URL values, then click ok.

To delete a Catalogue Service entry, select the entry you would like to delete and click the ‘Delete’ button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the ‘Load’ button. A new window will appear; click the ‘Browse’ button and
navigate to the XML file of entries you wish to load and click ‘Open’. The list of entries will be displayed. Select
the entries you wish to add from the list and click ‘Load’.

The ‘Service info’ button displays information about the selected Catalogue Service such as service identification,
service provider and contact information. If you would like to view the raw XML response, click the ‘GetCapa-
bilities response’ button. A separate window will open displaying Capabilities XML.
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Searching Catalogue Services

The ‘Search’ tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

The following search parameters are available:

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on. The default bounding box is the map view / canvas.
Click ‘Set global’ to do a global search, or enter custom values as desired

• Records: the number of records to return when searching. Default is 10 records

Clicking the ‘Search’ button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the ‘View search results as XML’ button opens a window with the service
response in raw XML format.

Clicking a result will show the record’s abstract in the ‘Abstract’ window and provides the following options:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate ‘Add to
WMS/WMTS|WFS|WCS’ buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear
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Settings

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is
stored with the various QGIS layer provider. Use this setting to set whether to use the name provided
from MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

.

19.13 Complemento Edición fuera de linea

Para la recolección de datos, es una situación común para trabajar con un ordenador portátil o una línea de teléfono
celular en el campo. A su regreso a la red, los cambios tienen que ser sincronizados con el origen de datos principal
(ej., una base de datos PostGIS). Si varias personas están trabajando simultáneamente en los mismos conjuntos de
datos, es difícil fusionar los cambios a mano, incluso si la gente no cambia los mismo elementos.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

19.13.1 Usar el complemento

• Abrir algunas capas vectoriales (e.j. de una fuente de datos PostGIS o WFS-T).

• Guardarlo como un proyecto.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Editar las capas fuera de linea.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.
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Figure 19.25: Crear un proyecto fuera de linea de capas PostGIS o WFS

.

19.14 Complemento GeoRaster espacial de Oracle

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Esto cargará el raster en la tabla predeterminada GDAL_IMPORT, como una columna llamada “RASTER”

19.14.1 Administrar conexiones

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see El diálogo de complementos).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains

the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Nombre: Introduzca un nombre para al conexión a la base de datos.

• Instancia de la base de datos: Introduzca el nombre de la base de datos a la que desea conectarse.

• Nombre de usuario: Especificar su nombre de usuario que usará para acceder a la base de datos.
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• Contraseña: Proporcionar la contraseña asociada con su usuario que es requerida para el acceso a la base
de datos.

Figure 19.26: Crear dialogo de conexión de Oracle

Ahora, de vuelta en la ventana principal de GeoRaster espacial de Oracle (vea la Figure_oracle_raster_2), utilice
la lista desplegable para elegir una conexión y utilice el botón [Conectar] para establecer la conexión. También
puede [Editar] la conexión abriendo el dialogo previo y haciendo cambios en la información de la conexión, o
usar el botón [Borrar] para eliminar la conexión desde la lista desplegable.

19.14.2 Seleccionar un GeoRaster

Una vez que la conexión se ha establecido, la ventana de subconjuntos de datos mostrará los nombres de todas las
tablas que contengan columnas GeoRaster en esa base de datos en el formato de un nombre del subconjunto de
datos GDAL.

Haga clic en uno de los subconjuntos de datos listados y después haga en [Seleccionar] para elegir el nombre de
la tabla. Ahora se mostrará otra lista de subconjuntos de datos con los nombres de las columnas del GeoRaster en
la tabla. Normalmente es una lista corta, ya que la mayoría de los usuarios no tendrán mas de una o dos columnas
de GeoRaster en la misma tabla.

Clic sobre uno de los subconjuntos de datos en listados y después sobre [Seleccionar] para elegir una de las
combinaciones tabla/columna. El dialogo mostrará ahora todos los registros que contengan objetos GeoRaster.
Note que la lista de subconjunto de datos mostrará ahora las parejas de tablas de datos raster e Id de raster.

En cualquier momento, la entrada seleccionada se puede ser editar para ir directamente a un GeoRaster conocido
o para regresar al inicio y seleccionar otro nombre de tabla.

La entrada de datos seleccionados también puede usarse para introducir una cláusula WHERE al final de
la cadena de identificación (ej. geor:scott/tiger@orcl,gdal_import,raster,geoid=). Vea
http://www.gdal.org/frmt_georaster.html para mayor información.

19.14.3 Mostrar GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

El dialogo Seleccionar GeoRaster espacial de Oracle puede cerrarse ahora y la siguiente ocasión en que se abra
mantendrá la misma conexión y mostrará la misma lista previa de subconjuntos de datos, haciendo muy fácil abrir
otra imagen del mismo contexto.

Nota: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated outside
of QGIS using Oracle PL/SQL or gdaladdo.

Lo siguiente es un ejemplo usando gdaladdo:
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Figure 19.27: Diálogo de selección de GeoRaster de Oracle

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Este es un ejemplo usando PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

.

19.15 Complemento Análisis de Terreno

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Descripción del análisis:

• Pendiente: Calcula el ángulo de la pendiente de cada celda en grados (basado en primer orden estimación
derivada).

• Orientación: Exposición (iniciar con 0 para la dirección norte, en grados antihorario).

• Mapa de sombras: Crea un mapa de sombra utilizando luz y sombra para proveer un aspecto más tridi-
mencional para un mapa de relieve sombreado. El mapa de salida es una banda gris individual que refleja
el valor gris de los píxeles.
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• Índice de irregularidad: Una medición cuantitativa de la heterogeneidad del terreno tal como se describe
por Riley et al. (1999). Se calcula para cada lugar con un resumen de los cambios en la elevación dentro de
la cuadrícula de 3x3 píxeles.

• Relieve: Crea un mapa de relieve sombreado de los datos digitales de elevación. Implementado es un
método para elegir los colores de elevación mediante el análisis de distribución de frecuencia. EL mapa de
salida es una color multibanda con tres bandas que reflejan los valores RGB del relieve sombreado.

Figure 19.28: Complemento de Modelado de Terreno (Cálculo de la pendiente)

19.15.1 Usar el complemento

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Cargar el complemento de Análisis de Terreno en el Administrador de Complementos (vea El diálogo de
complementos).

3. Seleccione un método de análisis del menú (e.j., Ráster → Análisis de Terreno → Pendiente). El diálogo
Pendiente aparece como se muestra en Figure_raster_terrain_1.

4. Especificar una ruta , y un tipo de archivo de salida

5. Haga clic en [Aceptar].

.

19.16 Complemento Grafo de rutas

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Características principales:

• Calcula la ruta, así como la longitud y el tiempo de viaje.

• Optimiza la longitud o el tiempo de viaje.

• Exporta la ruta a una capa vectorial.

• Resalta la dirección de las carreteras (esto es lento y se utiliza principalmente para fines de depuración y
para pruebas de configuración)

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

En la tabla de atributos de la capa, se pueden usar los siguientes campos:

• Velocidad en una sección de la carretera (campo numérico).
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Figure 19.29: Road Graph Plugin

• Dirección (cualquier tipo que se pueda convertir en texto). Las direcciones de avance y retroceso correspon-
den a una carretera de un solo sentido, ambas direcciones indican una carretera de doble sentidos.

Si algunos campos no tienen ningún valor o no existen, se usan los valores predeterminados. Puede cambiar lo
predeterminado y algunas configuraciones del complemento en el diálogo de configuración del complemento.

19.16.1 Usar el componente

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

Después de configurar Unidad de tiempo, Unidad de distancia y Tolerancia de topología, puede seleccionar la
capa vectorial en la pestaña Capa de transporte. Aquí también puede seleccionar el Campo de sentido y el Campo
de velocidad. En la pestaña Configuración predeterminada, puede establecer el Sentido para el calculo.

Finalmente, en el panel Ruta más corta, seleccione un punto de Inicio y un punto Final en la capa de red de
carreteras y pulse [Calcular].

.

19.17 Complemento Consulta espacial

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Operadores posibles son:

• Contiene
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Figure 19.30: Road graph plugin settings

• Igual

• Solapa

• Cruzar

• Intersecta

• Está inconexo

• Toca

• Dentro

19.17.1 Usar el complemento

Como un ejemplo, queremos encontrar regiones en el conjunto de datos de Alaska que contenga aeropuertos. Los
siguientes pasos son necesarios:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see El diálogo de complementos) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Seleccione la capa regions como la capa origen y airports como la capa de entidades de referencia.

4. Seleccione ‘Contiene’ como operador y haga clic en [Aplicar].

Ahora obtiene una lista de IDs de entidades de la consulta y tiene varias opciones, como se muestra en fig-
ure_spatial_query_1.

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• Se puede Zum al elemento o desplegar Registro de mensajes.
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• Additionally in Result Feature ID’s with the options ‘Invalid source’ and ‘Invalid reference’ you can have a
look at features with geometries errors. These features aren’t used for the query.

Figure 19.31: Spatial Query analysis - regions contain airports

.

19.18 Complemento SPIT

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins

menu, in the Installed menu check the box next to the SPIT and click [OK].

To import a shapefile, use Database → Spit → Import Shapefiles to PostgreSQL from the menu bar to open the
SPIT - Shapefile to PostGIS Import Tool dialog. Select the PostGIS database you want to connect to and click on
[Connect]. If you want, you can define or change some import options. Now you can add one or more files to the
queue by clicking on the [Add] button. To process the files, click on the [OK] button. The progress of the import
as well as any errors/warnings will be displayed as each shapefile is processed. .

19.19 Complemento Comprobador de topología.

La topología describe las relaciones entre puntos, líneas y polígonos que representa los objetos espaciales de una
región geográfica. Con el complemento de Comprobador de Topología, puede revisar sus archivos vectoriales y
verificar la topología con varias reglas topológicas. Estas reglas comprueban con relaciones espaciales si su objeto
espacial es ‘Equal’, ‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’, o son ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’
o ‘Within’ el uno al otro. Depende de sus preguntas individuales que reglas topológicas que se aplican a los
datos vectoriales (por ejemplo, normalmente no aceptará overshoots en capas de líneas, pero si ellos representan
callejones sin salida que no eliminará de su capa vectorial).
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Figure 19.32: Usar el complemento SPIT para importar archivos shape a PostGIS

Figure 19.33: El complemento de Comprobador de Topología
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QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

Es muy simple crear reglas topológicas con el complemento Comprobador de topología.

En capa de puntos las siguientes reglas están disponibles:

• Must be covered by: Aquí puede elegir una capa vectorial de su proyecto. Los puntos que no están
cubiertos por la capa vectorial dada se produce en el campo ‘Error’.

• Must be covered by endpoints of: Aquí puede elegir una capa de líneas de su proyecto.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• Must not have duplicates: Siempre que un punto se representa dos o más veces, se producirá el campo
‘Error’.

• Must not have invalid geometries: Comprobar si las geometrías son validas.

• Must not have multi-part-geometries: Todos los puntos multi-parte se escriben en el campo ‘Error’.

En Capas de líneas, las siguientes reglas están disponibles:

• End points must be covered by: Aquí se puede seleccionar una capa de puntos de su proyecto.

• Must not have dangles: Este mostrará los overshoots en la capa de líneas.

• Must not have duplicates: Siempre que un objeto línea es representado una o dos veces, se producirá en el
campo ‘Error’.

• Must not have invalid geometries: Comprobar si las geometrías son validas.

• Must not have multi-part geometries: A veces, una geometría es en realidad una colección de simples
(una sola pieza) geometrías. Una geometría de este tipo se denomina de geometría multiparte. Si contiene
sólo un tipo de geometría simple, lo llamamos multi-punto, multi-línea o multi-polígono. Todas las líneas
de multi-partes se escriben en el campo ‘Error’.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
psuedo node.

En capas de polígonos, las siguientes reglas están disponibles:

• Must contain: La capa de polígonos debe contener al menos un punto de la geometría de la segunda capa.

• Must not have duplicates: Los polígonos de la misma capa no deben tener geometrías idénticas. Cada vez
que una entidad de polígono se represente dos veces o más se producirá en el campo ‘Error’.

• Must not have gaps: Los polígonos adyacentes no deben formar espacios entre ellos. Los límites adminis-
trativos podrían mencionarse como ejemplo (polígonos de los estados de Estados Unidos no tienen espacios
entre ellos ...).

• Must not have invalid geometries: Comprobar si las geometrías con validas. Algunas de las reglas que
definen si una geometría es valida son:

– Anillos de polígonos deben cerrarse.

– Los anillos que definen agujeros deben estar dentro de los anillos que definen los límites exteriores.

– Los anillos no deben intersectarse (Ni pueden tocarse o cruzarse entre si)

– Los anillos no puede tocar otros anillos, excepto en un punto.

• Must not have multi-part geometries: A veces, una geometría es en realidad una colección geometrías
sencillas (parte sencilla). Una geometría de este tipo se denomina de geometría multi-parte. Si contiene
sólo un tipo de geometría simple, lo llamamos multi-punto, multi-líneas o multi-polígono. Por ejemplo, un
país que consta de múltiples islas se puede representar como un multi-polígono.

• Must not overlap: Los polígonos adyacentes no deben de compartir un área en común.
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• Must not overlap with: Los polígonos adyacentes de una capa no deben compartir un área con los polí-
gonos de otra.

.

19.20 Complemento de Estadísticas de zona

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). You can calculate the sum, the mean value and the total count of the pixels that are within a
polygon. The plugin generates output columns in the vector layer with a user-defined prefix.

Figure 19.34: Zonal statistics dialog (KDE)

.
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CHAPTER 20

Ayuda y apoyo

20.1 Listas de correos

QGIS is under active development and as such it won’t always work like you expect it to. The preferred way to
get help is by joining the qgis-users mailing list. Your questions will reach a broader audience and answers will
benefit others.

20.1.1 usuarios-qgis

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 fossgis-talk-liste

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 desarrollador-qgis

SI eres un desarrollador con algunos problemas de naturaleza técnica, puede que quieras apuntarte a la lista de
correos de desarrollador-qgis en el siguiente enlace: http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac

Esta lista proporciona notificaciones por email relacionadas con gestión de proyectos, incluyendo
informes de errores, tareas y solicitudes de funciones. Puedes suscribirte a esta lista en:
http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 equipo-de-la-comunidad-qgis

Esta lista se ocupa de temas como la documentación, ayuda de contexto, guía para el usuario, páginas
web. blog, listas de correos, foros y trabajos de traducción. Si además quisieras trabajar en la guía
para el usuario, esta lista es un buen punto de partida para preguntar. Puedes suscribirte a esta lista en:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 equipo-de-publicación-qgis

Esta lista se ocupa de temas como el proceso de publicación, paquetes de datos binario para var-
ios OSS y anuncios de nuevas publicaciones a nivel mundial. Puedes suscribirte a esta lista en:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 tr-qgis

This list deals with the translation efforts. If you like to work on the translation of the manuals or the graphical
user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 edu-qgis

This list deals with QGIS education efforts. If you would like to work on QGIS education ma-
terials, this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 psc-qgis

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

20.2 IRC

También mantenemos una presencia en IRC - visítenos uniéndose al canal #qgis en irc.freenode.net. Por favor,
espere una respuesta a su pregunta, la mayoría de gente en el canal están haciendo otras cosas y puede tomar un
tiempo para que noten su pregunta. Si se ha perdido una discusión en IRC, ¡no hay problema! Registramos toda
discusión, así que puede fácilmente ponerse al día. Sólo tiene que ir a http://qgis.org/irclogs y leer los IRC-logs.

Apoyo comercial para QGIS también esta disponible. Revisar la página web http://qgis.org/en/commercial-
support.html para mayor información.

20.3 Rastreador de Errores

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.
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Por favor, tenga en cuenta que su error no siempre puede disfrutar de la prioridad que podría esperar (depende de
su gravedad). Algunos errores pueden requerir de significativo esfuerzo por parte del desarrollador para remediar,
y la mano de obra no siempre está disponible para esto.

Se pueden presentar las solicitudes de funciones utilizando el mismo sistema de ticket de errores. Asegúrate de
seleccionar el tipo «Función».

If you have found a bug and fixed it yourself, you can submit this patch also. Again, the lovely redmine ticketsys-
tem at http://hub.qgis.org/wiki/quantum-gis/issues has this type as well. Check the Patch supplied checkbox
and attach your patch before submitting your bug. One of the developers will review it and apply it to QGIS. Please
don’t be alarmed if your patch is not applied straight away – developers may be tied up with other commitments.

20.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

20.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

Por último, mantenemos un sitio web en WIKI http://hub.qgis.org/projects/quantum-gis/wiki donde se puede en-
contrar una variedad de información útil relacionada con el desarrollo de QGIS, planes de lanzamiento, los enlaces
para descargar sitios, mensaje- consejos de traducción y más. ¡Compruébelo, hay algunas cosas en el interior!

.
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CHAPTER 21

Apéndice

21.1 GNU General Public License

Versión 2, Junio de 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preámbulo

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt excepciones para GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

21.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPIADO EN CANTIDAD

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICACIONES

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINACIÓN DE DOCUMENTOS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLECCIONES DE DOCUMENTOS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGREGACIÓN CON TRABAJOS INDEPENDIENTES

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRADUCCIÓN

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINACIÓN

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. REVISIONES FUTURAS DE ESTA LICENCIA

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RENOVACIÓN DE LICENCIAS

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

APÉNDICE: Cómo usar esta Licencia para sus documentos

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.

.
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